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Garantie und Instandsetzung

Die Garantiezeit betragt ein Jahr ab dem
Kaufdatum  des  Neugerdts. Fir  eine
Garantieleistung missen folgende Bedingungen
erfillt sein:

1.) Wir beheben unentgeltlich Mangel am Gerat,
die nachweislich auf einem Herstellungsfehler
beruhen. Die Mangel missen uns unverziglich
nach Feststellung und innerhalb der geltenden
Garantiedauer gemeldet werden. Von der
Garantie ausgeschlossen sind alle
VerschleiBteile, sowie Folgen natiirlicher
Abnutzung und alle Fehler, die durch
unsachgemafle Handhabung sowie &auflere

Einwirkungen entstanden sind. Nicht
eingeschlossen in die Garantieleistung sind
geringfugige Abweichungen von der

Solibeschaffenheit, die fur die Gebrauchs-
fihigkeit des Gerates unerheblich sind.

2.} Voraussetzung fir die Garantieleistung ist die
Vorlage des Kaufbeleges, aus dem zweifelsfrei
Name und Anschrift des Fachhandlers, Name
und Anschrift des Kiufers und das Kaufdatum
hervorgehen muB3. Unrichtige Angaben tiber das
Kaufdatum sowie eigenmichtige Anderungen
und Erganzungen entbinden uns von jeglicher
Garantieverpflichtung.

3.) Die Garantie kann nur dann Ubernommen
werden, wenn die vom Hersteller am Gerat
angebrachte Seriennummer nicht entfernt oder
verandert wurde.

4)) Die Garantieleistung erfolgt in der Weise,
daBB mangelhafte Teile nach unserer Wahl
unentgeltlich  instandgesetzt  oder  durch
einwandfreie Teile ersetzt werden. Der
Garantieanspruch erlischt, wenn Reparaturen
oder Eingriffe von Personen vorgenommen
werden, die hierzu von uns nicht ermachtigt sind
oder wenn das Gerdt mit ungeeigneten
Erganzungs- oder Zubehdrteilen versehen
wurde.

5.) Bei Garantieanspriichen wie folgt vorgehen:
Gerdte mit moglichst genauer Fehlerbe-
schreibung frachtfrei unter Beifligung der unter
Punkt 2 beschriebenen Kaufbelege in
sachgemaler  Verpackung  (mdglichst im
Originalkarton) an unsere Servicewerkstatte
senden: PMS Electronics, Kutenhauser Str. 155,
32423 Minden, Tel. 0571-646000, Fax 0571-
6460010.

6.) Wir Ubernehmen keine Haftung fiir
Beschadigung oder Verlust des Gerates auf dem
Versandweg vom Anspruchsteller zur Service-
Werkstatte. Der Nachweis obliegt immer dem
Versender. Beschiadigungen oder Verlust beim

Ruckversand des Gerétes sind umgehend beim
Zusteller  zu  melden. Verspatete  oder
unterlassene Meldung schlieBt eine Haftung
unsererseits aus. Die Ricksendung erfolgt nur
bei Geraten kostenlos, die uns in der
Originalverpackung zugestellt wurden.

7.) Weitergehende oder andere Anspriiche,
insbesondere solche auf Ersatz auBerhalb des
Gerates entstandener Schaden, sind
ausgeschlossen, soweit sich eine Haftung nicht
aus den gesetzlichen Bedingungen ergibt.

In dem seltenen Fall eines Defekts wenden Sie
sich bitte direkt an unsere Service-Werkstitte
fur DIGITECH, DBX und JOHNSON-Produkte:

2MS

PMS Electronics
Grosse Heide 27
32425 Minden

Tel.: 0571 646000
Fax.: 0571 6460010

ANMERKUNG: Die in diesem Handbuch
enthaltenen Informationen kénnen jederzeit
ohne Ankiindigung geandert werden. Auch
kénnen manche in diesem  Handbuch
enthaltenen Informationen aufgrund
undokumentierter Anderungen am Produkt oder
Betriebssystem, die nach der Fertigstellung
dieser Handbuchversion vorgenommen wurden,
ungenau sein. Die in dieser Version des
Bedienungshandbuchs enthaltenen Informatio-
nen ersetzen die Informationen aller vorherigen
Versionen.

http://www.audioexport.de

http://www.digitech.de

http://www.digitech.com
www.johnson-amp.com

www.dod.com







Schnellstart

Fur jene, die lieber zuerst driicken und drehen und dann erst nachlesen, haben wir diese Schnellstart-
Seite geschrieben, damit Sie sich gleich ins Vergniigen stiirzen konnen.

Kabel anschlieBen

Gitarre an der Frontplatte des 2120 VGS anschlieBen; Ausgangskabel an die linken und/oder rechten
Ausgange an der Riickseite anschlieBen und mit Verstarker oder Mischpult verbinden. An den Ausgangs-
Klinkenbuchsen kénnen entweder symmetrische (Tip-Ring-Sleeve) oder unsymmetrische (Tip-Sleeve)
Klinkenkabel angeschlossen werden.

2120 FC Foot Controller anschlie3en

Vergewissern Sie sich zuerst, ob das Gerat ausgeschaltet ist. SchlieBen Sie dann den Ausgang der
mitgelieferten DigiTech 2120 FC FuB-Fernbedienung an die Foot Controller Buchse an der Riickseite des
2120 an.

WARNUNG:
SCHLIESSEN SIE NUR DEN DIGITECH 2120 FC FOOT CONTROLLER AN DIE FOOT CONTROLLER
BUCHSE AN! ANDERE HIER ANGESCHLOSSENE GERATE KONNEN DEN 2120 VGS BESCHADIGEN!

Soll der 2120 VGS iiber MIDI gesteuert werden, so verbinden Sie lhren MID! Controller mit der MID! IN
Buchse an der Rickseite des Gerits.

Netzkabel anschlieBBen

Verwenden Sie das mitgelieferte Netzkabel zum Anschliu3 des 2120 an einen ordnungsgemaB geerdete
Netzdose. Verlegen Sie alle netzfithrenden Kabel so, daB sie mdglichst weit von der Audio-Verkabelung
entfernt sind. Damit werden Stéreinstreuungen in den Signalweg minimiert.

Effects Loop

SchleiBen Sie beliebige externe Effektgerate (etwa ein heiBgeliebtes altes Effektpedal) an die Effect
Loop Send- und Return Klinkenbuchsen des 2120 VGS an. Der FX Loop Level Schalter (an der Riickseite)
dient zur Pegelanpassung: durch Driicken des Schalters wird das Signal um 6dB abgeschwécht.

HINWEIS: Stellen Sie externe Gerdte so ein, daB sie denselben Signalpegel an den 2120 VGS
zuriickschicken, den sie von dort erhalten. Damit entstehen keine Pegelschwankungen, wenn die Effects
Schleife ein- oder ausgeschaltet wird. Dieses Pegelverhaltnis wird auch als Unity Gain (1:1 Verstarkung)
bezeichnet.

Eingangspegel einstellen

Schalten Sie den 2120 VGS Netzschalter ein. Stellen Sie die Gitarre auf das lauteste Signal ein. Der
angeschlossene Verstarker sollte auf einen cleanen Sound eingestelit, alle Tonregler auf Flat (linear), und
der Master Volume Regler véllig zugedreht sein. Nun stellen Sie mit dem Input Regler an der Frontplatte
des 2120 VGS den Eingangspegel so ein, daB das lauteste Gitarrensignal die Clip LED Anzeige nur
manchmal zum Aufleuchten bringt.

Ausgangspegel einstellen

Stellen Sie den Output Level Regler des 2120 auf die 12 Uhr-Position und anschlieBend den Master
Volume Regler des Verstarkers nach Wunsch ein.

Programm auswahlen:

Spielen Sie nun lhre Gitarre und wahlen mit dem Program/Effect Rad irgendein Programm aus. Die User
Programs 1-100 sind Kopien der Factory Programs; sie sind vom Anwender programmierbar und kénnen
nach Belieben modifiziert und gespeichert werden. Die Factory Programs 1-100 sind nicht veranderbar.
Die Factory Programs 101-124 sind Basic Programs (Programme in Grundeinstellung), sie reprasentieren
die 24 Effekt-Konfigurationen. Die insgesamt 124 Factory Programs konnen nicht tiberschrieben werden.
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Abschnitt 1 - Einleitung

Gratulation!

Sie sind jetzt stolzer Besitzer eines Digitech 2120 VGS Artist Guitar Preamp/Prozessors. Der 2120 VGS
Artist Dual Tube Multieffekt-Prozessor verwendet zwei S-DISC I Prozessoren, mit denen Sie jeden nur
vorstellbaren Preamp/Multieffekt Sound erzeugen kénnen. Egal ob Dual Distortion Path Morphing oder
bis zu 8 digitale Effekte gleichzeitig, der 2120 VGS Artist bietet unbeschrinkte Méglichkeiten. Weiters
inkludiert der 2120 VGS Artist den voll programmierbaren 2120 FC Foot Controller und fantastische
Presets von angesagten Profi-Gitarristen.

Diese Bedienungsanleitung ist lhr Schliissel zum Verstandnis der méachtigen Funktionen des 2120 VGS
Artist. Lesen Sie dieses Handbuch aufmerksam durch. Wenn Sie mit dem Gerdt vertrauter sind,
versuchen Sie doch, mit ungewdhnlichen Effekt-Kombinationen zu experimentieren. Unter Garantie
stoBen Sie auf Sounds, die Sie nicht fiir méglich gehalten hatten! Viel Gliick, und danke dafiir, daB Sie
sich fiir Digitech entschieden haben.

Ilhr 2120 VGS Artist wurde unter gréfiter Sorgfalt hergestelit und verpackt. Bevor Sie weiterlesen,
iiberpriifen Sie bitte, ob Sie alle unten angefiihrten Dinge erhalten haben:

Bedienungsanleitung

Digitech 2120 VGS Artist

Digitech 2120 FC FuB3-Fernbedienung
Netz-AnschluBkabel

Digitech Garantiekarte

— b ed ek A

Bewahren Sie bitte. das Verpackungsmaterial auf. Es wurde so gestaltet, daB das Gerit beim Transport
oder Yersand optimal geschiitzt ist. Fir den unwahrscheinlichen Fall, daB das Gerit zur Reparatur
verschickt werden muB, verwenden Sie nur denQriginal-Karton fiir den Versand.

2120 VGS Artist Leistungsmerkmale:

« Von Musikern programmierte Presets

« Dual Distortion Path Routing

« Dual Tube Preamp mit zwei 12AX7 Vorverstéarker-Réhren

e Effekte in voller Bandbreite (20-20.000Hz)

«  24-bit Signalpfad, 48-bit interner Datenpfad

+ Bis zu 8 digitale Effekte gleichzeitig

e Dual S-DISC Il ® Processing

o Flexibles, leicht zu bedienendes Effect Routing

«  Effekte kénnen mehrmals in einer Kette eingesetzt werden (z.B. EQ+Flange+EQ+PitchShift)
e Lange Delay Zeiten (5,0sec in Full Modules)

o Sofortiger Zugriff auf Module

¢ Exklusive Dynamic Parameter Steuerung

+  Programmierbarer Speaker Cabinet Emulator

e« Chromatisches Stimmgerat

¢ Vollstandige MIDI Implementation

« Alle Effekte und Parameter tiber MIDI steuerbar

« 2 Expression Pedals als externe CC Pedale mit zusétzlichen Zuordnungen anschlieBbar
e Voll programmierbarer Foot Controller




in dem seltenen Fall eines Defekts wenden Sie sich bitte direkt an unsere Service-Werkstatte fur
DIGITECH- und JOHNSON-Produkte:

PMS Electronics
Kutenhauser Str. 155
32425 Minden

Tel.: 0571 646000
Fax.: 0571 6460010

Die Garantiezeit betragt ein Jahr ab dem Kaufdatum des Neugerats. Fur eine Garantieleistung miissen
folgende Bedingungen erfiillt sein:

1.) Wir beheben unentgeltlich Mangel am Gerat, die nachweislich auf einem Herstellungsfehler beruhen.
Die Miangel missen uns unverziiglich nach Feststellung und innerhalb der geltenden Garantiedauer
gemeldet werden. Von der Garantie ausgeschlossen sind alle VerschleiBteile, sowie Folgen nattirlicher
Abnutzung und alle Fehler, die durch unsachgemiBe Handhabung sowie auBere Einwirkungen
entstanden sind. Nicht eingeschlossen in die Garantieleistung sind geringfiigige Abweichungen von der
Solibeschaffenheit, die fiir die Gebrauchsfahigkeit des Gerates unerheblich sind.

2.) Voraussetzung fiir die Garantieleistung ist die Vorlage des Kaufbeleges, aus dem zweifelsfrei Name
und Anschrift des Fachhindlers, Name und Anschrift des Kaufers und das Kaufdatum hervorgehen muB.
Unrichtige Angaben iiber das Kaufdatum sowie eigenmachtige Anderungen und Ergénzungen entbinden
uns von jeglicher Garantieverpflichtung.

3.) Die Garantie kann nur dann iibernommen werden, wenn die vom Hersteller am Gerat angebrachte
Seriennummer nicht entfernt oder verandert wurde.

4) Die Garantieleistung erfolgt in der Weise, daB mangelhafte Teile nach unserer Wahl unentgeltlich
instandgesetzt oder durch einwandfreie Teile ersetzt werden. Der Garantieanspruch erlischt, wenn
Reparaturen oder Eingriffe von Personen vorgenommen werden, die hierzu von uns nicht erméachtigt sind
oder wenn das Gerat mit ungeeigneten Erganzungs- oder Zubehérteilen versehen wurde.

5) Bei Garantieanspriichen wie folgt vorgehen: Gerdte mit mdoglichst genauer Fehlerbeschreibung
frachtfrei unter Beifiigung der unter Punkt 2 beschriebenen Kaufbelege in sachgemaBer Verpackung
{moglichst im Originalkarton) an unsere Servicewerkstitte senden: PMS Electronics, Kutenhauser Str.
155, 32423 Minden, Tel. 0571-646000, Fax 0571-6460010.

6.) Wir ibernehmen keine Haftung fiir Beschadigung oder Verlust des Gerates auf dem Versandweg vom
Anspruchsteller zur Service-Werkstatte. Der Nachweis obliegt immer dem Versender. Beschadigungen
oder Verlust beim Riickversand des Gerates sind umgehend beim Zusteller zu melden. Verspatete oder
unterlassene Meldung schliet eine Haftung unsererseits aus. Die Riicksendung erfolgt nur bei Geraten

kostenlos, die in der Originalverpackung zugestellt wurden.

7.) Weitergehende oder andere Anspriiche, insbesondere solche auf Ersatz auBerhalb des Gerates
entstandener Schiaden, sind ausgeschlossen, soweit sich eine Haftung nicht aus den gesetzlichen
Bedingungen ergibt.

Digitech™, S-DISC II™, Whammy™ und Silencer™ sind eingetragene Warenzeichen der Harman Music
Group Incorporated.

HINWEIS: Digitech behilt sich das Recht vor, die in diesem Handbuch enthaltenen Beschreibungen und
technischen Spezifikationen jederzeit und ohne Ankiindigung zu andern. Unter Umstanden entsprechen
einige Informationen dieses Handbuches aufgrund nicht dokumentierter Anderungen seit dem Zeitpunkt
der Drucklegung, entweder am Gerat selbst oder am Betriebssystem des Gerates, nicht dem letzten
Stand. Alle in dieser Version des Handbuches enthaltenen Informationen ersetzen friihere Versionen.




lhr 2120 Artist VGS - ein schneller Uberblick

Die Frontplatte
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1) Output Level Regler - Regelt den Ausgangspegel des 2120 VGS.

2) Display - In diesem groBen Display finden Sie alle Informationen zum Navigieren im System. Das Display
besteht aus mehreren Teilen:
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2a) Programm Nummer - Die drei groBen Ziffern in der oberen linken Ecke des Display zeigen das gerade
ausgewahlte Programm an.

2b) Factory / User Anzeigen - Direkt unterhalb der Programm-Nummer zeigen die Factory- und User
Program Symbole an, ob sich das aktuelle Programm in einer Factory- oder User Bank befindet.

2¢) Bank / Page Anzeigen - Diese befinden sich in der linken unteren Ecke des Display und zeigen

die Bank Nummer, in welcher sich das aktuelle Programm im Program Mode befindet (erscheint
nur, wenn der 2120 FC Foot Controller angeschlossen ist).
die Seite (Page), welche in den verschiedenen Edit Modes ausgewahlt ist.

2d) Information Zeile - Die oberste Zeile des Display ist 24-stellig und gibt detaillierte Informationen iber
bestimmte Funktionen, Programm- und Parameter-Namen und Hilfsinformationen.




3)
4)
5)

6)

7)

9)

10)
1)

12)

13)

14)

2e) Parameter Daten - Unmittelbar unter der information Zeile befinden sich vier Felder mit Parameter-
Daten. Diese entsprechen den Drehreglern <1> bis <4> auf der Frontplatte. Jedes Feld zeigt den
aktuellen Wert des angezeigten Parameters.

Der in jedem Feld vorhandene CC Indikator zeigt an, ob der angezeigte Parameter von einem MIDI
Controller, dem 2120 FC oder einem internen dynamischen LFO gesteuert wird. Wurde ein Parameter
verandert, so erscheint die CHANGED Anzeige unter diesem Parameter, und die <Store> Taste leuchtet
auf: damit wird angezeigt, daB das Programm verandert, jedoch noch nicht gespeichert wurde.

2f) Input Level / Clip Pegelanzeigen - Diese Pegelanzeigen befinden sich in der Mitte unten im Display. Der
Pegelmesser zeigt den Vorverstarker-Pegel an und verwendet eine Spitzenwertanzeige fir die
Pegelspitzen. Die Clip Anzeige am Ende des Pegelmessers leuchtet auf, wenn das Eingangssignal am
analogen Eingangsteil (vor dem digitalen Teil) oder in den digitalen Effekten begrenzt wird.

2q) Effect Routing Matrix - Die Matrix zeigt den SignalfluB des aktuellen Programms. Die Felder
reprasentieren die Effect Module; die Verbindungslinien symbolisieren, wie diese Effekte mit Eingangen,
Ausgéngen und untereinander verbunden sind. Wird ein Effect Modul auf Bypass (Uberbriickung)

_geschaltet, so erscheint eine gerade Linie durch das entsprechende Feld in der Matrix.

Im FX Edit Mode zeigt ein blinkendes Feld den aktuell ausgewahlten Effect Modul an.

input Klinkenbuchse - Hier wird die Gitarre angesteckt.

Clip LED - zeigt an, daf} das Eingangssignal im Vorverstérker des 2120 VGS begrenzt wird.

input Level Regler - Regelt den Eingangspegel des 2120 VGS.

Gain/Page Regler - Steuert den Distortion Gain Parameter, entweder lokal oder global. Die Auswahl

swischen Global- und Local Mode treffen Sie auf Seite 1 des Utilities Menu. Wenn der 2120 VGS im Edit

Mode ist, dient der <Page> Regler zum Scrollen durch die verschiedenen Pages (Seiten) des ausgewahlten

Effect Moduls.

Parameter Regler - Die Parameter Regler <1> bis <4> dienen zur:

. Verstirkungseinstellung des EQ (<1> bis <3>) und Mischungsverhaltnis zwischen Wet- und Dry

Signalen (<4>) im Program Mode. Die EQ- und Mix Modes kénnen auf Seite 1 des Utilities Menu
entweder auf Local- oder Global Modes gesetzt werden.

Anderung der gewiinschten Parameter im FX Edit Mode.

Program/Effect Rad - Wahlt im Program Mode die Programme, oder wechselt im FX Edit Mode die Effect
Module.

Program Taste - Schaltet zwischen User- und Factory Banks um. Ein darauffoigender Tastendruck schaltet
den 2120 VGS von jedem anderen Mode in den Program Mode zurtick.

Solo Taste - Schaltet den SOLO Parameter ein und aus.
Levels Taste - Schaltet vom aktuellen Mode in den Levels Mode.

Assign Taste - Dient zur Zuordnung von Programmen oder Parametern zum 2120 FC oder zur Parameter-
Zuordnung fur MIDI Controller.

FX Edit Taste - Schaltet vom aktuellen Mode in den FX Edit Mode. Ein darauffolgender Tastendruck
schaltet den 2120 VGS in den Program Mode zurlick.

Store Taste - Fihrt die Speicher-Funktion aus und zeigt den geanderten Status an.




15) Utilities Taste - Schaltet vom aktuellen Mode in den Utilities Mode.
16) Bypass Taste - Uberbriickt den 2120 VGS Vorverstérker und die Effekte.
17-23) FX Library Tasten:

17) [PreAmp] - Schaltet vom aktuellen Mode in den FX Edit Mode des Preamp Moduls. Weitere
Tastendriicke schalten zum nachsten in der Preamp Sektion vorhandenen Modul.

18) [Mod] - Schaltet vom aktuellen Mode in den FX Edit Mode und wihlt den ersten vorhandenen
Modulation Modul eines Programms aus. Weitere Tastendriicke schalten zum nichsten vorhandenen
Modulation Effect in diesem Programm. Driicken und Halten der Taste ladt automatisch einen Modulation
Effect in den gerade ausgewahiten Effect Modul.

19) [Pch] - Schaltet vom aktuellen Mode in den FX Edit Mode und wahlt den ersten vorhandenen
PitchShift- oder Detune Modul eines Programms aus. Weitere Tastendriicke schalten zum nachsten
vorhandenen PitchShift- oder Detune Modul in diesem Programm. Driicken und Halten der Taste ladt
automatisch einen Detune Effect in den gerade ausgewahlten Effect Modul.

20) [Dly/Rvb) - Schaltet vom aktuellen Mode in den FX Edit Mode und wahlt den ersten vorhandenen
Delay- oder Reverb Modul eines Programms aus. Weitere Tastendriicke schalten zum néchsten
vorhandenen Delay- oder Reverb Modul in diesem Programm. Driicken und Halten der Taste ladt
automatisch einen Delay/Reverb Effect in das gerade ausgewahite Programm.

21) [Other] - Schaltet vom aktuellen Mode in den FX Edit Mode und wahlt die Effect Konfiguration aus.
Weitere Tastendriicke schalten zum nachsten vorhandenen Digital Effect Modul, der nicht in den oben
genannten Auswahimdglichkeiten vorhanden ist; als letztes erscheint der Master Mix Modul.

22) [Taplt] - Die Taplt Taste steuert das Delay Tap Tempo fiir prazise Delay Zeiten im Rhythmus der Musik.
Driicken Sie einfach die <Taplt> Taste im gewiinschten Tempo, die Delay Zeiten werden automatisch
richtig gesetzt.

23) [Tuner] - Schaltet vom aktuellen Mode in den Tuner (Stimmgerat) Mode.

24) [Power] - Mit dem Netzschalter schalten Sie das Gerat ein und aus.
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1) NetzanschluB - SchlieBen Sie hier das mitgelieferte Netzkabel an.
2) " MID}In - Uber die MIDI In Schnittstelle reagiert der 2120 VGS auf eingehende MIDI Messages, wie
" Program Change-, Continuous Control- und System Exclusive Daten.

3) . MIDI Out/Thru - Sendet MIDI Daten, die vom 2120 VGS erzeugt werden, bzw. schleift MIDI Daten
von anderen Geraten durch.

4) Foot Controller - Diese 5-polige DIN Buchse dient nur zum AnschluB3 des mitgelieferten Digitech
2120 Foot Controller. SchlieBen Sie den 2120 FC an, BEVOR Sie den 2120 VG5 einschalten.

WARNUNG:

DIESE BUCHSE IST KEIN MIDI ANSCHLUSS. SCHLIESSEN SIE HIER NUR DEN DIGITECH 2120 FC FOOT
CONTROLLER AN. ANDERE HIER ANGESCHLOSSENE GERATE KONNEN DEN 2120 VGS
BESCHADIGEN!

5)

Expression Pedal Input - An diese 1/4” Klinkenbuchse kann optional ein externes passives
Lautstirke-Pedal angeschlossen werden, das die Fernsteuerung von 2120 VGS Parametern erlaubt.

Hinweis:

Wird der 2120 VGS zusammen mit dem 2120 FC verwendet, so wird der 1/4" Expression Pedal
Eingang an der Riickseite des 2120 VGS als EXP 3 bezeichnet.

Wird der 2120 VGS ohne den 2120 FC betrieben, so wird Expression Pedal Eingang an der

* Riickseite des 2120 VGS als EXP 1 bezeichnet.

9)

10)

1)

_ FX Loop Send Level - Mit diesem Schalter wird der Pegel der Effekt-Schleife fiir Send und Return

verandert. Ist der Schalter nicht gedriickt, so haben Sie hier den Standardpegel. Bei gedriicktem
Schalter wird das Send Signal um 6dB gedadmpft. Diese Funktion ist ideal fir FX Pedale, die nicht den
gleichen Ausgangspegel wie der 2120 VGS haben; damit wird ein gleichmaBiger Pegel im Signalfluf3
erreicht.

FX Loop Send - Diese symmetrische 1/4™ TRS Klinkenbuchse ist der FX Loop Send Mono Ausgang.
Verbinden Sie diesen Ausgang mit dem Eingang eines externen Effektgerates. Das Send Signal wird
direkt hinter dem Analog Wah Modul des 2120 VGS abgegriffen.

FX Loop Return - Diese Klinkenbuchse ist der FX Loop Return Mono Eingang. Das hier angesteckte
Signal wird vor der Distortion Sektion in den Signalweg des 2120 VGS eingespeist.

Left/Mono Output - Diese symmetrische 1/4” TRS Klinkenbuchse ist der linke Audioausgang im
Stereo Betrieb. Bei Stereo verwenden Sie beide Ausgangsbuchsen. Im Mono Betrieb verwenden Sie
nur den linken Ausgang und wihlen im Utilities Menu auf Seite 11 den Mono Output Mode.

Right Output - Diese symmetrische 1/4" TRS Klinkenbuchse ist der rechte Audioausgang im Stereo
Betrieb.

Netzsicherung - Die Netzsicherung ist von auBen zuganglich.




Der Vorverstarker

Der 2120 VGS bietet Ihnen die weltberiihmten DigiTech Preamp Sounds, die in Aufnahmestudios oder
auf der Bithne einfach unentbehrlich sind.

Kompression: Jedes 2120 VGS Programm hat eine speziell fir Gitarren entworfene Kompressor-
Schaltung mit dynamischem Bereich.

Analoges Wah - digital gesteuert: Endlich gibt’s die Vintage Analog Wah Effekte in Reichweite threr
Finger und FiiBe. Das digital gesteuerte analoge Wah produziert amtliche Wah Effekte; Storgerdusche
gehéren dank digitaler Steuerung endgiiltig der Vergangenheit an.

Dual Distortion Pfade: Der 2120 VGS bietet durch das zweifache Verzerrer Routing mehr Sound
Optionen. Innerhalb des 2120 VGS Signalweges kdnnen Sie wahlen, durch welchen Distortion Weg das
Signal geschickt wird. Abgesehen davon kénnen Sie beide Signalwege auch parallel verwenden und
zwischen beiden Pfaden mit Morphing iiberblenden. Damit noch nicht genug: mit dem 2120 VGS haben
Sie die Mdglichkeit, beide Distortion Wege zu kombinieren und auf den linken bzw. rechten Ausgang zu
pannen, um "Mammut”-Gitarrensounds in Stereo zu erzeugen!

Dual Tubes und EQ: Mit dem Dual Tube Distortion Path haben Sie zwei 12AX7 Vorverstarker-Réhren und
einen eigenen grafischen 10-Band EQ zur Verfiigung. Nach dem 10-Band EQ gelangt das Signal in das
Noise Gate und anschlieBend in den Speaker Cabinet Emulator (Lautsprecherbox-Nachbildung), der
entweder vor oder nach der Digital Effects Sektion schaltbar ist.

Solid State und EQ: Mit dem Solid State Distortion Path haben Sie Zugriff auf die vielfaltigen
Maglichkeiten der Transistor-Verzerrung, inklusive 10-Band EQ. Von hier wird das Signal in das Noise
Gate und anschlieBend in den Speaker Cabinet Emulator geroutet.

Noise Reduction: Mit dem Silencer }{ Rauschunterdriickungssystem héren Sie ein Gitarrenpick auf den
FuBboden fallen. Mit einem Noise Reduction System dieses Kalibers gibt es keine storenden
Hintergrundgerédusche mehr.

Programmierbare Lautsprecherbox-Nachbildung: Vorbei die vielen Stunden des Experimentierens mit
der richtigen Mikrofonaufstellung zur Abnahme von Gitarrenamps: die Programmable Cabinet Emulation
des 2120 VGS ist jetzt das angesagte Tool, egal ob im Studio oder auf der Biihne. Einfach an das
Mischpult oder direkt an die Bandmaschine anstecken! '




Die Digitaleffekte

Wenn es um digitale Multieffekte geht, steht Digitech an erster Stelle. Seit fast 20 Jahren perfektionieren
wir die Kunst der Digitaleffekte; damit kénnen Sie sicher sein, mit dem 2120 VGS ein Gerat zu haben, das
makellose digitale Effekte in hochster Qualitat und véllig frei von stérenden Nebengerduschen liefert.

Die Effekte:

« Digitaler EQ o Chorus e Chromatische Pitch Shifters

e Whammy e Auto Panners « Noise Gates

o Flangers o Detuners e Phasers

« Rotierender Lautsprecher +« Hall « Intelligente Pitch Shifters
Emulator

« Digitale Delays o Tremolos o Lange Delays (doppelte Delay

Zeiten mit verringerter Bandbreite)

Bis zu 8 Digitaleffekte gleichzeitig (bei Dual S-DISC Il Konfigurationen): Bei Verwendung einer Dual S-
DISC Il Konfiguration kénnen Sie bis zu 8 digitale Effekte aus der riesigen Palette an Méoglichkeiten
miteinander verbinden.

Nahtlose Programm-Wechsel (bei Single S-DISC Il Algorithmen): Weiche Programmiibergénge sind ein
Kiacks mit Seamless Program Changes. Bei einem Programmwechsel gibt es keine hdrbare
Unterbrechung des Signals. Die Hold- und Release Zeiten sind einstellbar, sodaB sich Programmeffekte
mit verschiedenen Geschwindigkeiten iiberlappen.

Nahtlose Programmwechsel-Zeiten kénnen fir jedes Programm im Edit Mode im Master Mix Menu auf
Seite 4 eingestellt und verandert werden. Der Bereich geht von 0,0sec bis unendlich, sowohl fir Hold- als
auch fiir Ramp Zeiten.

Real Time Modifiers: Modifiers sind ein einzigartiges Werkzeug fiir dramatische Soundanderungen in
Echtzeit: die Effekte werden in Abhangigkeit von Signalamplitude, Einstellungen eines Low Frequency
Oszillators (LFO) oder MID! Continuous Controller Informationen verandert.

Jedes 2120 VGS Programm hat einen eigenen Satz an Modifiers. Bis zu 16 Modifier Links (Verbindungen)
kénnen Steuer-Parametern zugeordnet werden. Es gibt drei verschiedene Modifier Typen zur Steuerung
eines Parameters: MID! CCs, LFOs und Dynamic (abhingig von der Lautstérke des Signals).

MID! CCs: Bei Verwendung von MIDI CCs reagiert thr 2120 VGS auf die CC Nummern 0-127 und CHP
(Channel Pressure oder Aftertouch). Zum Beispiel konnen Sie das Modulation Wheel eines Synthesizers
(normalerweise MIDI CC #1) in einem Programm zur Pegelsteuerung am Eingang eines Reverb und
Chorus verwenden; in einem anderen Programm wiederum kann das Modulation Wheel das Delay
Feédback steuern.

LEOs: Bei Verwendung von LFOs kénnen Parameter automatisch zwischen einem definierten Minimum
und Maximum mit einstellbarer Geschwindigkeit verandert werden. thr 2120 VGS hat zwei vom
Anwender programmierbare LFOs in jedem Programm, die jedem beliebigen Parameter zugeordnet
werden konnen.

Zum Beispiel kénnen Sie einen Auto Panner erzeugen, ohne ein Auto Panner Modul zu verwenden.
Linken (verbinden) Sie einfach einen Effect Output Pan Parameter mit dem LFO Modifier - der LFO
bewegt diesen Parameter hin und her. Dieser Modifier ist eine unschlagbare Waffe im anhaltenden
Wettstreit um neue Sound Kreationen. In jedem Programm sind zwei LFOs mit ihren eigenen
Geschwindigkeiten und Wellenformen vorhanden.

Dynamische Modifiers: Bei Verwendung von Dynamic Modifiers werden die Parameter Werte abhangig
von der Dynamik des Eingangssignals verandert. Damit ergeben sich endlose Méglichkeiten, die mit
keiner anderen Methode erzeugt werden konnen.

Weitere Informationen Uber den Einsatz von Modifiers finden Sie im Abschnitt 6 - Fortgeschrittene
Funktionen.




Modultypen

Jeder Effekt in der Digital FX Sektion besteht aus einzelnenEffect Blécken, die als *Module* bezeichnet
werden. Es gibt drei grundsatzliche FX Module in der Digital FX Sektion des 2120 VGS.

¢ Mono FX Modul
o Dual FX Modul
e Stereo FX Modul

Die untenstehende Abbildung zeigt das SignalRouting durch jeden FX Modultyp. Obwohl hier alle drei
Module mit Stereo Eingang gezeigt sind, kénnen sie auch mit Mono Quellen verwendet werden. In
diesem Fall wird das Mono Signal einfach auf beide Seiten des Moduleinganges3eroutet. Beachten Sie,

daB} beim Dual FX- und Stereo Modul das Stereo Abbild des Originalsignals erhalten bleibt, wihrend
beim Mono FX Modul das Eingangssignal immer summiert wird.

ModulgréBen

Die oben beschriebenen Module variieren in ihrer Rechenﬁréﬁ_e, von 1/4 bis Full. Um die so gut wie
endlosen Kombinationsméglichkeiten von Effekten und Routings zu erreichen, stehen lhnen vier
verschiedene ModulgréBen zur Verfiigung:

Full (Voll) Modultyp: FUL
3/4 Modultyp: 3-4
Half (Halb) Modultyp: HLF
Quarter (1/4) Modultyp: 4th

Die Aufteilung der Rechenleistung der zwei S-DISC Il ftatic-Dynamic Instruction Set Computer) beféhigt

lhren 2120 VGS, bis zu 8 digitale Effekte gleichzeitig zu erzeugen. Die untenstehende Abbildung zeigt,
wie die beiden S-DISC Il fiir eine optimale Ausniitzung desEffect Routings aufgeteilt werden.

QUARTER

$-DISC I

Ein Full Modultyp bietet Effekte mit mehr Flexibilitat und Power als ein Half Modul und so weiter.
Jedoch erzeugen alle vier ModulgréBen Effekte in héchster Qualitat, sodaB Sie sich keine Sorgen
machen brauchen, wenn die S-DISC Il "Tortenecken” aufgeteilt werden miissen. Eine komplette Liste
dieser FX Typen finden Sie im Abschnitt 3 unter "Editieren eines Moduls®. Die volisténdige Liste aller
Effect Konfigurationen lesen Sie im Abschnitt 7 - Anhang auf Seite 8.




Aufbau

1 Eingang, 2 symmetrische Ausgange (TRS)

Die Eingange und Ausgange des 2120 VGS sind als Mono Eingang und Stereo- oder Mono Ausgénge
konfiguriert. Die Eingangs-Klinkenbuchse des 2120 VGS befindet sich an der Frontplatte des Gerats. Die
Ausgangs-Klinkenbuchsen sind symmetrisch als TRS (Tip-Ring-Sleeve) ausgefithrt und befinden sich an
der Riickseite des Gerats. Der Left/Mono (Links/Mono) Ausgang arbeitet auch als Mono Ausgang, far
Effekte in Stereo werden sowohl der linke als auch rechte Ausgang verwendet.

Programmierbare Mono FX Loop

Fiir Unersittliche, die noch nicht genug haben mit den ohnehin umfangreichen Sound Moglichkeiten des
2120 VGS, steht eine programmierbare Mono Effektschleife zur Verfiigung. Das Signal verlaBt das Gerit
nach der Wah Sektion und kehrt unmittelbar vor den Dual Distortion Pfaden zuriick. Im weiter unten
abgebildeten Blockschaltbild ist die FX Loop Schaltung, oben in der Mitte, gut zu erkennen.

SignalfluB

Das-untenstehende Blockschaltbild zeigt den SignalfluB durch den 2120 VGS. Beachten Sie, daB mit dem
2120 VGS die-Méglichkeit besteht, entweder einen oder beide Distortion Signalwege auszuwahlen, und
daB ein Rauschunterdriickungssystem in der analogen Preamp Sektion und der ersten DSP Sektion
verfiigbar ist, welches fir extrem saubere Signale sorgt.

Analog Section e eemmememmemmemememmmemssesTSSTTssSsSTSssmosToSTIIITITITITTTTRIIOE .
Gale Det. \ FX Loop Gliz’t; b I:
Clip LED :
Input Buf. Comp Wab 55 Dist. :
AD e
Tube Dist. :
' SoloBoost
— 10 GEQ Speaker Global/
St. Gate Cabinet 3% s-pisci| |S-DisCH >ﬂ
H 10 GEQ \’ Emulatort— FQ >~
DSP Section-1 DSP Section-2 Dual S-DISC IIs
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2120 FC Foot Controller

Der 2120 VGS ist fiir sich gesehen der ideale Multieffekt-Prozessor; um uns jedoch selbst zu tbertreffen,
haben wir den 2120 VGS kompatibel zur 2120 FC FuB-Fernsteuerung gemacht. Der mitgelieferte 2120
FC erlaubt thnen, das Maximum aus dem 2120 VGS herauszuholen. Da der 2120 FC mit dem 2120 VGS
iiber ein eigenes Kommunikationsprotokoll "spricht”, ergeben sich schnellere Reaktionszeiten und
M&glichkeiten, die iiber normale MIDI Pedal Controllers weit hinausreichen.

Auf dem 2120 FC befinden sich 12 FuBschalter zur Steuerung von Programmen und Parametern.
Zusitzlich ist noch ein Expression FuBpedal vorhanden. Dariiber hinaus kénnen Sie eine weitere
Expression Steuerung an die External Expression Pedal Klinkenbuchse (an der Frontseite des 2120 FC
Foot Controller) anschlieBen. In Kombination mit dem Expression Pedal Input (an der Riickseite des 2120
VGS) stehen Ihnen dann insgesamt 3 Expression Controllers zur Verfiigung! Das grof3e 20-stellige Display
am 2120 FC zeigt lhnen stindig wichtige Informationen an, wie etwa Programm Namen, CC Info und
eine Stimmgerat-Anzeige.

Detaillierte Informationen iiber den 2120 FC Foot Controller finden Sie im Abschnitt 5.
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Abschnitt 2 - Einstellungen

Anschliisse

Durch seine Flexibilitat kann der 2120 VGS auf verschiedene Arten angeschlossen werden, abhangig von
der gerade gewiinschten Anwendung. Die folgenden Abbildungen zeigen einige AnschluBméglichkeiten
fiir den 2120 VGS.

HINWEIS: Alle Abbildungen zeigen auch die Verwendung der externen FX Loop. Das ist natirlich eine
Option und kann auch weggelassen werden.
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2120 VGS mit Stereo Endstufe

Hier sehen Sie das ideale 2120 VGS Setup. Von der Klinkenbuchse der Gitarre lauft das
instrumentenkabel zum Eingang an der Frontplatte des 2120 VGS. Zu diesem zeitpunkt kann, wenn
gewdlinscht, die Mono FX Loop mit einem weiteren externen Effect Gerat verbunden werden: dazu
verbinden Sie den FX Loop Send des 2120 VGS mit dem Eingang des Effektgerats, und dessen Ausgang
mit dem FX Loop Return des 2120 VGS.

Nun verbinden Sie die Left- und Right Ausginge des 2120 VGS mit den entsprechenden Eingangen der
Endstufe und schlieBen die beiden Lautsprecherboxen an.

Sie werden sprachlos sein, wie sich die Meister des Stereo Effekts bei der Erzeugung von gnadenloser
Stereo Kanaltrennung selbst ibertroffen haben. In dieser Konfiguration héren Sie Stereo Effekte, wie
Stereo Delays, Phasers, Tremolos und Auto Panning Effekte, die einfach nicht von dieser Welt sind...

Bei einem Gitarren Setup wie diesem ist es immer eine gute Idee, sich davon zu liberzeugen, daB alle
Kabelverbindungen erstklassig und sicher sind. Uberpriifen und halten Sie die Pegel aller Ein- und
Ausgange der angeschlossenen Gerite auf gleichen Werten, damit Ubersteuerungen vermieden werden.
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2120 VGS mit zwei Combo Amps

Bei diesem Setup haben Sie die Méglichkeit, das Potential des 2120 VGS und lhrer Gitarrenverstirker zu
optimieren.

Die beste Art, Signalverbindungen fiir diese Kombination herzustellen, ist wie folgt: schlieBen Sie Ihre
Gitarre an den 2120 VGS Eingang an. Wenn Sie es vorziehen, ein weiteres Effektgerat in den Signalweg
des 2120 VGS einzuschleifen, verwenden Sie dazu die programmierbare Mono FX Loop. Dazu verbinden
Sie den FX Loop Send des 2120 VGS mit dem Eingang des Effektgeréts, und einen seiner Ausginge mit
dem FX Loop Return des 2120 VGS. Nun verbinden Sie die Left- und Right Ausgdnge des 2120 VGS mit
den Eingangen der Gitarrenverstarker.

Damit erzielen Sie satte und weiche Stereo Effekte unter Beibehaltung der individuellen
Klangeigenschaften von 2120 VGS und lhrer wertvollen Combo Amps.

Wie immer sollten Sie sich Uberzeugen, daB alle Kabelverbindungen gut und sicher sind. Weiters ist es
eine gute ldee, alle Ein- und Ausgangspegel auf gleichen Werten zu halten. Oder anders gesagt, der
Ausgangspegel eines Gerats sollte nicht so hoch sein, dal3 Ubersteuerung am nachfolgenden Eingang
eintritt. Denken Sie daran: je sauberer lhr gesamtes Setup eingestellt ist, desto besser klingt auch der

2120 VGS.
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2120 VGS direkt, mit programmierbarem Speaker Cabinet Emulator

Um den Programmable Speaker Cabinet Emulator zu verwenden, gehen Sie einfach in den Edit Mode
des aktuellen Programms und scrollen zu Page 2 des Master Mix Moduls, nach dem letzten Effect Modul.
Hier kdnnen Sie den Cabinet Emulator (die Lautsprecher-Nachbi|dung) aktivieren. Nehmen Sie die
Voreinstellungen und/oder plazieren Sie den Cabinet Emulator entweder Pre Digital (damit wird nur die
Pre Amp Sektion beeinfluBBt), oder Post Digital (sowohl Vorverstarker als auch die Effekte werden
beeinfluBt). Diese Einstellungen weden mit den Reglern <2> und <3> gemacht.

Damit haben wir den "Mittelsmann” (die Lautsprecherbox) eliminiert. Von der Gitarre lauft das Signal an
den Eingang des 2120 VGS. Wenn Sie es vorziehen, ein weiteres Effektgerat in den Signalweg des 2120
VGS einzuschleifen, verwenden Sie dazu die programmierbare Mono FX Loop. Dazu verbinden Sie den
FX Loop Send des 2120 VG5 mit dem Eingang des Effektgerats, und einen seiner Ausgange mit dem FX
Loop Return des 2120 VGS. Nun verbinden Sie entweder nur den Left Output (Mono), oder bei Stereo
Betrieb die Left- und Right Ausgange des 2120 VGS mit den Eingangen des Mischpults. Bei Stereo
stellen Sie die Pan Regler der beiden Mischpultkanéle fir einen optimalen Stereo Effekt hart links und

hart rechts.

HINWEIS: Bei aktiviertem Speaker Cabinet Emulator erscheint im Display das Lautsprecher- Symbol.
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Das Operating System

Die Meniistruktur lhres 2120 VGS wurde speziell in Hinblick auf leichte Bedienbarkeit entworfen. Das
Display zeigt die dazu notwendigen Informationen; um Ihnen die Dinge aber noch leichter zu machen,
bieten die beleuchteten Tasten an der Frontplatte zusatzlichen Bedienungskomfort.

Die Tasten an der Frontplatte geben eine zweifache Information:

1. Leuchtet die Taste nur mit halber Helligkeit, so ist die entsprechende Funktion nicht aktiv. Bei
Driicken der Taste leuchtet sie voll, und ihre Funktion wird zum aktiven Element im Display.

2. lLeuchtet die Taste voll, so ist die entsprechende Funktion aktiv. Bei Driicken einer aktiven Taste
(ausgenommen die <Program> Taste) wird das aktive Element im Display erneut angewahit.

Program Mode

Im Program Mode kénnen Sie mit dem <Program/Effect> Rad durch die Factory- und User Programme
scrollen. Bei Einschalten des 2120 VGS geht das Gerét automatisch in den Program Mode. Wenn die
<Program> Taste leuchtet, ist der Program Mode aktiv und es erscheint ein Program Name in der
Information Zeile (oberste Zeile) im Display.

FX Edit Mode

In diesem Mode kdénnen Sie folgende Dinge editieren:
e Effect Konfigurationen

+ Preamp Module

+  FXModule

e Output Mode Modul

Driicken der <Edit> Taste schaltet in den FX Edit Mode; ein weiterer Tastendruck wiahit den nachsten
Modul zum Editieren aus.

HINWEIS: Wenn Sie die Effect Routing Matrix beobachten, wéahrend Sie die FX <Edit> Taste driicken,
blinkt der aktuell ausgewadhlte Modul.

Um FX Module auszuwéhlen, verwenden Sie das <Program/Effect> Rad. Ein ausgewahlter Modul besteht
aus "Pages" (Seiten), in denen navigiert werden kann. Eine "Page” ist eine Gruppe von bis zu vier Effect
Parametern, die gleichzeitig im Display erscheinen. Mit dem <Gain/Page> Drehregler bewegen Sie sich
durch die Seiten eines Menu. Wahrend Sie durch die Pages scrollen, wechselt der Page Indikator in der
linken unteren Ecke des Display und zeigt die Page Nummer der derzeit sichtbaren Seite.

Utilities Mode

Durch Driicken der <Utilities> Taste an der Frontplatte des 2120 VGS erhalten Sie Zugriff auf alle Menu
Pages des Utilities Mode (Hilfsprogramm Modus). Das Display zeigt an, daB Sie sich in der Utilities
Library (Bibliothek) befinden, und Sie kénnen nun durch die Optionen des Utilities Menu einfach durch
Drehen des <Page> Reglers scrollen.

Levels Mode

Das Levels Menu erreichen Sie durch Driicken der <Levels> Taste. Hier kénnen Sie Einstellungen am
Preamp (Tube oder Solid State), DSP und Master Levels vornehmen, bis Ihre Ohren und Pegelanzeigen
zufrieden sind.
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Assign Mode

Im Assign Mode werden die Zuordnungen von Programmen und Parametern zum Foot Controller und
den MID!-, LFO- und Dynamic Modifiers getroffen. Wenn der 2120 VGS im Assign Mode ist, kdnnen alle
Modifier Zuordnungen (Foot Controller, MIDI, LFO und Dynamic Links) gemacht werden. Den Zugriff auf
diese Funktion haben Sie entweder iber die <Assign> Taste an der Frontplatte oder iber die Utilities
Pages des 2120 VGS.

Output Modul Funktionen

Der Output Modul des 2120 VGS ermdglicht lhnen die Steuerung wichtiger Aspekte lhres Sounds. Die
Output Modul Menus sind: Master Mix (Page 1), Cabinet Emulator Einstellungen (Page 2), Zuordnung der
Solo Taste (Page 3), Zuordnung des Volume Pedals (Page 4) und Zeiteinstellungen fur nahtlose
Programmiibergange (Page 4).

Den Output Modul des 2120 VGS erreichen Sie wie folgt: im Program Mode dricken Sie die <Edit>
Taste und drehen <Program/Effect>, bis der Master Mix Modul blinkt. Eine schnellere Mdglichkeit ist das
Driicken der <Other> Taste, bis der Master Mix Modul blinkt.

Sobald Sie sich im Master Mix Modul befinden, kénnen Sie mit dem <Page> Regler durch die
verschiedenen Edit Seiten des Output Modul blattern.

Die Output Modul Sektion verlassen Sie durch einfaches Driicken der <Program> Taste. Vergewissern

Sie sich, daB die gewiinschten Anderungen im aktuellen Programm auch gespeichert wurden.

Sounds erzeugen

Die folgenden Abschnitte helfen lhnen mit einigen schnellen, leicht verstandlichen Tips und
Empfehlungen fiir optimale Sounds mit threm 2120 VGS.

input- und Output Einstellungen

Eiir die Einstellung des Eingangspegels verwenden Sie am besten den <Input> Regler. Stellen Sie ihn so
ein, daB starke Signale die Clip LED nur ab und zu zum Aufleuchten bringen. Fir den Output Level
vertrauen Sie am besten lhren Ohren. Wenn Sie allerdings den Rest der Band nicht mehr horen, konnte
es sein, daB Sie die Lautstarke etwas zurlicknehmen missen: entweder mit dem <Output> Regler des
2120 VGS, am Mischpult oder an Threm Verstarker. -

Gain Einstellungen

Die Verstirkung in der Tube- oder Distortion Sektion kann entweder mit dem <Gain> Regler an der
Frontplatte erfolgen; oder Sie driicken die <Edit> Taste und schalten in den Edit Mode, anschlieBend
scrollen Sie mit dem <Program/Effect> Rad zum Tube- oder Distortion Modul, drehen jetzt den <Page>
Regler und blattern zur Page 2 des Tube- oder Distortion Modul. Der Gain Bereich geht von 0-100, damit
kénnen Sie auch ganz feine Einstellungen fir einen tollen Sound machen.
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EQ- und Mix Einstellungen

Die Einstellung des globalen EQ ist ganz leicht: drehen Sie einfach die entsprechenden Regler. Der <1>
Knopf regelt die Basse, <2> beeinfluBt die Mitten, und <3> die Héhen. Im Program Mode wird der Pegel
jedes Frequenzbandes im Display angezeigt. Der Regelbereich des globalen EQ geht von -12 bis 12.
Weitere Informationen iber Global/Local EQ und Mix lesen Sie auf Seite 31.

Wet/Dry Mix Einstellungen

Das Mischungsverhaltnis zwischen Dry ("trockenem"” Signal) und Wet (Effektsignal) wird mit dem <4>
Regler bestimmt. Der Bereich geht von 0O (nur Dry) bis 100% (nur Wet). Beim Live Auftritt ist dieser Regler
besonders praktisch, denn die Akustik jedes Raumes andert sich wahrend eines Auftrittes erheblich
durch die (hoffentlich steigende) Zuhéreranzahl, Luftfeuchtigkeit, Temperatur und andere variable
Umgebungsfaktoren. Durch einfaches Drehen des <4> Reglers kdnnen Sie die Starke threr Effekte
andern und so den Veranderungen im Raum entgegenwirken. Der Master Mix jedes Programmes kann im
Edit Mode im Master Mix Menu verdndert werden: entweder durch Dricken der <Edit> Taste und
anschlieBendes Scrollen durch die Program Pages, oder durch Driicken der <Other> Taste, bis dieses
Menu erreicht ist.

Program Pegel

Zur Einstellung des allgemeinen Pegels eines Programmes driicken Sie zuerst die <levels> Taste.
AnschlieBend schalten Sie mit dem <1> Regler die Tube- oder Solid State Levels ein oder aus. Jetzt
stellen Sie mit dem <2> Regler den Pegel der ausgewahlten Distortion Sektion ein, damit wird der
Preamp Level vor der digitalen Sektion beeinfluBt. Bei Aufleuchten des CLIP Indikators nehmen Sie
diesen Pegel etwas zuriick. AnschlieBend stellen Sie mit dem <3> Regler den DSP Level ein, damit
werden die Preamp Pegel in der digitalen Domine gesteuert. Bei Aufleuchten des DIGITAL CLIP
Indikators nehmen Sie diesen Pegel etwas zuriick. Zum guten SchluB kommt der Regler <4> dran, der
den Master Program Level bestimmt. Alle vier Pegeleinstellungen haben einen Bereich von 0 (Aus) bis
100% (Vollgas).

Solo Taste

Das exklusive Solo Feature des 2120 VGS gibt thnen die Mdglichkeit, Ihre Gitarrensolos blitzartig mit
einem Turbo Boost zu versehen, live oder im Studio, und das mit einem einzigen Tastendruck.

Wie geht das? Bei aktivem Solo Button Feature (entweder von der Frontplatte aus, oder mit dem
mitgeliefertem 2120 FC Foot Controller) schaltet sich eine zusatzliche 6dB Verstarkung am Ausgang des
2120 VGS ein. Besonders praktisch sowohl im Studio als auch auf der Biihne fiir den Extrakick bei Solos.

Die Zuordnung der Solo Tasten-Funktion geschieht durch einmaliges Driicken der <Solo> Taste und
anschlieBend <Store>. Die Steuerung von einem FuBschalter aus wird im Utilities Menu, Master Mix
Menu, Page 3 aktiviert.
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Das Stimmgerat

Der Tuner des 2120 VGS kann auf zwei verschiedene Arten aktiviert werden. Entweder
driicken Sie die <Tuner> Taste an der Frontplatte, oder Sie verwenden dazu den
mitgelieferten 2120 FC Foot Controller. Beide Mdglichkeiten werden hier beschrieben.

2120 VGS Tuner Mode
1. Driicken Sie die <Tuner> Taste an der Frontplatte des 2120 VGS. Das Display zeigt:

"" 77 Tuner A=448 Output
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2. Wenn Sie eine Note auf der Gitarre spielen, zeigt die oberste Zeile die gerade gespielte Note an,
und die Tuning Anzeige sagt lhnen, ob diese Note zu tief (flat - b) oder zu hoch (sharp - #) ist.
Bewegt sich die Marke nach links, so ist der Ton zu tief. Es geht darum, die Gitarre so zu stimmen,
daB sich die Marke nicht mehr bewegt und die Anzeige verriegelt - die richtige Stimmung ist
erreicht. Sobald Sie die gewahlte Note spielen, zeigt das Display:

"‘ 0  Tuner A=448 COutput
’— B Bi00*
J— R . R G Em O O e -
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3. Mit erneutem Driicken der <Tuner> Taste verlassen Sie den Tuner Mode.

Referenz und Ausgang

Die Kammerton-Referenz des 2120 VGS kann von 427-453Hz verandert werden. Dazu gehen Sie in den
Tuner Mode und drehen den <3> Knopf. Ein weiteres Feature des 2120 VGS Tuner Modus ist die
Maglichkeit, die Lautstarke der Gitarre am Ausgang des Gerats wihrend des Stimmvorganges einstellen
sikénnen. Der Bereich geht von 0 (stummageschaltet) bis 100% und wird im Tuner Mode mit dem <4>
Regler auf die gewunschte Lautstarke eingestelit.

2120 FC Tuner Mode und Ausgang

Um mit dem 2120 FC Foot Controller in den Tuner Mode zu gelangen, driicken und halten Sie den
<BankUp/Tuner> FuBschalter. Damit wird der 2120 FC in den Stimmgerat-Modus geschaltet

1. Wenn Sie eine Note auf der Gitarre spielen, bewegt sich die Tuning Anzeige im Display des 2120 FC
entweder nach links oder nach rechts. Geht die Marke nach links, so ist der Ton zu tief; geht sie nach
rechts, so ist der Ton zu hoch. Die Gitarre muB so gestimmt werden, daf3 sich die Marke nicht mehr
bewegt und die Anzeige verriegelt - die richtige Stimmung ist erreicht.

2 Bei beiden Stimm-Methoden - lokal oder iiber den 2120 FC - ist die Referenz des Tuner auf den
Kammerton A=440Hz eingestellt. Wenn Sie aus irgendwelchen Griinden diese Referenz verandern
méchten, kénne Sie die neue Referenz mit dem <3> Regler auswahlen. Der Bereich geht von 427-
453Hz. Auf diese Weise ist es auch méglich, die Gitarre beispielsweise tiefer zu stimmen, sodaB
A=Ab entspricht (will heifen, Sie greifen und spielen die A Note, der Tuner stimmt jedoch auf Ab).
Die tiefste mogliche Referenz ist A=F#.

3. Mit Driicken eines beliebigen FuBschalters am 2120 FC verlassen Sie den Tuner Mode.
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Abschnitt 3 - Programme editieren

Programm auswahlien

Beim Einschalten des 2120 VGS geht das Gerat automatisch in den Program Mode, und das Display sieht
etwa wie folgt aus:

'-" Satch 2
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Ein Programm wihlen Sie folgendermaBen aus:

1. Vergewissern Sie sich, daB Sie im Program Mode sind (die <Program> Taste leuchtet hell). Ist die

<Program> Taste nur halb erleuchtet, so driicken Sie sie einmal; damit schalten Sie in den
Program Mode.

2. Mit der <Program> Taste wahlen Sie jetzt die Program Bank ("Factory” oder “User”). Jeder
weitere <Program> Tastendruck schaltet zwischen Factory- und User Bank um.

3. Mit dem <Program/Effect> Rad scrollen Sie nun zum gewiinschten Programm.

Effekt-Konfiguration auswahlen

Mit dem 2120 VGS haben Sie die Mdglichkeit, eine von 24 verschiedenen Effect Routing Konfigurationen
innerhalb des aktuellen Programms auszuwahlen. Dazu gehen Sie wie folgt vor:

Schalten Sie in den Program Mode und driicken die <Other> Taste. Das Display sieht etwa so aus:

=~ Contiga:l SDISC 22
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Sie bemerken, daB die gesamte Digital Effects Anzeige blinkt. Nun drehen Sie den <1> Knopf unter dem
Display und wahlen damit eine der 24 verschiedenen Effect Routing Konfigurationen aus. Nach Auswahl
der gewiinschten Konfiguration kénnen Sie die firr lhre aktuellen Programmwiinsche bendtigten Effect
Module laden. Driicken Sie die <Store> Taste, damit werden alle Anderungen gespeichert. Mit Driicken
der <Program> Taste kehren Sie zum Program Mode zurlick.
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Speichern und Benennen von Programmen

Bevor wir uns dem Editieren von Programmen suwenden und Sie lhrer Kreativitat freien Lauf lassen
kénnen, lernen wir zuerst, wie Veranderungen gespeichert werden, damit Sie die gewlinschten
Modifikationen nicht verlieren. Der Store Vorgang erlaubt thnen, modifizierte Programme neu zu
benennen, zu verschieben und zu speichern, damit sie zu einem spateren Zeitpunkt wieder aufgerufen
werden kénnen.

1. Driicken Sie einmal die <Store> Taste. Das Display zeigt den Namen des aktuellen Programms
(das sieht etwa so aus):

_i MHap=: S at.ch &
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Unter der ersten Stelle des Programm-Namens erscheint ein Cursor.

Programm benennen

Mit dem <Program/Effect> Rad éndern Sie das erste Zeichen an der markierten Position.

2. Sobald das gewiinschte Zeichen an dieser Stelle erscheint, drehen Sie den <Page> Knopf; damit
wird der Cursor auf das nichste zu dndernde Zeichen verschoben.

3. Mit dem <1> Knopf wird zwischen GroB- und Kleinbuchstaben umgeschaltet. Der <2> Knopf
wihlt Ziffern aus, der <3> Knopf fiigt Leerzeichen ein. Der <4> Knopf dient zum Kopieren und
Einfligen von Zeichen.

4, Soll ein Zeichen kopiert werden, positionieren Sie den Cursor mit dem <Page> Knopf unter dem
zu kopierenden Zeichen, anschlieBend drehen Sie den <4> Knopf im Uhrzeigersinn. Um das
kopierte Zeichen einzufiigen, positionieren Sie den Cursor an die gewlnschte Stelle und drehen
den <4> Knopf gegen den Uhrzeigersinn.

5. Wenn Sie den Store- und Name Vorgang beenden méchten, driicken Sie entweder die
<Program> Taste, um in den Program Mode zuriickzuschalten, oder die <Edit> Taste fir den FX
Edit Mode, oder die <Utilities> Taste fur den Utilities Mode, je nachdem, in welchen Mode Sie
schalten mochten.
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Programm speichern

Sobald Sie den gewunschten Namen eingestellt haben, driicken Sie erneut <Store>. In der obersten
Display Zeile ist zu lesen:

“tore To! [Frodram Hame]

Mit dieser Anzeige kénnen Sie den Speicherplatz des neuen Programms auswahlen. Beachten Sie, daf
das Programm in der User Program Bank gespeichert wird, da Factory Programme nicht {iberschrieben
werden kénnen.

1. Mit dem <2> Knopf oder dem <Program/Effect> Rad wahlen Sie die User Programm Nummer,
unter der das neue Programm gespeichert werden soll.

2. Driicken Sie erneut die <Store> Taste. In der obersten Zeile des Display erscheint kurz:

STORIMHG FROGEARM TO ##

AnschlieBend schaltet der 2120 VGS automatisch auf das eben gespeicherte Programm.
Das neu erzeugte User Programm ist jetzt geladen und kann jederzeit wieder aufgerufen
werden.

3. Wenn Sie den Store- und Name Vorgang beenden mdchten, driicken Sie entweder die
<Program> Taste, um in den Program Mode zuriickzuschalten, oder die <Edit> Taste fir den FX
Edit Mode, oder die <Utilities> Taste fir den Utilities Mode, je nachdem, in welchen Mode Sie
schalten méchten.
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Editieren von Programmen

Die Erzeugung von eigenen Effect Programmen ist ein Kinderspiel, denn mit dem 2120 VGS haben Sie
Zugriff auf eine umfangreiche Bibliothek von professionell entwickelten Effekten, die als "Defaults”
(Voreinstellungen) bezeichnet werden. Hier folgt ein Beispiel fir einen Edit Vorgang:

Im Program Mode driicken Sie die <Pitch> Taste. Das Display sieht etwa wie folgt aus:

SEAMLESS
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Wenn Sie in den FX Edit Mode schalten, kénnen Sie auf der ersten Page jedes FX Moduls

1. diesen Effect Modul mit dem <1> Knopf auf Bypass schalten (On oder Off),

2 einen Effect Modul mit dem <2> Knopf auswahlen (nur in der digitalen Effect Sektion),
3. die Default Einstellungen mit dem <3> Knopf speichern (mehr dazu auf Seite 24),

4 eine Default Einstellung fiir den gewahlten Effect Modul mit dem <4> Knopf auswahlen.

Auswihlen/Andern von Effect Modulen

Jedes Programm kann bis zu 8 digitale Effekte (zusitzlich zur Preamp Sektion) beinhalten. Sie kénnen auf
swei verschiedene Arten durch die Module eines Programms scrollen:

1. Durch Driicken der <Edit> Taste, um in den FX Edit Mode zu schalten, und anschlieBendes
Drehen von <Program/Effect>, um durch die verschiedenen Module zu scrollen.

2. Mit den FX Library Tasten. Driicken der <Preamp> Taste bringt Sie direkt zum ersten Modul in
der Preamp Sektion. Weitere Tastendriicke scrollen durch die nachfolgenden Module in der
Preamp Sektion. In gleicher Weise funktioniert das auch mit der <Dly/Rvb> Taste: damit
kommen Sie direkt zum ersten Modul der Digital FX Sektion, der ein Delay oder Reverb geladen
hat. Weitere Tastendriicke scrollen durch alle nachfolgenden Module, die ein Delay oder Reverb
geladen haben (natirlich unter der Annahme, daBl mehr als ein Delay oder Reverb im Programm
geladen ist).

Sobald Sie den Modul erreicht haben, der verandert werden soll (etwa der Tausch eines Delay mit einem
Reverb), wihlen Sie mit dem <2> Knopf einen neuen Effekt. Das geht auch anders: durch Driicken der
<Mod>, <Pitch>, <Dly/Rvb> oder <Other> Taste wird der entsprechende Effekt sofort geladen.

Default wahlen

Sobald der im Programm gewiinschte Effekt geladen ist {in unserem Beispiel: St Pitch), kénnen Sie
schnell durch verschiedene St Pitch Defaults in der Bibliothek Ihres 2120 VG5 scrollen.
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Ein Beispiel:

Es stehen 7 Stereo Pitch Shifter Defaults zur Auswahl. Einige Factory Programme verwenden die Default
Einstellungen. Wenn |hnen der Pitch Shifter im Factory Program #4 gefalit und Sie ihn im Programm #98
verwenden wollen, scrollen Sie einfach zum Stereo Pitch Shifter Modul und rufen mit dem <4> Knopf den
Default (in diesem Fall F4-Octave Up) im Programm #4 auf. Damit ersparen Sie sich die l\nderung aller
Parameter von einem Programm zum anderen.

Eine komplette Liste aller FX Module und deren Defauits finden Sie auf Seite 28.

Modul-Parameter einstellen

Die Parameter jedes Moduls sind auf mehreren Pages angeordnet. Den Eingangspegel eines Moduls
stellen Sie auf Edit Page 2 ein. Wenn Sie sich noch nicht im Edit Mode befinden, driicken Sie die <Edit>
Taste. Nun scrollen Sie mit dem <Program/Effect> Rad zum gewiinschten Modul (in unserem Beispiel: St
Pitch). Mit dem <Page> Knopf scrollen Sie zu Page 2. Jetzt kann der Eingangspegel diese Moduls mit
dem <1> Knopf im Bereich von 0 (Aus) bis 100% verandert werden. Auf gleiche Weise dndern Sie auch
andere Parameter.

Custom Defaults

Sobald Sie die Parameter eines Effect Moduls veréndert haben, kénnen Sie ihn als Teil eines Programmes
speichern. Mit der Speicherung werden diese Einstellungen zum Custom Default fiir dieses Programm,
das damit jedoch nicht zur User Default Bibliothek hinzugefiigt wird. Wie Einstellungen als User Defaults
gespeichert werden, lesen Sie auf Seite 25. ' '
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Editieren eines Moduls

Der 2120 VGS stelit thnen ein riesiges Menu an Factory Effect Defaults zur Verfiigung. Mit Sicherheit
méochten Sie aber von Fall zu Fall kleine Anderungen im gewshlten Modul machen. Die Parameter jedes
Effect Moduls erreichen Sie iiber mehrere Seiten.

1. Driicken Sie die <Edit> Taste. Das Display sieht etwa so aus:

2. Wenn Sie (durch Driicken der <Edit> Taste) in den FX Edit Mode geschaltet haben, kommen Sie
suerst zum Tube Distortion Modul in der Preamp Sektion. Mit Drehen von <Program/Effect>
scrollen Sie durch die verschiedenen Module, bis Sie einen Digital Effect Modul erreicht haben.
Beachten Sie, daB wiahrend des Scrollens der aktuelle Modul in der Effect Routing Matrix blinkt.
Sobald Sie den gewiinschten Modul in der Digital Effects Sektion, der editiert werden soll,
erreicht haben, scrollen Sie mit dem <Page> Knopf durch die Parameter dieses Moduls.

HINWEIS: Jedesmal, wenn ein Effect Modul oder ein Default gedndert wurde, erscheint das CHANGED
Symbol direkt unter dem entsprechenden Parameter des Moduls oder Default.

Durch die Modul Pages scrollen

In der linken unteren Ecke des Display sehen Sie, auf welcher Seite Sie gerade sind, und die
Gesamtanzahl aller Pages in diesem Modul. Auf jeder Page haben Sie mit den Knépfen <1> bis <4>
Zugriff auf bis zu 4 Parameter.

Beispiel:

Um durch die Parameter Pages eines Effect Moduls zu scrollen, driicken Sie die <Edit> Taste. Sobald
diese Taste leuchtet, scroilen Sie mit dem <Program/Effect> Rad zu einem Effect Modul. AnschlieBend
<crollen Sie mit mit dem <Page> Knopf durch die Parameter dieses Effect Moduls.

Eine Beschreibung aller FX Module und ihrer Parameter finden Sie im Abschnitt 4 - Effekte und
Parameter.
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Versionen vergleichen

Beim Editieren von Programmen méchten Sie sicher die editierte Version mit der gespeicherten Original-
Version vergleichen. Gliicklicherweise gibt es im 2120 VGS den hilfreichen A/B Vergleich als Compare
Funktion.

Um ein editiertes Programm mit der gespeicherten Original-Version zu vergleichen, machen Sie
folgendes:

Im FX Mode driicken Sie einmal die <Edit> Taste. In der obersten Zeile des Display steht:

'-’ *Comraring Original Pra®

PAGE ’ OF

Wenn dieser Text angezeigt wird, ist das gespeicherte Programm temporédr geladen und aktiv.

Um zur editierten Version zurtickzuschalten, driicken Sie entweder die <Program> Taste - damit schalten
Sie in den Program Mode; oder die <Edit> Taste - damit kehren Sie in den FX Edit Mode zuriick.

Speichern und Benennen von Defaults

Der Store Vorgang erlaubt lhnen, modifizierte Defaults neu zu benennen, zu verschieben und zu

speichern, damit sie zu einem spateren Zeitpunkt leicht in anderen Programmen wieder aufgerufen
werden kénnen.

Wenn Sie einen Effect Default nach eigenen Vorstellungen verandert oder einen neuen erzeugt haben,

scrollen Sie zuriick zur Page 1 des gerade editierten Moduls (wenn Sie nicht schon dort sind). Das Display
sieht etwa so aus:

'-' Fi:[Hamel Custom
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Auf der Page 1 des FX Edit Menu drehen Sie den <3> Knopf im Uhrzeigersinn. Nun kénnen Sie dem
neuen Default einen Namen geben.
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Default benennen

Mit dem <Program/Effect> Rad sndern Sie das erste Zeichen an der markierten Position.

Sobald das gewiinschte Zeichen an dieser Stelle erscheint, drehen Sie den <Page> Knopf; damit wird der
Cursor auf das nachste zu sndernde Zeichen verschoben.

Mit dem <1> Knopf wird zwischen GroB- und Kleinbuchstaben umgéschaltet. Der <2> Knopf wahlt
Ziffern aus, der <3> Knopf figt Leerzeichen ein. Der <4> Knopf dient zum Kopieren und Einfigen von
Zeichen.

Soll ein Zeichen kopiert werden, positionieren Sie den Cursor mit dem <Page> Knopf unter dem zu
kopierenden Zeichen, anschlieBend drehen Sie den <4> Knopf im Uhrzeigersinn. Um das kopierte
Zeichen einzufiigen, positionieren Sie den Cursor an die gewiinschte Stelle und drehen den <4> Knopf
gegen den Uhrzeigersinn.

Wenn Sie den Store- und Name Vorgang beenden mdchten, driicken Sie entweder die <Program> Taste,
um in den Program Mode suriickzuschalten, oder die <Edit> Taste fir den FX Edit Mode, oder die
<Utilities> Taste fir den Utilities Mode, je nachdem, in welchen Mode Sie schalten mochten.

Default speichern

1. Sobald Sie den gewiinschten Namen eingestellt haben, driicken Sie die <Store> Taste. In der
obersten Display Zeile ist zu lesen:

Store To: [Hamel

Mit dieser Anzeige kénnen Sie den Speicherplatz des neuen User Default auswahlen. Beachten
Sie, daB das Default in der User Default Bank gespeichert wird, da Factory Defaults nicht
iberschrieben werden konnen.

2. Mit dem <2> Knopf wahlen Sie die Default Nummer, unter der das neue Default gespeichert
werden soll.
3. Driicken Sie erneut die <Store> Taste. Das Default wird gespeichert und nun erscheint die

Aufforderung zum Speichern dieser Anderungen in das Programm. Wenn Sie die Anderungen in
das Programm speichern mochten, driicken Sie nochmals die <Store> Taste. Andernfalls driicken
Sie die <FX Edit> Taste.

4. Wenn Sie den Store- und Name Vorgang beenden médchten, driicken Sie entweder die
<Program> Taste, um in den Program Mode zuriickzuschalten, oder die <Edit> Taste fiir den FX
Edit Mode, oder die <Utilities> Taste fur den Utilities Mode, je nachdem, in welchen Mode Sie
schalten mochten.
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Abschnitt 4 - Effekte und Parameter

Digital Effect Modulgréen und -typen

Bei all der schweren Arbeit, die die Digital Effect Module fir Ihren Sound leisten miissen, konnen sie
ganz schdnen Appetit auf Rechenleistung entwickeln. Daher besorgen sie sich ihr Futter vom FX
Tortendiagramm auf Seite 9.

Da einige Effect Module gefraBiger sind als andere, beanspruchen sie auch mehr von der Torte. Als
kleine Hilfe zum Aufteilen des Kuchens haben wir unten eine Tabelle zusammengestellt, die lhnen zeigt,
wieviel Rechenleistung die einzelnen Effect Blocks beanspruchen, und ob der Modul ein Mono-, Stereo-
oder Dual FX Modul ist.

HINWEIS: Die GréBe eines Effect Moduls wird immer auf Page 1-des ausgewahlten Effect Moduls neben
dem [2] Symbcl im Display angezeigt.

- & . .
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Default Liste

Die folgende Liste enthilt die Namen aller
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Effect Defaults im 2120 VGS Artist.
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Effects Bibliothek
Auf den folgenden Seiten finden Sie eine komplette Liste aller Preamp- und Digitaleffekte des 2120 VGS.

Alle Preamp Effect Module haben 2 gemeinsame Parameter auf Page 1:
On/Bypass schaltet den Effect Modul ein oder aus.
Effect Default wahlt eine Preset Einstellung fiir dieses Modul.

Alle Digital Effect Module haben 3 gemeinsame Parameter auf Page 1:
On/Bypass schaltet den Effect Modul ein oder aus.

Effect Module Type wahlt einen Effect fiir diesen Modul aus.
Effect Default wahlt eine Preset Einstellung fiir diesen Effect Typ.

Preamp Modul

Der Preamp Modul ist das Herz des charakteristischen 2120 VGS Sounds. Grundsétzlich besteht der
Preamp Modul aus der Summe aller Einzelmodule und deren Parameter-Einstellungen in der Preamp
Sektion (Compressor, Wah, Tube Distortion und EQ, Solid State Distortion und EQ, und Noise Gate) und
arbeitet in gleicher Weise. Wenn Sie ein anderes Preamp Default aufrufen, werden damit automatisch die
Parameter in allen oben genannten Einzelmodulen auf bestimmte Werte gesetzt. Will heilen, weniger
Arbeit und dafiir mehr spielen. Hier folgen die Parameter des Preamp Moduls:

Effect Default FEine kollektive Einstellung der individuellen Preamp Modul Parameter, fiir den
grundsitzlichen Sound lhres Programms verantwortlich.

TUBEPan Damit kann die Tube Sektion des Preamp im Stereo Panorama entweder nach links oder
nach rechts gepannt werden. **

DISTPan Damit kann die Distortion Sektion des Preamp im Stereo Panorama entweder nach links
oder nach rechts gepannt werden. **

Mix Das ist der Master Effect Mix des Programmes.

Sie kdnnen sogar lhre eigenen Custom Preamp Defaults speichern und in einem anderen Programm
wieder aufrufen, ohne daB3 Sie jedesmal alle Parameter neu programmieren miissen. In einem Custom
Preamp Default werden alle Parameter-Einstellungen aller Effekte im Preamp Modul, inklusive der Pan
Einstellungen gespeichert.

** Die Pan Einstellungen verhalten sich unterschiedlich, in Abhangigkeit von der verwendeten Effect
Konfiguration. Bei einer Series- oder Parallel/Series Konfiguration (am Ende der Kette leuchtet ein L/R
OUTS Symbol) steuert das Pan die Position der Tube- oder Distortion Sektion im linken oder rechten
Kanal der verwendeten Effekte. Bei einer Parallel/Split Konfiguration (am Ende der Kette leuchten zwei
L/R OUTS Symbole) gehen alle nach links gepannten Signale in den oberen Effekt (die oberen Effekte),
und alle nach rechts gepannten Signale in den unteren Effekt (die unteren Effekte) der Konfiguration.
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Preamp Effekte

Compression

In der Welt der Effekte ist der Kompressor ein unschatzbares Werkzeug. Sowohl im Studio als auch auf
der Biihne kann ein Kompressor den Unterschied zwischen Erfolg und Desaster ausmachen. Bei richtigem
Einsatz kann ein hervorragendes Solo, dem nur irgendwie der entscheidende Nachdruck fehlt, derart
lebendig werden, daB es scheinbar aus den Lautsprechern herausspringt. Ein Kompressor andert ab
einer gewissen Lautstarke das Verstirkungsverhaltnis: je lauter das Signal, desto mehr wird die
Verstarkung zuriickgenommen. Damit werden leisere Téne lauter gemacht, der Gitarrensound wird
dichter und gewinnt an Sustain.

Compression Parameter:
Comp On/Bypass schaltet den Compressor Modul ein oder aus

Threshold bestimmt den Schwellwert, iiber dem der Kompressor wirksam wird. Bei niedrigem
THRESHOLD setzt der Kompressor schon bei leiseren Signalen ein, der aligemeine Lautheitseindruck
wird leiser. Der Bereich geht von -35dB bis -5dB.

Compression Ratio steuert das Verstirkungsverhaltnis bei Einsatz des Kompressors. Bei einer
RATIO von 2:1 bewirkt ein Pegelanstieg um 2dB am Eingang eine Pegelerh6hung von 1dB am Ausgang.
Bei einer RATIO von 5:1 bewirkt ein Pegelanstieg um 5dB am Eingang eine Pegelerhdhung von 1dB am
Ausgang. Je héher der RATIO Wert, desto mehr wird das Eingangssignal komprimiert. Der Bereich geht
von 1:1(keine Kompression) bis :1 {Limiter).

Attack regelt die Ansprechzeit des Kompressors. Mégliche Werte sind: Slow (langsam), Medium, Fast
und Very Fast (sehr schnell).

Output Level regelt den Ausgangspegel des Kompressors. Der Bereich geht von OFF bis 20,0dB in
0,5dB-Schritten.

Analoges Wah

Mit dem Analog Wah des 2120 VGS haben Sie das Beste aus beiden Welten, denn dieser analoge Wah
Effekt ist digital gesteuert. Was das genau bedeutet? Ganz ecinfach: Sie haben hier eine prézise Wah
Emulation, die den Nagel auf den Kopf trifft und vom machtigen Processing des 2120 VGS kontrolliert
wird. Dieser Wah Modul basiert auf den beliebtesten Wah Pedalen, die man kaufen kann.

Analog Wah Parameter:
ON/Bypass schaltet den Wah Modul ein oder aus.

Wah Position  bestimmt die Pedal-Position des Analog Wah Effect Moduls. Der Bereich geht von 1-
128. Damit der Modul verwendet werden kann, muf3 diesem Parameter ein Expression FuBpedal
zugeordnet werden.

Wah Type wihlt den Wah Typ aus. Mégliche Einstellungen sind: Toe Heavy (Empfindlichkeit auf der
FuBspitze), Linear und Heel Heavy (Empfindlichkeit an der Ferse)
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Tube Distortions

Die Zeiten, in denen man VerlaBlichkeit gegen die unverwechselbaren Sounds eines alten englischen
oder amerikanischen Réhrenamps mit Stoffbespannung eintauschen muBte, sind nun endgiiltig vorbei.
Die Tube Distortion Sektion des 2120 VGS bietet alles, was der anspruchsvolle Gitarrist begehrt. Und das
Beste - Sie haben mehr als nur einen Preamp Sound zur Verfiigung. Alles da, vom Vintage Tweed iber
British Half bis zum Full Stack.

Tube Distortion Parameter:
Dist On/Off/Bypass schaltet den Tube Distortion Modul ein oder aus

Distortion Type wahlt den Typ der Verzerrung fiir das Programm aus. Die Tube Distortion Typen sind:
Warm Clean - ideal fur einen cleanen Sound, Bright Clean - besonders fir Blues geeignet, Dirty Tube -
ibersteuertes Blues Solo oder dreckige Rhythmus-Gitarre, und Saturated Tube - satt (ibersteuerter
Réhrenamp.

Distortion Gain regelt die Verstirkung im ausgewahlten Distortion Typ. Der Bereich geht von 0-100.

Solid State Distortions

Im 2120 VGS gibt es nicht nur starke Tube Preamp Sounds, sondern auch die Solid State (Transistor)
Preamp Sektion. Und auBerdem kénnen Sie beide Distortion Signalwege gleichzeitig verwenden. Die
Solid State Distortions im 2120 VGS bieten groBte Flexibilitdt und ergénzen die Tube Distortion Sounds
auf ideale Weise.

Solid State Distortion Parameter:

On/Off/Bypass schaltet den Solid State Distortion Modul ein oder auf Bypass.

Distortion Type wihlt den Typ der Solid State Verzerrung aus. Die Solid State Distortion Typen sind:
Grunge - Industrial Music Industriestandard, Fuzz - Fuzz-face Distortion, Overdrive - klassischer
Distortion Screamer, und Heavy Sustain - schwerst gesattigter Solo Sound.

Distortion Gain regelt die Verstiarkung im ausgewahlten Distortion Typ. Der Bereich geht von 0-100.

10-Band Grafische EQs im Tube- und Solid State Distortion Path

In jedem Tube- und Solid State Distortion Path Programm des 2120 VGS ist ein 10-Band Grafik EQ mit
+12dB Regelbereich in 1dB-Schritten integriert. HINWEIS: dieser EQ ist véllig unabhangig vom
Global/lLocal EQ und den EQ Effect Modulen im Program Mode.

Noise Reduction

Sie werden sehen: das Silencer Il Noise Reduction-System wird noch lhr bester Freund bei Aufnahme
Sessions oder Live Auftritten, denn diese Rauschreduktion halt lhre Signale blitzsauber und frei von
storenden Nebengerauschen. Dariiber hinaus kann die Noise Reduction an verschiedenen Punkten im
Signalweg des 2120 VGS eingesetzt werden: besonders praktisch, wenn zusatzliche Noise Reduction in
verschiedenen Bereichen gebraucht wird.

Noise Reduction Parameter:

Type  wahlt den Typ und die Plazierung der Noise Reduction. Die Mdglichkeiten sind: 1. Silencer 1 pre
T&D (vor Tube und Distortion), 2. Silencer Il post T&D (nach Tube und Distortion), 3. Silencer Il post Tube
(nach Tube), und 4. Silencer Il post Solid State Distortion (nach Solid State Distortion).

Threshold bestimmt den Schwellwert, unter dem die Noise Reduction wirksam wird. Der Bereich
geht von -90 bis 0.
Attenuation regelt die Signaldampfung bei geschlossenem Gate. Der Bereich geht von 1 bis 5.

Attack bestimmt die Schnelligkeit, mit der das Gate bei Uberschreiten von Threshold &ffnet. Der
Bereich geht von 1 bis 10.

31




Release legt fest, wie schnell das Gate schlieBt, nachdem das Signal den Threshold unterschritten hat.
Der Bereich geht von 1 bis 10.

Global/Local EQ und Mix

Die Einstellregler fiir die Global/Local EQ und Mix Sektion an der Frontplatte sind nur dann wirksam,
wenn der 2120 VGS im Program Mode ist. Dieser EQ hat zwei verschiedene Einstellmdglichkeiten: Global
£Q und Mix Einstellungen beeinflussen alle Programme, wihrenddessen Local EQ und Mix Einstellungen
nur auf das jeweils aktive Programm wirken. Die zugehérigen Einstellungen fir Global/Local EQ und Mix
finden Sie im Utilities Menu auf Page 1.

Global/Local EQ und Mix Parameter:

Bass regelt die Bass EQ Frequenzen im 2120 VGS, entweder global oder lokal. Der Regelbereich
betragt +12dB in 1dB-Schritten.

Mid regelt die mittleren EQ Frequenzen im 2120 VGS, entweder global oder lokal. Der Regelbereich
betragt +12dB in 1dB-Schritten.

Treble regelt die hohen EQ Frequenzen im 2120 VGS, entweder global oder lokal. Der Regelbereich
betragt +12dB in 1dB-Schritten.

Mix bestimmt den gesamten Digital Effect Mix der 2120 VGS Programme. Der Bereich geht von 0 bis
100%. Ist Mix auf Global Mode eingestellt, so verandert der <Mix> Knopf prozentuell den in den
einzelnen Programmen gespeicherten Mix Wert.

Digitale Effekte

Reverbs

Reverberation {oder Hall) ist wahrscheinlich der am meisten eingesetzte Effekt, denn damit kdnnen die
akustischen Reflexionen der meisten Radume nachgebildet werden. In einem realen Raum ist "Hall" das
Resultat von Sound Reflexionen, die durch Wande, FuBbdden, Decken und Objekte im Raum entstehen.
Die Oberflichen und Materialien, die GréBe und Form des Raumes bestimmen, wie lang diese Echos
auftreten und wie schnell sie verklingen. Dies Faktoren helfen bei der Bestimmung der akustischen
Charakteristik eines Raumes, etwa wie lange die hohen Frequenzen im Verhdltnis zu den Bassen
reflektiert werden, oder wieviele "erste" Reflexionen entstehen, wenn der Schall die Wande des Raumes

trifft.

Die moderne Technologie des 2120 VGS stellt eine komplette Palette von flexiblen und leicht
einzusetzenden Halleffekten bereit. Grundsatzlich stehen fiinf verschiedene Reverbs und ein Room Echo
Effekt zur Auswahl:

1) Reverb Einfacher, geradliniger Hall, nur mit den wichtigsten Parametern ausgestattet.

2) Dual Reverb Multidimensionaler Hall mit flexiblen Frequenzband Split Méglichkeiten. Der Reverb
kann mit Hilfe von einstellbaren High- oder Low Pass Frequenzweichen in primére und sekundire Stufen
aufgeteilt werden.

3) Stereo Reverb Eine echte Stereo Version des Reverb Moduls.

4) Stereo Dual Reverb  Eine echte Stereo Version des Dual Reverb Moduls.
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5) Gated Reverbs Ein sehr linearer Halleffekt mit hoher Energie, dessen Ausklang absinken, gleich
bleiben oder sogar ansteigen kann; damit kénnen auBergewdhnliche Umgebungseffekte erzeugt
werden.

6) Room Echo  Ein echtes Stereo Delay mit mehrfachen Abgriffen fiir kleine Umgebungen. Die Delays
sind in vier Sektionen fiir die Simulation von ersten Reflexionen aufgeteilt. Diese kénnen frei im Stereo
Panorama plaziert und nach Belieben dichter oder diinner gemacht werden. Das Room Delay hat auch
eine feedback Loop (Riickkopplungsschleife) zur Delay Regeneration.

Reverb

Im richtigen Leben ist Hall das Ergebnis von Schallreflexionen an den umgebenden Flichen eines Raumes
oder einer Halle. Am besten kann man sich Reverb als Millionen kleiner Echos vorstellen, die iiber einen
bestimmten Zeitraum schwiacher werden. Die GroBe des Raumes, die Oberflichen und Materialien der
Wande, Teppiche am FuBboden und Vorhénge bestimmen, wie der Raum klingt und wie er sich akustisch
verhalt.

Wann verwende ich Reverb? Im Studio so gut wie immer. Zum Beispiel werden viele Gitarren-Spuren in
einer sehr sterilen (sehr "trockenen® oder schalltoten) Umgebung aufgenommen. Der Halleffekt macht
daraus Uppige Gitarren Tracks mit jeder Menge Tiefe.

Warum solite ich Stereo Reverb verwenden? Das hat ganz einfach mit Natiirlichkeit zu tun. Heutzutage
werden so gut wie alle Musikaufnahmen in Stereo gemacht, denn sie klingen so am natiirlichsten und das
Original-Klangbild bleibt erhalten. Stereo Reverb unterstiitzt dieses Original Stereo Abbild. Andererseits
wurden zahllose Hit Aufnahmen mit Halleffekten gemacht, die einen Mono Eingang haben und daraus
ein Stereo Hallsignal erzeugen. Die Theorie dahinter lautet, daB ein Sound im aligemeinen von einem
einzigen Punkt im Raum ausgeht, sodaf ein Mono Eingangssignal in vielen Fallen ausreicht. Ein guter Tip:
verwenden Sie in Live Situationen nicht zuviel Reverb fiir Ihre Gitarre. Selbst wenn der Raum klein ist, hat
er doch noch etwas natiirlichen Hall. Bei zuviel Halleffekt geht die Gitarre irgendwo verloren. Passen Sie
also den Sound dem Raum an.

Gated Reverb

Ein Hall mit Gate Effekt verhalt sich nicht so natiirlich wie die Standard Reverb Variationen. Urspriinglich
wurde Gated Reverb mit einem langen, dichten Halleffekt erzeugt, dessen Ausklang abrupt mit einem
Noise Gate abgeschnitten wurde - daher auch der Name. Auf diese Weise entstand ein kurzer Schwall an
Hallenergie, der verschiedene Sounds wesentlich dicker machen konnte. Verbesserte digitale
Signalprozessoren erméglichten bald Gated Reverb Sounds, die entschieden besser einsetzbar und
flexibler waren. Heutzutage werden Gated Reverbs nicht mehr mit einem Gate abgeschnitten, sie klingen
nur so. Tatsachlich besteht ein Gated Reverb aus einer groBen Menge von Delay Abgriffen, die fiir
diesen Sound verantwortlich sind. Damit kénnen Sie sowohl die Lange des Effekts als auch seine
Hillkurve in jeder Hinsicht variieren.

Wann verwende ich Gated Reverb? Ein Gated Reverb in einer Multieffekt-Anwendung ist ideal fir die
Erzeugung von ungewdhnlichen Spezialeffekten. Damit k&nnen Sie zum Beispiel einen Gitarrenton
"anschwellen” lassen. Dieser Hall-Typ ist auch bestens fiir einen Riickwirts-Maskiereffekt geeignet.

Reverb Parameter:

HINWEIS - Nicht alle Parameter sind in allen Reverb Typen vorhanden.

FX: Lvl regelt den Eingangspegel des Moduls. Der Bereich geht von O bis 100%.

Dry: Lv! regelt den Pegel des "trockenen” (unbeeinfluBten) Signals. Der Bereich geht von Off bis
100%.

Balance bestimmt die Position des Dry Signals im Stereo Panorama. Der Bereich geht von -99

(ganz links) bis 99 (ganz rechts).
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Type

Density

Dispersion

Diffusion

X-Over Type

X-Over Freq
Prim & Secd X-Over

Prim & Secd Damp

Low Pass

Time

Blend

Prim & Secd Blend

Decay

wihlt den Reverb Typ. Jeder Raum hat einen verschieden langen Ausklang (so wie im
richtigen Leben), daber sndert TYPE auch die Lange des Ausklangs. Die Typen sind:
Studio Room, Wood Room, Vocal Plate, Concert Hall, Plate Reverb, Chamber, Cathedral,
Arena, Cement Shelter und Infinite Spring (Federhall); weiters Flat, Shelf, Decaying Linear,
Decaying Logarithmic, Decaying Exponential, Decaying Sine, Reverse Linear, Reverse
Logarithmic, Reverse Exponential, Reverse Sine, Peaking Linear und Peaking Exponential
{(fur Gated Reverbs).

bestimmt die Anzah! der diskreten Wand-Reflexionen wahrend des ersten Teils von
DECAY. Héhere Werte erzeugen mehr Reflexionen, niedrigere Werde ergeben weniger
erste Echos. Im Zusammenhang mit DISPERSION kann die Horbarkeit friher
Reflexionsanhiufungen am Beginn des Halls verstirkt oder abgeschwacht werden. Der
Bereich geht von 0 bis 100%.

bestimmt den Abstand (die Zeit) zwischen den mit DENSITY eingestellten Echos. Wenn
DENSITY niedrig und DISPERSION hoch eingestellt ist, hdrt man Echos am Beginn des
Raumhalls. Dispersion ist wahrnehmbar als diskrete Echos, denen ein weicher Raumhall
folgt. Niedrige DISPERSION Werte ergeben eine dichte Anhaufung von Reflexionen im
ersten Teil von DECAY. Der Bereich geht von 1 bis 10.

simuliert verschiedene Oberflachenmaterialien durch Steuerung der Weichheit des Halls
im Zusammenhang mit DECAY. Niedrige DIFFUSION Einstellungen ahmen harte ebene
Flachen nach, hohere Werte simulieren unregelmaBige Oberflachen, wie etwa natirliche
Steinmauern oder kunstliche Schalldiffusoren. Im Gegensatz zu ebenen Flachen
reflektieren (verteilen) diese Materialien durch ihre UnregelmaBigkeit den Schall in viele
Richtungen Damit klingt der Hallverlauf wesentlich weicher. Der Bereich geht von 0 bis
99%.

wahlt den Typ der Frequenzweiche (Crossover) fiir die primaren und sekundéren
Halistufen. Die zwei méglichen Typen sind High Pass (HP) und Low Pass (LP).

wihlt die Ubergangsfrequenz von X-Over. Der Bereich geht von 25Hz bis 20kHz.

Diese zwei Parameter schalten den Crossover fiir jede Hallstufe ein und aus. Bei Off hat
die entsprechende Hallstufe volle Bandbreite, andernfalls wird der Frequenzbereich durch
X-Over Type und X-Over Freq beschnitten.

legt fest, wie schnell der Raum hochfrequente Hallanteile absorbiert. In einem realen
Raum kann schallschluckendes Material zur Dampfung der natirlichen hochfrequenten
Hallanteile eingesetzt werden. Hohe DAMP Werte bewirken, dal3 der Raumhall dunkler
wird und iber den Zeitraum von DECAY weniger definiert ist. Niedrige Werte bewirken
weniger dramatische Raumeffekte. Der Bereich geht von 1 bis 10. .

bestimmt die Grenzirequenz, oberhalb der die hoheren Frequenzanteile gedampft
werden. Damit kénnen hell kiingende Gated Reverbs dunkler gemacht werden. Der
Bereich geht bei Gated Reverb von 100Hz bis 8kHz, und bei Stereo Gated Reverb von
100Hz bis 20kHz.

bestimmt die Lange des Gated Reverb in ms (ahnlich dem DECAY Parameter eines
normalen Halls). Der Bereich geht bei Gated Reverb von 25 bis 300ms, und bei Stereo
Gated Reverb bis zu 500ms.

mischt Hallanteile von der linken zur rechten Seite und umgekehrt. Damit kann der
Realismus des simulierten Raumes deutlich erhdht werden, die Addition von Hallanteilen
aus verschiedenen Positionen im Raum zu jedem Kanal tragt dazu bei. Der Bereich geht
von 0 bis 99%.

bestimmt den BLEND Anteil fir die primaren und sekundaren Hallstufen. Die
Beschreibung von BLEND finden Sie oben.

regelt die Lange des Raumhalls (auch als RT60 bezeichnet). Dieser Parameter kénnte auch
auf zwei Parameter fir Raumgrofe und Raumreflexionen aufgeteilt werden, zur
einfacheren Bedienung wurden sie aber hier zusammengefalt. Fir die Simulation
gréBerer Raume nehmen Sie langere DECAY Werte, fur kleinere sind kiirzere DECAY
Werte einzustellen. Bei letzteren nehmen Sie die DENSITY Einstellung zuriick, um einen
natiirlicheren Hallveriauf zu erhalten. Der Bereich geht von 0,5 bis 23sec, abhangig vom
gewahlten Reverb Type.
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Prim & Secd Decay steuert die Lange des Halls (RT60) fiir die primaren und sekundaren Hallstufen. Dieser

Prim & Secd Size

Prim & Secd Reflct

Delay A
Delay B
Delay C
Delay D

OutA-D
BalA-D
Shape

Spread
FB: Dly

Amount
QutlL-R

Prim Qut L
Prim Out R
Secd Out L

Secd Out R

Parameter arbeitet mit den SIZE und REFLCT Parametern zusammen. GrofB3e SIZE und
REFLCT Werte ergeben langere Hallausklang-Zeiten, kleinere Werte reduzieren den
Hallausklang, sind aber besser zur Simulation kleinerer Umgebungen geeignet. Der
Bereich geht von 0,26 bis 11sec.

andert die relative RaumgroBe der primaren und sekundéren Hallstufen. Der Bereich geht
von 1 bis 5.

beeinfluBt die Dampfung der wiederkehrenden Reflexionen. Harte glatte Materialien, wie
Glas und Holz, zeigen mehr Reflexionsenergie als weicheres poréses Material. Diesen
Parameter kann man sich auch als Regler fur die "Lebendigkeit” des Raumes vorsteilen.
Der Bereich geht von 1 bis 10.

bestimmt die Zeitspanne, nach der Delay Group A horbar wird. Der Bereich geht von 0 bis
120ms.

bestimmt die Zeitspanne, nach der Delay Group A und B hérbar werden. Der Bereich geht
von 0 bis 120ms.

bestimmt die Zeitspanne, nach der Delay Group B und C horbar werden. Der Bereich geht
von 0 bis 120ms.

bestimmt die Zeitspanne, nach der Delay Group C und D horbar werden. Der Bereich
geht von 0 bis 120ms.

regelt den Ausgangspegel der Delay Groups. Der Bereich geht von 0 bis 100%.
regelt die Links/Rechts Balance der Delay Groups. Der Bereich geht von -99 bis 99.

wahlt die Hillkurve der Ausgangspegel der Delay Groups Abgriffe. Méglich sind: Flat,
Peak, Decreasing, Increasing, Shelf und Reverse Shelf.

bestimmt die Basisbreite des Stereo Effekts. Der Bereich geht von 1 bis 10.

verandert die Zeitspanne, nach der das Delay riickgekoppelt wird. Der Bereich geht von 0
bis 170ms.

regelt die Stirke der Ruckkopplung fir das Delay. Der Bereich geht von Off bis 50%.

bestimmt den allgemeinen Pegel der linken/rechten Seite des Reverb. Der Bereich geht
von Off bis 100%.

bestimmt den Pegel der linken Seite des Primary Reverb. Der Bereich geht von Off bis
100%.

bestimmt den Pegel der rechten Seite des Primary Reverb. Der Bereich geht von Off bis
100%.

bestimmt den Pegel der linken Seite des Secondary Reverb. Der Bereich geht von Off bis
100%.

bestimmt den Pegel der rechten Seite des Secondary Reverb. Der Bereich geht von Off
bis 100%.

Choruses und Flangers

Sowohl Chorus- als auch Flanger Effekte verwenden einen Low Frequency Oscillator (LFO) fir diese
dicken, schwebenden Sounds. Bei Anderung der Speed- und Depth Parameter regeln Sie in Wirklichkeit
die Frequenz und Amplitude des LFO. Diese Einstellungen bestimmen den Rhythmus und Intensitét des

Modulation Effekts.

Chorus und Flanger funktionieren prinzipiell wie folgt: nach dem Moduleingang wird das Audiosignal auf
zwei Signalwege aufgeteilt. Den ersten Pfad durchlauft das Signal ohne Anderung, im zweiten Pfad wird
das Signal verzégert und in der Tonhéhe verandert. Der modifizierte Sound gelangt dann zusammen mit
dem Original an den Ausgang. Im unten gezeigten Bild 4-1 wird ein Sinussignal zur Tonhéhen-Modulation
des aufgesplitteten Audiosignals verwendet.
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Der Dual Chorus erzeugt zwei unterschiedliche Pitch *Voices” (Stimmen), und der Octal Chorus acht
Voices fiir besonders volle, dicke Sounds.

Modulierter Sound
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Original Sound
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B:ﬂd 4-1: Beispiel einer Modulation i H M E J— gﬁmcgioﬁ?‘gnd

Der einzige Unterschied zwischen Chorus und Flanger besteht darin, dal3 Flangers weniger Delay haben
und einen Feedback Parameter verwenden, der einen Teil des bearbeiteten Signals an den
Moduleingang zuriickfihrt. Dieses Signal wird erneut durch den Modul geschickt und erzeugt so ein
dickeren und tieferen Eindruck. Wird Feedback noch weiter verstarkt, so verliert die Signalquelle ihre
urspriingliche  Tonhdhe und nimmt die dramatische Tonhohen-Modulation der  Feedback
Riickkopplungsschleife an.

LFO Wellenformen: Fiir Choruses, Flangers, Phasers, Tremolos, Auto Panners und Modifiers sind vier
verschiedene LFO Wellenformen moglich - SINe (Sinus), TRlangle (Dreieck), SPecial-1 (positive Halbwelle)
und SPecial-2 (negative Halbwelle). Im Bild 4-2 sehen Sie Beispiele dieser Wellenformen.

AM PLITUDE (DEPTH)
AMPLITUDE (DEPTH)
AMPLITUDE (DEPTH)
AMPLITUDE (DEPTH)

JFR qugN'Y (éEED :
SINE LFO TRIANGLE LFO SP1LFO SP2 LFO

Bild 4-2: Einige LFO Wellenformen

Amplitude {Depth - Tiefe)

Frequenz (Speed - Geschwindigkeit)

Chorus

Chorus ist wahrscheinlich der am haufigsten genutzte Modulationseffekt. Tatsachlich besteht Chorus aus
einem sehr kurzen Delay, dessen Lange standig variiert. Durch diese seitliche Veranderung andert sich
auch die Tonhéhe des verzogerten Signals (wie bei einer analogen Bandmaschine - der Ton wird héher,
wenn sie schneller 13uft). Wird nun die Verzogerung fanger oder kiirzer, so horen Sie einen Sound, der
einmal in Stimmung und dann wieder zu hoch oder zu tief ist. Bei Kombination mit dem Originalsignal
klingt es fast so, als ob mehrere Instrumente gleichzeitig spielen. Zum Beispiel verwendet der Octal
Chorus acht Chorus Stimmen fur ein unglaubliches Sound Ensemble. Abgesehen von den offensichtlichen
Speed- und Depth Parametern (die die Geschwindigkeit und Stirke der Tonhdhen-Verschiebung steuern)
haben Sie im 2120 VGS verschiedene Modulations-Wellenformen zur Verfigung. Diese bestimmen, auf
welche Art die Tonhshe verandert wird.
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Die TRIangle (Dreieck-) Wellenform ist besonders beliebt fiir langsame, eher flache Chorus Einstellungen,
wihrend SINe (Sinus) besonders gut fiir schnellere und stérkere Effekte geeignet ist.

Wann verwende ich Chorus? Die Anwendungen fiir Chorus sind so vielféltig, daf3 die Frage eigentlich
lauten sollte: "Wann verwende ich KEINEN Chorus”. Bei Blues drehen Sie die Speed- und Depth
Parameter auf, um einen Leslie-dhnlichen Effekt zu erhalten. Fir "groBe" Rockgitarren macht Chorus
einen dickeren und raumlicheren Sound. Und bei jedem Clean Tone Program sorgt Chorus fir
wunderschéne und angenehme Gitarren.

Chorus Parameter:

FX: Lvl regelt den Eingangspegel des Moduls. Der Bereich geht von Off bis 100%.

Dry: Lvl regelt den Pegel des "trockenen™ {unbeeinfluBBten) Signals. Der Bereich geht von Off bis
100%.

Balance bestimmt die Position des Dry Signals im Stereo Panorama. Der Bereich geht von -99
(ganz links) bis 99 (ganz rechts).

Speed steuert die LFO Frequenz (Geschwindigkeit). Der Bereich geht von 0,06 bis 16,0Hz.

Depth steuert die Intensitat des Chorus Effekts. Hohe Werte erzeugen dramatische Modulation,
niedrige Werte sorgen fiir subtilere, ambiente Schwebungen. Der Bereich geht von 0 bis
30ms.

Depth1-2 DEPTH1 regelt die Intensitat der Chorus Voices 1-4. DEPTH2 regelt die Intensitat der
Chorus Voices 5-8. Der Bereich geht von 0 bis 30ms.

Wander Speed steuert die Frequenz des sekunddren LFO der Chorus Voices 5-8. Das ist ein sekundarer
Oszillator fur Voices 5-8, der Abweichungen vom mit DEPTH2 eingestellten Oszillator-
Pfad erzeugt. Bei kreativer Verwendung kann dieser Parameter radikal neue Texturen
erzeugen. Versuchen Sie Einstellungen, die knapp unter oder Gber SPEED liegen. Der
Bereich geht von 0,06 bis 2,0Hz.

Wander Depth regelt die Intensitat der mit WANDER SPEED erzeugten Oszillationsabweichungen.
WANDER DEPTH erzeugt dramatische psychoakustische Schwebungseffekte, wenn der
Wert grofer als DEPTH2 ist. Der Bereich geht von 0 bis 10ms.

WvFrm wahlt die LFO Wellenform. Méglich sind: SINe (Sinus), TRlangle (Dreieck), SP1 (Special 1)
und SP2 (Special 2). Siehe Bild 4-2.

Dly A-B regelt die Delay Zeiten der Chorus Voices A und B. Héhere Werte erzeugen
dramatischere Schwebungen. Der Bereich geht von 0 bis 60ms.

DlyC-D regelt die Delay Zeiten der Chorus Voices C und D. Hdhere Werte erzeugen
dramatischere Schwebungen. Der Bereich geht von 0 bis 60ms.

DlyE-H regelt die Delay Zeiten der Chorus Voices E bis H. Héhere Werte erzeugen dramatischere
Schwebungen. Der Bereich geht von 0 bis 60ms.

OutA-B bestimmt den allgemeinen Ausgangspegel von Chorus Voice A oder B. Der Bereich geht
von Off bis 100%.

Pan A-B steuert die Links/Rechts Balance von Chorus Voice A oder B. Der Bereich geht von -99 bis
99.

OutC-D bestimmt den allgemeinen Ausgangspegel von Chorus Voice C oder D. Der Bereich geht
von Off bis 100%.

PanC-D steuert die Links/Rechts Balance von Chorus Voice C oder D. Der Bereich geht von -99 bis
99.

Out LA - LB bestimmt den linken Ausgangspegel von Chorus Voice A oder B. Der Bereich geht von
Off bis 100%.

Out RA - RB bestimmt den rechten Ausgangspegel von Chorus Voice A oder B. Der Bereich geht von
Off bis 100%.

Spread steuert die Stereo Basisbreite des Effekts. Je hoher der Wert, desto breiter die Stereo

Abbildung. Bei niedrigeren Werten fallt der Effekt zunehmend nach Mono zusammen. Der
Bereich geht von 1 bis 10.
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Flanger

Ein Flanger ist einfach ein Chorus Effekt, dessen Ausgang an seinen Eingang riickgekoppelt wird und am
besten als “rohrender” hohler Sound beschrieben werden kann, da er shnlich wie Reflexionen innerhalb
einer groBen Beton- oder Metallréhre klingt. Flanging ist ebenfalls ein Modulationseffekt, Sie horen eine
Menge von sich bewegenden Schwebungen. Damit ist Flanging ein sehr farbiger Effekt, den man auch
leicht iibertreiben kann. Je mehr Feedback der Flanger hat, desto intensiver wird der charakteristische
Sound.

Wann verwende ich einen Flanger? Elektrische Gitarre ist der Sound, der formlich nach Flanging fleht.
Der Effekt ist sehr gut sowohl fur cleane als auch verzerrte Gitarrensounds geeignet. Bei hcheren Speed-
und Depth Werten werden dem allgemeinen Gitarrensound mehr Tiefe und Kérper hinzugefigt.

Flanger Parameter:

FX: bl regelt den Eingangspegel des Moduls. Der Bereich geht von Off bis 100%.

Dry: Lvl regelt den Pegel des “trockenen” (unbeeinfluBten) Signals. Der Bereich geht von Off bis
. 100%.

Balance bestimmt die Position des Dry Signals im Stereo Panorama. Der Bereich geht von -99
e (ganz links) bis 99 (ganz rechts).

Speed steuert die LFO Frequenz (Geschwindigkeit) des Flanger. Der Bereich geht von 0,06 bis

16,0Hz.
Depth steuert die Intensitat des Flange Effekts. Hohe DEPTH und FDBCK Werte erzeugen

dramatische, synthesizerartige Texturen. Der Bereich geht von 0 bis 30ms.

FdBck bestimmt, wieviel Flange Signal an den Moduleingang riickgekoppelt wird. Der FDBCK
Parameter ist fir den charakteristischen Flange Sound verantwortlich. Flangers konnen
sowohl positive als auch negative Feedback Schleifen haben - experimentieren Sie so
fange, bis Sie lhren Lieblingssound gefunden haben. Der Bereich geht von -99%
{negatives Feedback) bis 99 (positives Feedback).

WvFrm wihlt die LFO Wellenform. Maglich sind: SINe (Sinus), TRIangle (Dreieck), SP1 (Special 1)
und SP2 (Special 2). Sinus Modulation ist wahrscheinlich die beliebteste und am
jeichtesten erkennbare Einstellung; die weichere Modulation mit Triangle oder die
Intensitat von SP1 oder SP2 produzieren jedoch meist bessere Ergebnisse. Siehe Bild 4-2.

DiyA-B regelt die Delay Zeiten der Flange Voices A und B. Niedrigere Werte erzeugen
dramatischere, tiefere Schwebungen. Der Bereich geht von O bis 60ms.

OutA-B bestimmt den allgemeinen Ausgangspegel von Flange Voice A oder B. Der Bereich geht
von Off bis 100%.

Pan A-B steuert die Links/Rechts Balance von Flange Voice A oder B. Der Bereich geht von -99 bis

e 99.

OutL-R bestimmt den linken oder rechten Ausgangspegel des Flanger. Der Bereich geht von Off

g bis 100%.

Phasers

Der Phaser (oft auch als "Phase Shifter” bezeichnet) ist ein klassischer Effekt aus den 70er Jahren, dessen
warmer Schwebungseffekt durch Signal-Phasenausloschungen entsteht. Dazu wird eine Kopie des Signals
kontinuierlich in der Phase verschoben und mit dem Originalsignal gemischt. Dadurch werden standig
wechselnde Frequenzen ausgeldscht und es entsteht ein weicher, sich drehender Sound. Ein Feedback
Weg schickt das phasenverschobene Signal zurlck an den Ausgang des Phaser, wodurch sich der Effekt
nochmals verstarkt.

Wann verwende ich einen Phaser? Der klassische Phaser Effekt wird meist bei Gitarren eingesetzt. In den
Hits der 70er sind jede Menge tolle Beispiele zu horen, denn damals liebten die Gitarristen ihre Phaser
Boxen sehr... Der Phaser Effekt kommt besonders gut bei cleanen und funky Rhythmusgitarren.
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Phaser Parameter:

FX: Lvl
Dry: Lvl

Balance

Speed
Depth

FdBck

WvFrm

OutA-B

PanA-B
Outl-R

Rotary Speaker Simulator

regelt den Eingangspege! des Moduls. Der Bereich geht von Off bis 100%.
regelt den Pegel des "trockenen” (unbeeinflul3ten) Signals. Der Bereich geht von Off bis 100%.

bestimmt die Position des Dry Signals im Stereo Panorama. Der Bereich geht von -99 (ganz
links) bis 99 (ganz rechts).
steuert die LFO Frequenz (Geschwindigkeit) des Phaser. Der Bereich geht von 0,06 bis 16,0Hz.

steuert die Intensitat des Phaser Effekts. Hohe DEPTH und FDBCK Werte erzeugen
dramatische, synthesizerartige Texturen. Der Bereich geht von 0 bis 30ms.

bestimmt, wieviel phasenverschobenes Signal an den Moduleingang riickgekoppelt wird. Der
FDBCK Parameter ist fiir den charakteristischen resonanten Phaser Sound verantwortlich. Der
Bereich geht von -99% (negatives Feedback) bis 99 (positives Feedback).

wiahlt die LFO Wellenform. Maglich sind: SINe (Sinus), TRIangle (Dreieck), SP1 (Special 1) und
SP2 (Special 2). Sinus Modulation ist wahrscheinlich die beliebteste und am leichtesten
erkennbare Einstellung; die weichere Modulation mit Triangle oder die Intensitat von SP1 oder
SP2 produzieren jedoch meist bessere Ergebnisse. Siehe Bild 4-2.

bestimmt den allgemeinen Ausgangspegel von Phaser Voice A oder B. Der Bereich geht von
Off bis 100%.

steuert die Links/Rechts Balance von Phaser Voice A oder B. Der Bereich geht von -99 bis 99.

bestimmt den linken oder rechten Ausgangspegel des Phaser. Der Bereich geht von Off bis
100%.

1

Der Rotary Speaker Simulator ahmt den klassischen Sound von rotierenden Lautsprechern nach und
vermeidet zuverldssig chiropraktische Probleme, die man sich beim Schleppen von schweren
Lautsprecherkabinetten aus Vollholz und mit eingebautem R&hrenamp zuzieht. Der Rotierende
Lautsprecher ist fir viele einzigartige Musiksounds verantwortlich. Die Anwendungen fiir diesen Effekt
sind sehr vielseitig; nicht nur Organisten schitzen den Rotary Sound, auch Stars wie the Allman Brothers
oder der legendére Stevie Ray Vaughn verwenden diesen erstaunlichen Effekt.

Rotary Speaker Simulator Parameter:

FX: Lvl
Dry: Lvl

Balance

Mode

Spread

H - R: Level

regelt den Eingangspegel des Moduls. Der Bereich geht von Off bis 100%.

regelt den Pegel des “trockenen” (unbeeinfluBten) Signals. Der Bereich geht von Off
bis 100%.

bestimmt die Position des Dry Signals im Stereo Panorama. Der Bereich geht von -99
(ganz links) bis 99 (ganz rechts).

wahlt die Rotationsgeschwindigkeit von Rotor (rotierende BaBBablenkung - im unteren
Teil des Lautsprecherkabinetts) und Horn (rotierendes Doppel-Hochtonhorn - im
oberen Teil des Kabinetts). Méglich ist Fast (schnell) oder Slow (langsam).

bestimmt die Stereo-Trennung der beiden Mikrofone zur Abnahme des Hochton-
Horns. Der Bereich geht von 0 bis 100%.

bestimmt den aligemeinen Ausgangspegel von Horn oder Rotor. Der Bereich geht von
Off bis 100%.

Slo - Fast Hrn Speed  steuert die Frequenz des LFO fiir das Hochton-Horn und legt dessen Slow- oder Fast

Geschwindigkeit fest. Der Bereich geht von 0,06 bis 16,0Hz.

Slo - Fast Hrn Depth  steuert die Effekt-intensitat des sich drehenden Hochton-Horns. Der Bereich geht von

0 bis 30ms.

Slo - Fast Hrn Doppler bestimmt die Starke der duch den Doppler-Effekt verursachten

Tonhdhenverschiebung im Horn-Teil. Der Bereich geht von 0 bis 50ms.

Slo - Fast Rtr Speed steuert die Frequenz des LFO fir den BaB-Rotor und legt dessen Slow- oder Fast

Geschwindigkeit fest. Der Bereich geht von 0,06 bis 16,0Hz.

Slo - Fast Rtr Depth steuert die Effekt-Intensitat des sich drehenden BaB-Rotors. Der Bereich geht von 0

X-Over

bis 30ms.

bestimmt die Ubergangsfrequenz zwischen Hochton-Horn und BaB3-Rotor. Der Bereich
geht von 25Hz bis 20kHz.
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Acceleration: H - R legt die durch die mechanische Tragheit von Horn oder Rotor verursachte
Beschleunigungsphase fest, nach der beide Teile ihre Endgeschwindigkeit (Fast oder
Slow) erreicht haben. Der Bereich geht von 0 bis 10 Sekunden.

" Tremolo und Auto-Panner

Musiker am Puls der Zeit werden es schon bemerkt haben: die populdren Tremolo- und Auto-Panner
Effekte der 50er und 60er Jahre sind wieder angesagt. Effekte, die vor allem den "Surf Style”
revolutioniert haben, tdnen am Ende dieses Jahrhunderts aus allen Radiogeraten. Sowoh! Tremolos als
auch Auto-Panners verwenden einen LFO zur Lautstarken-Modulation und erzeugen damit einen von
Réhrenamps bekannten "Vibrato"-Effekt.

Tremolo

Die Bezeichnung "Tremolo” hat in der Musikwelt mehrere Bedeutungen. Der hier gemeinte Effekt
besteht im wesentlichen darin, da die Amplitude (Lautstirke) eines Signals moduliert wird - der Pegel
verindert sich rhythmisch. Das kann man auch mit dem Volume Regler auf der Gitarre oder am
Verstarker bewerkstelligen, indem man ihn gleichmaBig auf- und zudreht. Nachdem Sie aber wahrend
eines Songs mit Sicherheit etwas besseres zu tun haben, als andauernd am Lautstarkeregler zu drehen,
besorgt das der 2120 VGS fir Sie.

Abgesehen von den Speed- und Depth Parametern wird das Tremolo auch durch die Wellenform eines
LFO gesteuert, welche die Art der Lautstirkeveranderung bestimmt. Sinus ist moglicherweise der am
meisten eingesetzte Effekt, Triangle und Special 2 Kurvenformen sind aber wesentlich intensiver.

Wann verwende ich Tremolo? Tremolo ist ein echter "Vintage" Sound fur Gitarre, elektrisches Piano und
Orgel. Am ehesten ist Tremolo bei Gitarren zu héren und dort so gut wie immer einsetzbar - von
gemichlichen Balladen bis zu Blues und Rock'n” Roll.

Auto-Panner

Der Auto-Panner ist eigentlich eine zweikanalige Version von Tremolo. Die Amplitude des linken Signals
wird wie bei Tremolo verandert, der Pegel des rechten Signals ist jedoch invers zum linken Kanal. Damit
entsteht die lllusion eines zwischen dem linken und rechten Lautsprecher hin- und her wandernden
Signals.

Im Normalfall ist der Speed Parameter von Auto-Panner langsamer als bei Tremolo eingestelit, da sich
das Signal weich und erkennbar im Stereo Panorama bewegen soll. Der Auto-Panner des 2120 VGS ist
besonders flexibel, da er sowohl fiir Mono- als auch Stereo Eingangssignale eingesetzt werden kann. Bei
einer Mono-Quelle bewegt sich das Signal wie zuvor beschrieben hin und her. Bei einer Stereo-Quelle
wird das Original Stereo Abbild beibehalten - der Pegel des linken Kanals wird genau spiegelbildlich zum
rechten Kanal verandert. Das Stereo Bild verandert sich gleichmaBig zwischen den Stereo Extremen.

Wann verwende ich Auto-Panner? Auto-Panning kann ein sehr kreatives Werkzeug sein. Wenn lhr Guitar
Rigin Stereo arbeitet und die Lautsprecher den richtigen Abstand zueinander haben, entsteht ein
auBerordentlicher Stereo Pan Effekt.

Auto-Panners -kénnen Delays oder Chorus lebendiger machen, einfach durch Bewegen der einzelnen
Delay- oder Chorus Voices anstatt fixierter Positionen im Mix. Fiigen Sie einfach einen Auto-Panner
Modul nach einem Delay- oder Chorus Modul ein. Ubertreiben Sie aber nicht mit dem Depth Parameter
des Auto-Panner, da meist nur eine leichte Bewegung erwlinscht ist.

Tremolo und Auto-Panner Parameter:

FX: Lvl regelt den Eingangspegel des Moduls. Der Bereich geht von Off bis 100%.

Speed steuert die LFO Frequenz {(Geschwindigkeit) des Effekts. Der Bereich geht von 0,06 bis
16,0Hz.

Depth steuert die Intensitat des Effekts. Hohe DEPTH Werte erzeugen starkere Lautstérke-
Modulationen. Der Bereich geht von 0 bis 100%.

WvFrm wahlt die LFO Wellenform. Méglich sind: SINe (Sinus), TRlangle (Dreieck), SP1 (Special 1) und

SP2 (Special 2). Siehe Bild 4-2.
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Pitch Shifters

Ein Pitch Shifter verandert die Tonhdhe eines Sounds. Ein kleiner Teil des Originalsignals wird
aufgenommen und unmittelbar darauf schneller (die Tonhohe steigt - sharp) oder langsamer (die
Tonhohe sinkt - flat) wiedergegeben. Dieser Vorgang wiederholt sich sehr schnell und ergibt damit die
Tonhdhenveranderung.

Wann verwende ich Pitch Shifting? Vor allem Gitarristen sind fiir den Einsatz von Pitch Shifting bekannt.
Zu den beliebtesten Effekten gehort die Tonhdhenverschiebung um eine ganze Oktave: entweder tiefer
fur einen grummelnden Rumpeleffekt bei verzerrten Sounds, oder hoher zur Simulation einer 12-saitigen
Gitarre.

Sowohl Gitarristen als auch Keyboarder erzeugen einige erstaunliche Texturen durch
Tonhdhenverschiebung um eine Quint héher (7 Halbténe). Damit entstehen aus einfachen Akkorden
wesentlich komplexere (z.B. ein C-Dur Akkord klingt wie Cmaj9, ein C-Moll Akkord wie Cmin11).

Pitch Shifter Parameter:

FX: Lvl regelt den Eingangspegel des Moduls. Der Bereich geht von Off bis 100%.

Dry: Lvl regelt den Pegel des "trockenen” (unbeeinfluSten) Signals. Der Bereich geht von Off bis
100%.

Balance bestimmt die Position des Dry Signals im Stereo Panorama. Der Bereich geht von -99 (ganz

links) bis 99 (ganz rechts).

Shft A-B bestimmt die Tonhéhenverschiebungs-Intervalle zwischen der Originalnote und den Voices A
und B des Pitch Shifter. Pitch Shifter konnen fir viele verschiedene Effekte eingesetzt
werden, wie etwa Doubling, Octave Division und chromatische Harmonien. Jedr Pitch Shifter
hat einen Bereich von 4 Oktaven (12 Halbtdne pro Oktave), aufgeteilt in Halbtdne von -24 bis
24.

Dtn A-B steuert die Verstimmung der tonhdhenverschobenen Voices A und B. Je weiter DTN von 0
entfernt ist, desto starker wird die Dissonanz. Kleine DTN Werte machen den Originalsound
dicker und verbessern die Abbildung. Der Bereich geht von -50% bis 50%.

Shit C-D siehe Shift A - B.

DinC-D siehe Dtn A - B.
Shft E-H siehe Shift A - B.
DtnE-H siehe Dtn A - B.
Key bestimmt die diatonische Tonart der Harmonien. Wenn der gerade gespielte Song in G-Dur

ist, stellen Sie hier G fiir die Tonleiter ein.

Scale legt die Art der Tonleiter fest. Die Mdglichkeiten sind: Major, Minor, Harmonic Minor,
Melodic Minor, Dorian, Mixolydian, Lydian, Lydian Augmented, Major Pentatonic, Minor
Pentatonic, Blues, Whole Tone, Half-Whole und Whole-Half.

Interva! bestimmt das Grundintervall der Harmonie: Sie haben die Wahl zwischen mehreren
Harmonie-Intervallen, die in der Harmony Interval Tabelle im Abschnitt 7 - Anhang aufgefihrt
sind.

OCut A-B bestimmt den allgemeinen Ausgangspegel von Pitch Shift Voice A oder B. Der Bereich geht
von Off bis 100%.

Pan A-B steuert die Links/Rechts Balance von Pitch Shift Voice A oder B im Stereo Panorama. Der
Bereich geht von -99 (ganz links) bis 99 (ganz rechts).

OutC-D bestimmt den allgemeinen Ausgangspegel von Pitch Shift Voice C oder D. Der Bereich geht
von Off bis 100%.

PanC-D steuert die Links/Rechts Balance von Pitch Shift Voice C oder D im Stereo Panorama. Der
Bereich geht von -99 (ganz links) bis 99 (ganz rechts).

OutE-H bestimmt den allgemeinen Ausgangspegel von Pitch Shift Voice E bis H. Der Bereich geht
von Off bis 100%.

Pan E - H steuert die Links/Rechts Balance von Pitch Shift Voice E bis H im Stereo Panorama. Der

Bereich geht von -99 (ganz links) bis 99 {(ganz rechts).
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OutlL-R bestimmt den linken oder rechten Ausgangspegel des Pitch Shifter. Der Bereich geht von Off
bis 100%.

Out LA - LB bestimmt den linken Ausgangspegel von Pitch Shift Voice A oder B. Der Bereich geht von Off
bis 100%.

Out RA-RB bestimmt den rechten Ausgangspegel von Pitch Shift Voice A oder B. Der Bereich geht von
Off bis 100%.

Spread steuert die Stereo Basisbreite des Effekts. Je hoher der Wert, desto breiter die Stereo
Abbildung. Bei niedrigeren Werten falit der Effekt zunehmend nach Mono zusammen. Der
Bereich geht von 1 bis 10.

Detuners

Der Detuner Effekt macht genau das, was sein Name vermuten l3Bt: er verstimmt einen Sound und
mischt ihn zum Originalsound dazu. Das Resultat ist dem Chorus Effekt 3hnlich, jedoch bleibt er statisch
und bewegt sich im Gegensatz zu Chorus nicht. Damit wirkt der Detuner viel transparenter und ist nicht
so.dick wie.Chorus, was bei vielen Anwendungen passender ist (wenn viele Effekte an einem Sound
hgrumkochen, entsteht schnell ein Soundbrei, der lhren tollen Gitarrensound zunichte macht).

Wann verwende ich Detuner? SinngemaB gilt dasselbe wie fiir den Chorus Effekt - funktioniert fiir so gut
wie alles und ist ideal fiir das "Aufblasen” einer Gitarrenspur.

Vergessen Sie nicht, mit den Delay Parametern zu experimentieren, wenn Sie auf der Suche nach einem
breiteren Detuning Sound sind. 30 bis 60ms Delay in den Detuner Voices, welche hart nach einer Seite
gepannt sind (die andere Seite hat kein Delay), andert dramatisch das Detuner Stereo Panorama .

Detuner Parameter:

FX: Lvl regelt den Eingangspegel des Moduls. Der Bereich geht von Off bis 100%.

Dry: Lvl regelt den Pegel des “trockenen” (unbeeinfluBten) Signals. Der Bereich geht von Off bis
100%.

Balance bestimmt die Position des Dry Signals im Stereo Panorama. Der Bereich geht von -99 (ganz
links) bis 99 (ganz rechts).

Dtn A-B steuert die Verstimmung der Detuner Voices A und B. Je weiter DTN A - B von 0 entfernt ist,
desto stirker wird die Dissonanz. Der Bereich geht von -50% bis 50%.

DtnC-D steuert die Verstimmung der Detuner Voices C und D. Je weiter DTN C - D von 0 entfernt ist,
desto stirker wird die Dissonanz. Der Bereich geht von -50% bis 50%.

DtnE-H steuert die Verstimmung der Detuner Voices E bis H. Je weiter DTN E - H von 0 entfernt ist,
desto stirker wird die Dissonanz. Der Bereich geht von -50% bis 50%.

DiyA-B bestimmt die Zeitspanne, nach der die Detuner Voices A und B hérbar werden. Hohere

- Werte erzeugen einen kurzen Slapback Delay Effekt. Der Bereich geht von 0 bis 60ms.

DlyC-D bestimmt die Zeitspanne, nach der die Detuner Voices C und D hérbar werden. Hohere

= ) Werte erzeugen einen kurzen Slapback Delay Effekt. Der Bereich geht von 0 bis 60ms.

DlyE-H bestimmt die Zeitspanne, nach der die Detuner Voices E bis H horbar werden. Hohere Werte
erzeugen einen kurzen Slapback Delay Effekt. Der Bereich geht von 0 bis 60ms.

OutA-B bestimmt den allgemeinen Ausgangspegel von Detuner Voice A oder B. Der Bereich geht
von Off bis 100%.

Pan A-B steuert die Links/Rechts Balance von Detuner Voice A oder B im Stereo Panorama. Der
Bereich geht von -99 (ganz links) bis 99 {ganz rechts).

OutC-D bestimmt den allgemeinen Ausgangspegel von Detuner Voice C oder D. Der Bereich geht
von Off bis 100%.

Pan C-D steuert die Links/Rechts Balance von Detuner Voice C oder D im Stereo Panorama. Der
Bereich geht von -99 (ganz links) bis 99 (ganz rechts).

OuttA-1B bestimmt den linken Ausgangspegel von Detuner Voice A oder B. Der Bereich geht von Off
bis 100%.

Out RA - RB bestimmt den rechten Ausgangspegel von Detuner Voice A oder B. Der Bereich geht von Oft
bis 100%.
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Spread steuert die Stereo Basisbreite des Effekts. Je hoher der Wert, desto breiter die Stereo
Abbildung. Bei niedrigeren Werten falit der Effekt zunehmend nach Mono zusammen. Der
Bereich geht von 1 bis 10.

Delays

Ein Delay erzeugt diskrete, sich wiederholende Echos des Originalsignals in einem bestimmten Intervall.
Bei digitalen Delays wird das Eingangssignal “"gesampled”, oder anders ausgedriickt: in einen
elektronischen Speicher geladen, fir den eingestellten Zeitraum (Dly Time) festgehalten und
anschlieBend am Ausgang abgespielt. Die 2120 VGS Delays haben einen Feedback Parameter, mit dem
ein Teil des verzégerten Signals an den Eingang zuriickgefihrt wird und dort zusammen mit dem
Originalsignal erneut die Verzégerung durchlauft. Der Feedback Wert bestimmt, wie lange sich die
Delays wiederholen, bis sie verklingen.

Wann verwende ich Delay? Wenn Sie der einsame Gitarrist in einer Band sind, kann Delay zum besten
Freund werden. Die Echos erzeugen eine lllusion, als ob mehrere Gitarristen gleichzeitig spielen. Ein
beliebter Trick bei Delays besteht darin, daB die Delays im Rhythmus der Musik zu horen sind. Das
bedeutet: Taschenrechner zur Hand nehmen, 60 dividiert durch Tempo (in BPM - beats per minute),
dividiert durch die gewiinschten Subbeats... H5rt sich kompliziert an? Haben wir uns auch gedacht. Der
2120 VGS Gbernimmt die ganze Rechnerei fiir Sie!

Um die Delay Zeit in einem Programm einzustellen, driicken Sie einfach mehrmals die <Taplt> Taste im
gewiinschten Abstand.

Eine weitere Anwendung flr Delay ist die Stereo Abbildung. Kleine Delays (10-25ms) erzeugen den
Eindruck, als ob der Sound auf eine Seite gepannt ist. Dieser Trick Uberlistet die Héreigenschaften des
Gehirns. Wenn lhr linkes Ohr einen Klang frither als das rechte Ohr wahrnimmt, denkt der Kopf, daf sich
die Schallquelle irgendwo links befinden muB3. Delays mit 30-60ms Lange spreizen den Sound an die
Grenzen des Stereo Panoramas. Vorsicht mit dieser Technik, wenn thr Mix auch in Mono gut klingen soll!

Delay Parameter:
HINWEIS - Nicht alle Parameter sind in allen Delay Modulen vorhanden.

FX: Ll regelt den Eingangspegel des Moduls. Der Bereich geht von Off bis 100%.

Dry: Lvl regelt den Pegel des "trockenen® (unbeeinfluBten) Signals. Der Bereich geht von Off bis
100%.

Balance bestimmt die Position des Dry Signals im Stereo Panorama. Der Bereich geht von -99

(ganz links) bis 99 (ganz rechts).

Delay Time bestimmt die maximale Delay Zeit fur alle Delay Voices gemeinsam. Wenn z.B.
DELAYTIME auf 1000ms eingestellt wird, kann jede Delay Voice zwischen 0 und 100%
dieser Delay Zeit haben. Der Bereich geht von 0 bis 1,4 Sekunden (die maximale Delay
Zeit hangt vom Modultyp ab: 4th, 3/4, HLF oder FUL). Delay Zeiten mit halber Bandbreite
verdoppeln automatisch die eingestelite Delay Zeit.

FdBck regelt die Zeitspanne, nach der die Delay Wiederholungen verklungen sind. Hohere Werte
bewirken einen langeren Ausklang, bei 0 ist nur eine Wiederholung pro Voice zu héren.
Das Delay erméglicht positive und negative Feedback Einstellungen. Der Bereich geht
von -99% bis +99%.

Taplt andert DELAYTIME in Echtzeit. Dazu driicken Sie die <Taplt> Taste im gewlinschten
Tempo. Die Delay Voice Prozent-Einstellungen werden davon nicht beeinfluf3t.

Smear bestimmt die Diffusion Verteilung der Delay Wiederholungen. Der Bereich geht von 0 bis
100%.

LPF schaltet einen Low Pass Filter im Delay Modul ein. Méglich ist: Pre Delay oder Post Delay.

Frequency wahlt die Grenzfrequenz des LPF. Der Bereich geht von 25Hz bis 20kHz.

Gain regelt die Verstarkung am Ausgang des LPF. Der Bereich geht von -12 bis 12.

Dly A-D bestimmt den DELAYTIME Prozentsatz fir die Delay Voices A - D. Ist z.B. DELAYTIME

(siehe oben) auf 1000ms und DLYA auf 75% eingestellt, so betragt die Verzogerung von
Voice A dementsprechend 750ms. Denken Sie daran: jede Modul Voice kann jede
beliebige Delay Zeit bis zu 100% des mit DELAYTIME eingestellten Maximums haben. Der
Bereich geht von 0% bis 100%.
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Qut bestimmt den allgemeinen Ausgangspegel des Delay. Der Bereich geht von Off bis 100%.

Pan steuert die allgemeine Links/Rechts Balance des Delay. Der Bereich geht von -99 (ganz
links) bis 99 (ganz rechts).
OutlL-R bestimmt den linken oder rechten Ausgangspegel des Delay. Der Bereich geht von Off bis
100%.
OutA-B bestimmt den Ausgangspegel von Delay Voice A oder B. Der Bereich geht von Off bis
100%.
PanA-B steuert die Links/Rechts Balance von Delay Voice A oder B. Der Bereich geht von -99
{(ganz links) bis 99 (ganz rechts).
OutC-D bestimmt den Ausgangspegel von Delay Voice C oder D. Der Bereich geht von Off bis
100%.
PanC-D steuert die Links/Rechts Balance von Delay Voice C oder D. Der Bereich geht von -99
(ganz links) bis 99 (ganz rechts).
Out LA - LB bestimmt den linken Ausgangspegel von Delay Voice A oder B. Der Bereich geht von Off
] bis 100%.
Out RA - RB bestimmt den rechten Ausgangspegel von Delay Voice A oder B. Der Bereich geht von
Off bis 100%.
ofit LC - LD* bestimmt den linken Ausgangspegel von Delay Voice C oder D. Der Bereich geht von Off
bis 100%.
OutRC-RD bestimmt den rechten Ausgangspegel von Delay Voice C oder D. Der Bereich geht von

Off bis 100%.

Equalizers

Im 2120 VGS gibt es jede Menge an Equalizer Modulen fiir jede nur denkbare Anwendung. Big Guitar
Tone? Null problemo, die EQs sorgen dafir. Es gibt sowohi Mono- als auch Stereo Module. Denken Sie
daran, daB Stereo Eingangssignale am Eingang eines Mono Equalizer summiert werden (und sich damit
das Stereo Panorama verabschiedet). Soll das Stereo Abbild erhalten bleiben, muB ein Stereo Equalizer
Modul verwendet werden.

Mit parametrischen Equalizern kénnen Sie ganz bestimmte Bereiche des Sound Spektrums mit groBter
Prazision bearbeiten. Die grafischen Equalizer verwenden Frequenzen nach 150 Standard mit 1/3-, 2/3-
oder 1-2/3 Oktave Abstand. Filter (Equalizer, oder kurz EQ) sind méglicherweise das nutzlichste
Werkzeug im 2120 VGS. Mit EQ indern Sie den Pegel bestimmter Frequenzen in threm Sound, und es
gibt sogar zwei Geschmacksrichtungen: Grafisch und Parametrisch. Grafische EQs sind Uibersichtlicher
und leichter einzusetzen, wahrend parametrische EQs wesentlich flexibler und genauer sind.

Wann verwende ich EQ? Ist eigentlich ganz einfach: immer dann, wenn thre Ohren danach verlangen!
Vergessen Sie jedoch dabei nicht, daB zuviel EQ eher Schaden als Nutzen anrichtet. EQ kann aus einer
diinnen, kraftlosen Gitarre durch Hinzufigen von Bissen einen monumentalen Sound herausholen. Das
funktioniert auch am anderen Ende: wenn der Song nach enger und brillanter Rhytmusgitarre verlangt,
nehmen Sie mit EQ die Basse heraus und drehen die Mitten und/oder Hohen auf.

Graphic Equalizers

Grafische EQs (GEQ) beeinflussen die Pegel von fixen oder voreingesteliten Frequenzen
(Frequenzbandern), die gleichmaBig tber das gesamte Frequenzspektrum aufgeteilt sind. Der 2120 VGS
bietet 8-Band und 15-Band Stereo- und Mono GEQs und einen 31-Band Mono GEQ. Alle wirken auf das
gesamte Frequenzspektrum, der Frequenzabstand bei einem 31-Band GEQ ist jedoch viel kleiner als bei
ecinem 8-Band GEQ; mit 31 Bandern kénnen Sie den Sound viel genauer kontrollieren.

Graphic Equalizer Parameter:

Level regelt den Eingangspegel des Moduls, Der Bereich geht von Off bis 100%.

Phase invertiert die Phase des Eingangssignals. Kann entweder auf IN (Signal ist in Phase) oder ouT
(Signal ist phasenverkehrt) geschaltet werden.

Phase L-R invertiert die Phase im linken oder rechten Kanal eines Stereo Eingangssignals. Kann entweder
auf IN (Signal ist in Phase) oder OUT (Signal ist phasenverkehrt) geschaltet werden.
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Freq steuert die Anhebung/Absenkung bei der entsprechenden Frequenz. Der GEQ8 verwendet 1-
1/3 Oktave I1SO Frequenzen, GEQ15 und GEQ31 haben 2/3 Oktave- und 1/3 Oktave
Mittenfrequenzen. Der Boost/Cut Bereich geht von -12 bis 12.

Parametric Equalizers

Parametrische EQs (PEQ) haben .den Vorteil, daB3 die zu bearbeitende Mittenfrequenz und die
Filterbreite beliebig eingestellt werden kann. Einige PEQ Module im 2120 VGS haben zusatzliche High
Shelf- und Low Shelf Filter. Bei einem High Shelf Filter werden alle Frequenzen oberhalb der
eingesteliten Ubergangsfrequenz (Freq) mit dem Boost/Cut Parameter angehoben oder abgesenkt. Bei
einem Low Shelf Filter werden alle Frequenzen unterhalb der eingestellten Ubergangsfrequenz (Freq) mit
dem Boost/Cut Parameter angehoben oder abgesenkt.

Parametric Equalizer Parameter:
Level regelt den Eingangspegel des Moduls. Der Bereich geht von Off bis 100%.

Phase invertiert die Phase des Eingangssignals. Kann entweder auf IN (Signal ist in Phase) oder OUT
(Signal ist phasenverkehrt) geschaltet werden.

Phase L - R invertiert die Phase im linken oder rechten Kanal eines Stereo Eingangssignals. Kann
entweder auf IN (Signal ist in Phase) oder OUT (Signal ist phasenverkehrt) geschaltet werden.

LoShlv Freq bestimmt die Ubergangsfrequenz des Low Shelf Filters. Der Bereich geht von 25Hz bis
20kHz.

LoShlv Level steuert die Anhebung/Absenkung bei der mit LOSHLV FREQ gewahlten Frequenz. Der
Boost/Cut Bereich geht von -12 bis 12.

Band # Freq bestimmt die Mittenfrequenz des gewéhlten Frequenzbandes (# = 1-4). 6-Band PEQs haben
vier echte parametrische Filter und je ein High- und Low Shelf Filter, alle mit variabler
Frequenz. Band 1 und 2 reichen von 25Hz bis 20kHz, Band 3 und 4 reichen von 1kHz bis
20kHz. -

Band # Width bestimmt die Filterbreite (Filtergiite, Q-Faktor) an der mit BAND # FREQ eingestellten
Frequenz. Je hoher der WIDTH Wert, desto selektiver wirkt Boost/Cut. In anderen Worten:
bei hohen (engen) WIDTH Werten werden mit BAND # LEVEL nur wenige Frequenzen neben
der eingestellten Mittenfrequenz mitbeeinfiuBt, bei niedrigen (breiten) WIDTH Werten
unterliegen nebenliegende Frequenzen zunehmend dem EinfluB3 von BAND # LEVEL.

Band # Level steuert die Anhebung/Absenkung bei der mit BAND # FREQ gewahlten Frequenz. Der
Boost/Cut Bereich geht von -12 bis 12.

HiShlv Freq bestimmt die Ubergangsfrequenz des High Shelf Filters. Der Bereich geht von 1kHz bis
20kHz.
HiShlv Level steuert die Anhebung/Absenkung bei der mit HISHLV FREQ gewahlten Frequenz. Der

Boost/Cut Bereich geht von -12 bis 12.
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Multi-Effekt Module

In einem 2120 VGS Multieffekt Modul kénnen entweder Delay und Chorus, oder Delay und Flange
innerhalb eines Effect Moduls kombiniert werden. Ideal fir Situationen, bei denen noch ein Effekt zur
Konfiguration hinzugefigt werden soll, die Signal Processing Ressourcen jedoch schon knapp werden. In
diesem Modul gibt es einen besonderen Route Parameter, der verschiedene Routing Mdglichkeiten
swischen den beiden Effekten erlaubt.

Multi-Effect Module Parameter:

FX: vl regelt den Eingangspegel des Moduls. Der Bereich geht von Off bis 100%.

Dry: Lvl regelt den Pegel des "trockenen” (unbeeinfluBten) Signals. Der Bereich geht von Off bis
100%.

Balance bestimmt die Position des Dry Signals im Stereo Panorama. Der Bereich geht von -99 (ganz

links) bis 99 (ganz rechts).

Route wahlt den Signalpfad innerhalb der Chorus/Delay- oder Flange/Delay Module. Die 3
Méglichkeiten sind: 1) Chorus/Flange in das Delay, mit Feedback zum Delay; 2)
Chorus/Flange in das Delay, mit Feedback zu Chorus/Flange; 3) Delay in den
Chorus/Flange, mit Feedback zu Chorus/Flange.

Speed steuert die LFO Frequenz (Geschwindigkeit) des Chorus oder Flanger. Der Bereich geht von
) 0,06 bis 16,0Hz.

Depth steuert die Intensitat des Chorus- oder Flanger Effekts. Der Bereich geht von O bis 30ms.

Feedback (Flanger) bestimmt, wieviel Flange Signal an den Moduleingang riickgekoppelt wird. Der

FDBCK Parameter ist fir den charakteristischen Flange Sound verantwortlich. Flangers
kénnen sowoh! positive als auch negative Feedback Schleifen haben - experimentieren Sie
solange, bis Sie lhren Lieblingssound gefunden haben. Der Bereich geht von -99% bis 99%.

WvFrm wihlt die LFO Wellenform. Méglich sind: SINe (Sinus), TRlangle (Dreieck), SP1 (Special 1)
und SP2 (Special 2). Siehe Bild 4-2.

C/F: Delay bestimmt die Delay Zeit der Chorus- oder Flanger Voice. Der Bereich geht von 0 bis 40ms.

Delay Time regelt die Delay Zeit des Delay Abgriffes. Der Bereich geht von 0 bis 300m:s.

Feedback bestimmt die Lange der Delay Wiederholungen. Hohere Werte ergeben einen langeren
Ausklang, beim Wert 0 ist nur eine Delay Wiederholung zu héren. Der Bereich geht von 0
bis 99%.

Taplt sndert DELAYTIME in Echtzeit. Dazu driicken Sie die <Taplt> Taste im gewiinschten
Tempo. Die Delay Voice Prozent-Einstellungen werden davon nicht beeinfluB3t.

Level: C/F/D regelt den allgemeinen Ausgangspegel aller Effect Blécke. Der Bereich geht von Off bis
100%.

Pan: C/F/D stevert die Links/Rechts Balance aller Effect Blocke. Der Bereich geht von -99 (ganz links)

bis 99 (ganz rechts).

Whammy Effekte

Der Whammy Effekt ahmt die Tonh&henverschiebung nach, die beim Ziehen oder Driicken des Vibrato-
Hebels (Whammy Bar) an manchen Gitarren entsteht. Heutzutage scheint es, als ob bei jedem Album in
den Charts - egal ob Country, Rock, Industrial oder Alternative - die DigiTech Whammy Technologie in
irgendeiner Form auftaucht. Ob subtiler Chorus Detune Effekt oder ausgeflippter Whammy Bergab-
Effekt iiber ganze 2 Oktaven: Whammy ist einer der innovativsten Effekte, der jemals erfunden wurde.

Whammy Effect Parameter:

Whammy On/Off  schaltet den Whammy Modul ein oder aus. Bei ausgeschaltetem Modul passiert das Signal
den Modul nur dann, wenn Dry Level {siehe unten) aufgedreht ist.

FX Level regelt den allgemeinen Effekt-Mix des Whammy Effect Moduls. Der Bereich geht von Off
bis 100%.

Dry Level bestimmt den Anteil an "trockenem” Signal im Whammy Effekt. Der Bereich geht von Off
bis 100%.
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Balance
Min Shift

Max Shift

Min Detune
Max Detune
Pedal

Out

Pan

Auto Wah

bestimmt die Position des Dry Signals im Stereo Panorama. Der Bereich geht von Left 99
(ganz links) bis Right 99 (ganz rechts).

legt die Tonhdhenverschiebung des Whammy Effekts fir das FuBpedal in Minimum-Stellung
fest. Der Bereich geht von -72 (6 Oktaven tiefer) bis 24 Halbténe (2 Oktaven hoher).

legt die Tonhdhenverschiebung des Whammy Effekts fir das Fulpedal in Maximum-
Stellung fest. Der Bereich geht von -72 (6 Oktaven tiefer) bis 24 Halbténe (2 Oktaven
hoher).

legt die Tonhohenverschiebung des Detune Effekts fiir das FuBpedal in Minimum-Stellung
fest. Der Bereich geht von -50% (50 cents tiefer) bis 50% (50 cents héher).

legt die Tonhohenverschiebung des Detune Effekts fur das FuBpedal in Maximum-Stellung
fest. Der Bereich geht von -50% (50 cents tiefer) bis 50% (50 cents héher).

Dieser Parameter dient zur Zuordnung eines Expression Ful3pedals und zeigt auch den
Pedalweg an. Der Bereich geht von 0 bis 100.

bestimmt den allgemeinen Ausgangspegel des Whammy Moduls. Der Bereich geht von 0
bis 100%.

steuert die Links/Rechts Balance des Whammy Effekts im Stereo Panorama. Der Bereich
geht von Left 99 (ganz links) bis Right 99 (ganz rechts).

Auto Wah ist ein starker Effekt fir nasale Wah Pedal Sounds, wobei lhrem FuBl die ganze Arbeit
abgenommen wird. Auto Wah verwendet einen Detektor, der das Eingangssignal Gberwacht und damit
die Bewegung eines Wah Pedals simuliert.

Auto Wah Effect Parameter:

Auto Wah On/Off
FX Level

Sensitivity

schaltet den Auto Wah Modul ein oder aus. Bei ausgeschaltetem Modul passiert das
unverénderte Signal den Modul.

regelt den allgemeinen Effekt-Mix des Auto Wah Effect Moduls. Der Bereich geht von
Off bis 100%.

Dieser Parameter regelt die Empfindlichkeit des Auto Wah Detektors. Je hdher der
Wert, desto weiter der Wah Bereich. Der Bereich geht von Off bis 100%.
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Abschnitt 5 - 2120 FC FuBB-Fernbedienung

AnschluB des 2120 FC

Kabel anschlieBen: Uberzeugen Sie sich, daB3 der Netzschalter des 2120 VGS ausgeschaltet ist, bevor Sie
die Kabelverbindung zum 2120 FC herstellen oder trennen. Mit einem Standard MIDI Kabel {5-pol. DIN
Stecker) schlieBen Sie den 2120 FC an die Buchse mit der Bezeichnung FOOT CONTROLLER an der
Riickseite des 2120 VGS an. AN DIE FOOT CONTROLLER BUCHSE AN DER RUCKSEITE DES 2120 VGS
DARF NUR DER 2120 FC ANGESCHLOSSEN WERDEN! JEDES ANDERE HIER ANGESCHLOSSENE
GERAT KANN IHREN 2120 VGS SCHWER BESCHADIGEN! WENN MIDI STEUERUNG GEWUNSCHT 15T,
SCHLIESSEN SIE IHRE MIDI GERATE AN DER MIDI IN BUCHSE AN.

Netz einschalten: Bei Einschalten des 2120 VGS wird auch der 2120 FC Foot Controller automatisch
eingeschaltet.

Programm wahlen: Waihlen Sie mit den <1> bis <5> FuBschaltern ein beliebiges Programm aus der
ausgewahlten Bank.

Ef:fékte ein/ausschalten: Mit den <6> bis <0> FuBschaltern kénnen die Effekte eines Programms ein- und
ausgeschaltet werden.

Bank auswihlen: Mit den <Bank Up> oder <Bank Down> FuBschaltern des 2120 FC kénnen Sie ganz
einfach durch die 19 Banks des 2120 VGS scrollen. Bei Erreichen der gewiinschten Bank driicken Sie
einen der blinkenden FuBschalter nieder - der 2120 VGS schaltet in die gewahlte Bank.

Einsatz des 2120 FC

Front-Bedienelemente und Funktionen

— =

( TiDigkach n I oo’

Eal mal anl ] Eal .
Aoy |

Auf der Frontplatte des 2120 FC befinden sich ein 20-stelliges Vakuum-Fluoreszenz-Display, 10
programmierbare FuBschalter, zwei separate Bank Up/Tune und Bank Down/Bypass FuBschalter und das
eingebaute Controller FuBpedal.

<1> bis <0> Schalter: Die zehn programmierbaren FuBschalter sind von 1-0 numeriert und kdnnen fur
verschiedene Funktionen programmiert werden.

<Bank Up/(Hold) Tuner> Schalter: Mit diesemn Schalter bewegen Sie sich im Bank Menu aufwarts und
wihlen durch 1x Niederdriicken die Bank aus. Aufeinanderfolgende Tastendrucke schaltet zur nachsten
Bank hinauf. Bei Erreichen der gewiinschten Bank driicken Sie einen der blinkenden FuBschalter nieder -
die Bank wird aktiviert. Wird der FuBschalter gedriickt und gehalten, so schaltet der 2120 FC den 2120
VGS in den Tuner (Stimmgerat) Mode.
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<Bank Down/(Hold) Bypass> Schalter: Mit diesem Schalter bewegen Sie sich im Bank Menu abwirts und
wihlen durch 1x Niederdriicken die Bank aus. Aufeinanderfolgende Tastendrucke schaltet zur nachsten
Bank hinunter. Bei Erreichen der gewiinschten Bank driicken Sie einen der blinkenden FuBschalter nieder
- die Bank wird aktiviert. Wird der FuBschalter gedriickt und gehalten, so schaltet der 2120 FC den 2120
VGS in den Bypass Mode.

Expression FuBpedal: Mit dem eingebauten kontinuierlichen Controller Pedal (und/oder einem externen
Expression FuBBpedal) kann jeder Parameter des 2120 VGS in Echtzeit gesteuert werden. Detaillierte
Informationen Uber die Controller Zuordnungen fir FuBpedale finden Sie im Abschnitt 6
Fortgeschrittene Funktionen.

Anschlisse an der Rickseite

Slo== [ ZiJigleck

An der Riickseite des 2120 FC befinden sich der Control Ein/Ausgang (NUR FUR DEN 2120 VGS
VERWENDEN!) und ein Eingang fir ein externes Expression FuBpedal, entweder anstatt oder zusitzlich
zum eingebauten FuB3pedal.

Control Ein/Ausgang: Dieser AnschluB ist q.ls 5-polige DIN Buchse ausgefiihrt. Alle Steuerinformationen
des 2120 FC laufen Uber diesen AnschluB. Uber diese Kable wird der 2120 FC auch mit Strom vom 2120
VGS versorgt, damit entfallt ein zusatzliches Netzgerst fir den Foot Controller.

WICHTIG: Der Control Ein/Ausgang ist kein MIDI OUT AnschluB! Er darf nur mit dem dafiir
vorgesehenen FOOT CONTROLLER AnschluB an der Riickseite des 2120 VGS verbunden werden!

External Continuous Controller Eingang: An diese 1/4" Klinkenbuchse kann ein zweites kontinuierliches
Steuergerdt (etwa ein passives FuBpedal) fiir den 2120 VGS angeschlossen werden. Dieser Eingang
verarbeitet sowohl ankommende Steuerspannungen als auch veridnderliche Widerstinde (wie z.B. von
einem passiven Lautstirkepedal) und kann gleichzeitig mit dem eingebauten Expression Pedal
verwendet werden.

Bedienung des 2120 FC Foot Controller

Hier lesen Sie eine schrittweise Anleitung, wie der 2120 FC an den 2120 VGS angeschlossen und bedient
wird.

1. Uberzeugen Sie sich, daB der 2120 VGS ausgeschaltet ist (Power Off).

2. Verbinden Sie den Control Output des 2120 FC Foot Controller und den Foot Controller Input an der
Ruckseite des 2120 VGS mit einem Standard MIDI Kabel.

WARNUNG: An die Foot Controller Buchse an der Riickseite des 2120 VGS darf nur der 2120 FC Foot
Controller angeschlossen werden. Das ist keine MIDI Verbindung! Jedes andere hier angeschlossene
Gerat kann lhren 2120 VGS schwer beschiadigen.

3. Sobald der 2120 FC angeschlossen ist, schalten Sie den Netzschalter des 2120 VGS ein. Sowohl der
2120 VGS Signal Processor/Preamp als auch der 2120 FC beginnen mit ihren Einschaltsequenzen.
Nach erfolgreicher Initialisierung zeigt das Display am 2120 FC die Nummer und den Namen des
derzeit am 2120 VGS ausgewahlten Programms.
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4. Zum Programmwechsel innerhalb der aktuellen Bank driicken Sie einen der numerierten FuBschalter
auf dem Foot Controller. Das Display zeigt Namen und Nummer des neu gewahlten Programms
an.

5. Das Expression FuBpedal ist vom Werk aus so programmiert, dal} es zumindest einen Parameter in so
gut wie allen 2120 VGS Programmen steuert. Versuchen Sie in den verschiedenen Programmen
herauszufinden, was das FuBpedal bewirkt. Bei vorhandener Steuerverbindung wird der 2120 FC
vom 2120 VGS automatisch kalibriert.

Expression Pedal Bezeichnungen

Der 2120 VGS kann mit bis zu 3 Expression FuBpedalen zusammenarbeiten. Abhangig davon, ob der
2120 EC Foot Controller angeschlossen ist oder nicht, andern sich jedoch deren Bezeichnungen:

Wenn der 2120 FC nicht angeschlossen ist:
Exp 1 Expression FuBpedal Eingang an der Ruckseite des 2120 VGS.

Wenn der 2120 FC angeschlossen ist:
Exp 1 Expression FuBpedal des 2120 FC Foot Controller.

Exp2 Expression FuBpedal Eingang an der Riickseite des 2120 FC Foot Controller.
Exp 3 Expression FuBpedal Eingang an der Ruickseite des 2120 VGS.

Programmieren des 2120 FC

Die gesamte Programmierung und Einstellung des 2120 FC wird iiber die Frontplatte des 2120 VG5
durchgefihrt. Die meisten Setup Menus fiir den 2120 FC befinden sich in der Utilities Sektion des 2120
VGS.

Funktionen zuordnen

Der 2120 FC Foot Controller hilft thnen bei der Organisation von Sounds in 19 Gruppen, die als Banks
bezeichnet sind. Jede dieser Banks verwendet die 10 FuBschalter Patches, welche vom Anwender fur die
verschiedensten Funktionen programmierbar sind. Dazu gehdren:

« Auswahl von 2120 VGS Programmen

e+ Ein/Ausschalten und Verandern von Parametern in Echtzeit

«. Senden von MIDI CC Informationen an die MIDI OUT Schnittstelle (O oder 127 an der gewahlten CC
Nummer)

« Zuordnung einer MIDI CC Nummer fir das Expression FuBpedal, um damit Steuersignale an die MID!
Schnittstelle zu senden

+  Auswahl der nichsten oder vorherigen Bank (Bank Up/Bank Down)

Um die Bank zu wechsein, driicken Sie einfach den <Bank Up> oder <Bank Down> Schalter am 2120 FC.
Damit schalten Sie zur nachsten Bank hinauf oder hinunter.

Das Foot Controller Setup Menu enthilt alle fir den Betrieb des 2120 VGS mit dem 2120 FC
notwendigen Optionen. Die zugehdrigen Unter-Menus befinden sich auf Page 10 und 11 des Utilities
Menu und sind wie folgt bezeichnet:

Patch Assignment (Patch Zuordnungen)
Continuous Control (Kontinuierliche Steuerung)
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Programme zu FufBBschaltern zuordnen

Um das aktive Programm einem Patch FuBschalter in der derzeit ausgewahlten Bank zuzuordnen, gehen
Sie wie folgt vor:

1. Der Programm Name muf im Display des 2120 VGS zu sehen sein.

'-' Clean Comr Delaw
2 0 .80 0.8 0.0!106
ﬁ“ﬁfﬁggﬁgg“ Jgp—

3. Driicken Sie den gewiinschten FuBschalter am 2120 FC, der dieses Programm aufrufen soll. Ist der
FuBschalter schon mit einer anderen Funktion (mit Ausnahme eines Programmaufrufs) belegt, so

zeigt das Display:

"" Re-Hszidgn F.Switch 7
S

) BYES B nro
— g Tm N mm oo —

BANK ’

4. Mit Drehen des <3> Knopfes (YES) wird die Funktion des FuBschalters neu zugeordnet; Drehen von
<4> (no) bricht den Vorgang ohne Veranderung ab. Sobald ein Programm mit einem Patch in der
Bank verbunden ist, leuchtet die LED iiber dem gewahlten FuBschalter auf und bestatigt damit die
Zuordnung.

5. Mit der <Program> Taste wird der Vorgang beendet.

Parameter zu FuBschaltern/Expression Pedalen zuordnen

Der 2120 VGS erlaubt thnen, bis zu 16 Parameter pro Programm zu steuern. Jede gemachte Verbindung
eines Parameters mit einem FuBschalter oder Expression Pedal wird den bereits vorhandenen
Zuordnungen fir diesen Controller hinzugefiigt. Damit wird lhr 2120 VGS zum richtigen Arbeitspferd,
denn die ganze Organisation wird dadurch enorm erleichtert: alles was Sie tun missen, ist den zu
steuernden Parameter auszuwshlen und dem 2120 VGS zu sagen: "Mach’ es so*.
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Die Zuordnung eines aktuellen Parameters zu einem FuBschalter oder Expression Pedal in der aktuellen
Bank geschieht wie folgt:

1. Uberzeugen Sie sich, da3 der Parameter, den Sie mit einem Controller verbinden wollen, im Display
zu sehen und ausgewahlt ist (in der folgenden Abbildung ist das die Gain Einstellung des Tube
Distortion Moduls). Das Display sieht etwa so aus:

'-" Tupe: Bright Clean Gain
| B sS

| S
SEAULESS

race C of C

2. Drehen Sie den <4> Knopf, um den Gain Parameter auszuwahlen; anschlieBend driicken Sie die
<Assign> Taste. Das Display zeigt:

'-‘ Gain Exer 1 Min[ S56I1Max
'—-E]Dn APg! B 0 O 100

3. Driicken Sie den gewiinschten FuBschalter oder bewegen das gewiinschte FuBpedal, z.B. Exp 1.
AnschlieBend stellen Sie mit den <3> und <4> Kndpfen das Minimum bzw. das Maximum von Gain
ein. Danach sieht das Display etwa so aus:

"" Gain Exp 2 Minl 691Max
' [ 0O~ BPd! B 20 OS5

| /_m/—\... B . T o O W _amm

OB seanirss
we | 1g

4. Mit Driicken der <Program> Taste verlassen Sie den Parameter-Zurdnungsmodus und kehren zum
Program Mode zuriick. Die <Store> Taste bleibt hell erleuchtet, bis die eben gemachten
Anderungen gespeichert werden oder das Programm gewechselt wird.

Weitere FuB3schalter-Funktionen

Die FuBschalter des 2120 FC kdnnen verschiedenen Funktionen zugeordnet werden. Das geschieht mit
den Foot Controller Menus in der Utilities Sektion des 2120 VGS. Die folgenden Menus sind verflgbar:

+ CC Transmit Toggle zuordnen

. MIDI Control zu Expression Pedalen zuordnen
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CC Transmit Toggle

Die Einstellungen fir die CC Transmit Toggle Funktion werden wie folgt gemacht:

1. Driicken Sie die <Utilities> Taste. Das Display sieht etwa so aus:

"" Outrput.: Steren Tuner
,— c OoFrF
e, TR SR OO

race 1oe 13

2. Drehen Sie den <Page> Knopf, bis das Display zeigt:

'-l 21FCiBank FS=Pra CCTran

r B 31 ---
XN NN W N B
PAO(’UD!’IB

3. Mit dem <2> Knopf wird die Bank ausgewshlt, in der CC Toggle verwendet werden soll. Nach
Auswahl wird mit dem <3> Knopf der gewiinschte FuBschalter ausgewhlt. Das Display zeigt:

"', Z21FCtBank FS=To2 CCTran

'— B | BE6 HoFF
[ — B AR DD
raar [Joe 13

HINWEIS: Fir die CC Transmit Toggle Funktion k&nnen nur FuBschalter ausgewshlt werden, die
aktuell einem Control Parameter im 2120 VGS zugeordnet sind.

4. Das Display zeigt nun an, da3 FuBschalter 6 in Bank 1 fiir die CC Toggle Funktion verwendet werden
kann. Ab Werk sind dafiir die FuBschalter <6> bis <0> programmiert.

5. Mit dem <4> Knopf wird nun die CC Nummer eingestellt. Das Display zeigt etwa folgendes:

'-‘ Z1FC:Bank FS=To3 CCTran

L_ l B b B2l
[0 =R N N N N O
race {0 or 13

6. Mit Dricken der <Utilities> Taste verlassen Sie das Foot Controller Setup Menu.
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MIDI1 Control zu Expression Pedalen zuordnen

Mit der folgenden Serie von Menus und Untermenus werden die MIDI Einstellungen fir das Expression
FuBpedal (die Pedale) des 2120 FC gemacht. Damit die FuBpedale ordnungsgemaf mit MIDI
funktionieren, sind zwei Vorgange notwendig:

1. Zuordnung der CC Nummer
2. Zuordnung des CC Transmit Channel

Zuordnung einer CC Nummer zu einem Expression FuBpedal - Mit dieser Option kdnnen Sie die
gewiinschte MIDI CC Nummer auswihlen, tiber die Continuous Control Messages von einer der drei
Expression Pedale gesendet werden. Ab Werk sind keine Zuordnungen von Expression Pedalen zu MIDI
CC Nummern vorprogrammiert. Um eine CC Nummer einem Expression Pedal (den Pedalen)
zuzuordnen, gehen Sie wie folgt vor:

1 Driicken Sie die <Utilities> Taste. Das Display sieht etwa so aus:

"'" Outrput:Stereo Tuner
'— B ° DOFF
— g OR 0N A DO B

oz | oe 13

2. Drehen Sie den <Page> Knopf, bis Page 11 des Utilities Menu erreicht ist. Das Display zeigt:

"'i coSnd: Exel Exr2  ExP3
BOFF BOFF DBDOFF
L
pace | loe 13

Drehen des <2>, <3> oder <4> Knopfes ordnet dem gewiinschten Expression Pedal eine MIDI CC
Nummer zu. Wenn zum Beispiel Exp 1 ausgewahlt ist (Exp1: am 2120 VGS angeschlossenes Expression
Pedal, ohne angeschlossenem 2120 FC; oder Exp1: internes Expression Pedal des 2120 FC, wenn dieser
angeschlossen ist), zeigt das Display:

"" CCz=no: ExFrl ExF2Z EXF3
— B30 BOFF  BOFF

' eyl ee) fei@_ (0
[ S— _/—‘2-_--'5‘--1--; ------------- —S—
[ usis g

'Aﬂ!"(”a

Mit Driicken von <Utilities> verlassen Sie das Menu.
Eine Erklirung der Expression Pedal Bezeichnungen lesen Sie auf Seite 50.

Zuordnung eines CC Transmit Channel - Mit dieser Option kénnen Sie den gewiinschten MIDI Kanal
auswihlen, Uber den CCs an die MIDI OUT Schnittstelle des 2120 VGS, und damit zu anderen MID!
Geraten gesendet werden. Wird der 2120 VGS nur mit dem 2120 FC verwendet, so brauchen Sie sich um
diese Option nicht zu kimmern.
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Wenn Sie jedoch vorhaben, den 2120 FC fir Continuous Control von anderen MIDI Gerate einzusetzen
(entweder nur diese oder im Zusammenhang mit dem 2120 VGS), muf3 ein MIDI Transmit Channel
zugeordnet werden.

Um die MIDI Transmit Channels zu dndern, iber die die ausgewahiten CCs zu anderen MID!I Geriten
ubertragen werden, gehen Sie wie folgt vor:

1. Dricken Sie die <Utilities> Taste. Das Display sieht etwa so aus:

'_" Output:Sterea Tuner
'— B OOFF
— R MR 00—

2. Drehen Sie den <Page> Knopf, bis Page 3 erreicht ist. Das Display zeigt:

= MIDI: RcvChril TransChnl
( 0

I~ B 1
—_— T S S SR 00—
pace Joe 13

3. Mit dem <4> Knopf wird der MIDI CC Transmit Channel ausgewahlt. Das untenstehende Beispiel
verwendet MIDI Kanal 10.

"'" MIDI® RocuChnl  TramsChnl

[T g~ S mm e DO - —
race Joe 13

4. Mit Dricken von <Utilities> verlassen Sie die Transmit Channel Zuordnung.

Bank Up/Tuner und Bank Down/Bypass FuB3schalter

Diese zwei FuBschalter befinden sich ganz rechts auf dem 2120 FC, neben dem Expression FuBpedal.

Der Bank Up/Tuner FuBschalter - Sie haben es sicher erraten - schaltet entweder zur nachsthéheren Bank
des 2120 VGS, oder in den Tuner (Stimmgerit) Mode: dazu driicken und halten Sie die Taste nieder, bis
die Tuner Anzeige im Display erscheint.

Der Bank Down/Bypass FuBschalter schaltet entweder zur nichstniedrigeren Bank des 2120 VGS, oder
auf Bypass: dazu drlicken und halten Sie die Taste nieder, bis die LEDs den Bypass Status anzeigen.
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Banks benennen

Bei Verwendung des 2120 VGS mit dem 2120 FC stehen 19 Banks zur Verfligung, aus denen Sie
auswihlen kénnen. Jede Bank ist mit einem besonderen Namen versehen, der die in dieser Bank
enthaltenen Programme beschreibt. Sie kdnnen diese Banks nach Belieben neu benennen. Der Vorgang
ist wie folgt:

1. Im Program Mode driicken Sie die <Utilities> Taste. Das Display sieht etwa so aus:

'-" Qutrut:iStereo EQ/Mix
— B ¢ OLel
[ — _‘Q—E-E-AE-,@“E-D-D.—.4—.4—

EETD  ypauiins
race o 13

5. Drehen'Sie den <Page> Knopf, bis Page 12 erreicht ist. Das Display zeigt:

""’ Bank: Artist 1 Name?
— ! O4YES

— g D0
PAGE IEO‘ ,3

3. Mit dem <2> Knopf wird die neu zu benennende Bank ausgewihlt. AnschlieBend drehen Sie den <4>
Knopf, um die Bank mit einem neuen Namen zu versehen. Das Display sieht etwa so aus:

'—" Mame:Brtist 1
- [CAFP Hnb-r BIlnS BLOP

' E=R M) (R Wy Em My )

Aeem @K = T T T T s em -
o v

H

- Mit dem <Program/Effect> Rad andern Sie das erste Zeichen an der markierten Position.

wn,

* Sobald das gewiinschte Zeichen an dieser Stelle erscheint, drehen Sie den <Page> Knopf; damit wird
der Cursor auf das nichste zu dndernde Zeichen verschoben.

6. Mit dem <1> Knopf wird swischen GroB- und Kleinbuchstaben umgeschaltet. Der <2> Knopf wahlt
Ziffern~aus, der <3> Knopf fiigt Leerzeichen ein. Der <4> Knopf dient zum Kopieren und Einfligen
von Zeichen.

7. Soll ein Zeichen kopiert werden, positionieren Sie den Cursor mit dem <Page> Knopf unter dem zu
kopierenden Zeichen, anschlieBend drehen Sie den <4> Knopf im Uhrzeigersinn. Um das kopierte
Zeichen einzufiigen, positionieren Sie den Cursor an die gewiinschte Stelle und drehen den <4>
Knopf gegen den Uhrzeigersinn.

8 Wenn Sie den Name Vorgang beenden méchten, driicken Sie entweder die <Program> Taste, um in
den Program Mode suriickzuschalten, oder die <Edit> Taste fir den FX Edit Mode, oder die
<Utilities> Taste fiir den Utilities Mode, je nachdem, in welchen Mode Sie schalten mochten.
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Abschnitt 6 - Fortgeschrittene Funktionen

Modifiers zuordnen

Modifiers sind einzigartige Werkzeuge, mit denen Sie lhren Sound in Abhingigkeit von der
Signalamplitude (Lautstdrke), den Einstellungen eines Low Frequency Oszillators (LFO), den
informationen von MIDI Continuous Controllers, externen FuBschaltern oder Pedalen dramatisch
verandern kénnen.

Jedes 2120 VGS Programm hat einen Satz an Modifiers. Einem einzigen Parameter kdnnen bis zu 16
Modifier Links (Verbindungen) zugeordnet werden. Es gibt fiinf verschiedene Modifier Typen:

« MIDICCs

e LFOs

»  Dynamic (abhéngig vom Signalpegel)

+ Externes Expression FuBBpedal

+ Internes Expression FuBpedal und FuB3schalter des 2120 FC Foot Controller

MIDI CCs

Bei Verwendung von MIDI CCs reagiert der 2120 VGS auf die CC Nummern 0-127 und CHP (Channel
Pressure Aftertouch). Damit kénnen Sie ein MIDI Expression Pedal, die Modulation- oder Pitch Bend
Rader eines Keyboards, oder jedes andere MIDI CC Gerdt zur Steuerung von Effect Parametern
einsetzen.

LFOs

Bei Verwendung von LFOs werden Parameter-Werte automatisch zwischen einem vorher definierten
Minimum und Maximum mit bestimmter Rate (Geschwindigkeit) und Wellenform verindert. Der 2120
VGS hat zwei vom Anwender programmierbare LFOs in jedem Programm, die jedem Parameter
zugeordnet werden kdnnen.

Zum Beispiel konnen Sie einen Auto Panner erzeugen, ohne ein Auto Panner Modul zu verwenden.
Linken (verbinden) Sie einfach einen Effect Output Pan Parameter mit dem LFO Modifier - der LFO
bewegt diesen Parameter hin und her. Dieser Modifier ist eine unschlagbare Waffe im anhaltenden
Wettstreit um neue Sound Kreationen. In jedem Programm sind zwei LFOs mit ihren eigenen
Geschwindigkeiten und Wellenformen vorhanden.

Dynamic Modifiers

Bei Verwendung von Dynamic Modifiers- werden die Parameter Werte abhangig von der Dynamik des
Eingangssignals verandert. Damit ergeben sich endlose Méglichkeiten, die mit keiner anderen Methode
erzeugt werden kénnen.

Zum Beispiel kénnen Sie den Dynamic Modifier eines Programms zur Steuerung der Chorus Starke
verwenden. Auf dem Papier klingt das nicht so toll, aber stellen Sie sich einmal diesen ausdrucksvollen
Effekt mit lhrer Gitarre vort Je lauter das Signal, desto schwicher der Chorus. Bei leichterem Anschlag
verstarkt sich der Chorus Effekt dramatisch. UND DAS ALLES IN ECHTZEIT!

HINWEIS: Ist ein Modifier mit einem Parameter gelinkt (verbunden), so wird der Parameter so gesteuert,
wie wenn Sie ihn mit dem Data Wheel verandern, mit einem Unterschied: die <Store> Taste und das
CHANGED Symbol leuchten nicht auf. Daher kénnte der voreingestelite Name als *Custom” angezeigt
werden, wenn ein Parameter stindig von einem Modifier verindert wird. Bei Speicherung des
Programms werden auch die neuen Parameter Werte gespeichert.

Externe Expression Pedale

Abgesehen vom Expression Pedal des 2120 FC Foot Controller kénnen bis zu zwei weitere externe
Expression FuBpedale in das 2120 VGS System integriert werden (entweder iiber den AnschluB an der
Rickseite des 2120 VGS, oder die External Expression Pedal Klinkenbuchse am 2120 FC). Die Zuordnung
eines angeschlossenes externen Pedals als Modifier wird weiter unten beschrieben.
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Parameter mit Modifier linken

HINWEIS: Alle hier gemachten Anderungen miissen mit dem Programm gespeichert werden, damit sie
zu einem spateren Zeitpunkt wieder aufgerufen werden kénnen.

Um einem Parameter mit einem Modifier zu verbinden, gehen Sie wie folgt vor:

Scrollen Sie zu dem Parameter, der zu einem Modifier gelinkt werden soll (in unserem Beispiel: Delay
Feedback). Wie man durch die Parameter eines Moduls scrollt, lesen Sie auf Seite 26.

Driicken Sie die <Assign> Taste. Das Display sieht etwa S0 aus:

'-" gvail Lirk for: FdBack
oo OFF

Wenn der aktuelle Parameter noch nicht gelinkt ist, kommen Sie automatisch zum nachsten
.. verfugbaren Link in diesem Menu.

Mit Drehen:des <1> Knopfes wird die Link Verbindung fur diesen Parameter aktiviert. Das Display zeigt:

"'" FdBck CC# Minl Iax
'— D on BFI B-99 WOHId

Suesmm. taadStdalioEhtens S L bgunin g S
XD  ge i £6S

Mit dem <2> Knopf scrollen Sie durch die verschiedenen Modifiers, die dem gewlinschten Parameter
zugeordnet werden kénnen:
MIDI CCs (CC): 0-127 und CHP (Aftertouch)
Echtzeit Modifiers (RT): LF1, LF2 (LFO 1 und 2), dyl, dy2 (Dynamic 1 und 2)
Expression Pedale (Pdl 1): Exp 1, Exp 2, Exp 3
FuBschalter (FS#): F1 bis F10

HINWEIS: Die MUTE und THRU Effect Typen haben keine Parameter, die gelinkt werden konnen.
Daher erscheinen sie auch nicht in der Parameter Liste.

Mit dem <3> wird das Minimum des Parameter Wertes festgelegt, wenn der Controller in der Minimum-
Position ist.

Mit dem <4> wird das Maximum des Parameter Wertes festgelegt, wenn der Controller in der
Maximum-Position ist.

HINWEIS: Uberzeugen Sie sich, daB3 alle hier gemachten Anderungen gespeichert sind, bevor Sie
fortsetzen.
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LFO Modifier einstellen
Einen mit einem Effect Parameter gelinkten LFO stellen Sie wie folgt ein:
Driicken Sie die <Assign> Taste, um in den Assign Mode zu schalten.

Mit dem <Page> Knopf scrollen Sie zur LFO Seite (Page 17). Das Display sieht etwa so aus:

""' LFOD WvForm Speed
'— |1 ROFF HBS .~ DOOB™
b ¥ TR0 0 —

racel Toe 19

Mit dem <1> Knopf wahlen Sie einen der beiden LFO aus, der eingestellt werden soll.
Der <2> Knopf schaltet den gewahiten LFO ein oder aus.

Der <3> Knopf bestimmt die Kurvenform des ausgewahiten LFO: SINe ({Sinus), TRiangle (Dreieck),
SPecial1 und SPecial2.

Mit dem <4> Knopf wird die Rate (Geschwindigkeit) des LFO eingestelit.

Alle Parameter, die mit dem LFO gelinkt sind, werden nun von dessen Kurvenform moduliert.

Dynamic Modifier einstellen

Driicken Sie die <Assign> Taste, um in den Assign Mode zu schalten.

Mit dem <Page> Knopf scrollen Sie zur ersten von zwei Dynamic Modifier Seiten (Page 18 und 19). Das
Display sieht etwa so aus:

""" Ssr’; HOFF léoghr*s HiThrs
'—

TS S MO (GO & Y M e

[
SEAMESS

raae [8or 19

Mit dem <1> Knopf wahlen Sie aus, welcher der beiden Dynamic Modifiers eingestelit werden soll.
Der <2> Knopf schaltet den Dynamic Modifier ein oder aus.

Der <3> Knopf bestimmt den Threshold (Schwellwert) im Signal, bei dessen Uberschreiten die
dynamische Anderung des Parameters beginnt.

Mit dem <4> Knopf wird der Punkt eingestellt, an dem die gréBte Verinderung des Parameters
stattfindet.
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Mit dem <Page> Knopf scrollen Sie zur nachsten Dynamic Modifier Seite.

Mit dem <1> Knopf wihlen Sie aus, welcher der beiden Dynamic Modifiers eingestellt werden soll.
Der <2> Knopf bestimmt die Attack Zeit (Ansprechzeit) des Dynamic Modifier.

Der <3> Knopf bestimmt die Hold Zeit (Haltezeit) des Dynamic Modifier.

Der <2> Knopf bestimmt die Release Zeit (Abfallzeit) des Dynamic Modifier.

Morphing/Volume Pedal Zuordnungen

Die 2120 VGS Valve Preamp Module und Effect Konfigurationen bieten besondere Morphing- und
Volume Control Méglichkeiten, mit denen eine allmahliche Soundveranderung von einem Preamp Typ
zum anderen maglich ist. Damit kénnen Sie einen Morphing Effekt von einem verzerrten Tube Distortion
Typ zu einem cleanen Solid State Preamp Ton steuern, oder eine Volume FuBpedal-Steuerung vor oder
nach den Digital Effects einfligen. Morphing und Volume Control wird durch Linken eines Expression
FuBpedals zu den Morph- oder Volume Pedal Parametern erreicht.

Morphing/Volume Zuordnungen

Die Zuordnung des Morphing/Volume Pedals zur Steuerung des Morph Effekts zwischen den Distortion
Typen oder der Lautstarke geschieht wie folgt:

1. Im Program Mode dricken Sie die <Edit> Taste und drehen anschlieBend das <Program/Effect>
Rad, bis das Display etwa so aussieht:

"'" %onfe‘igﬁi SDISC 4-4:4:-4
St |
!-_E_;D &'E_ammrmm_rﬁrﬂrj_r:\“—

PAGE. loe C

2. Nun drehen Sie den <Page> Knopf, das Display zeigt:

"" Yolume Pdl: Pre Digital
-' D00 B !

— ‘-//_—’_—'I‘Etjé]ﬂ_,"_f‘—a” :::
pace C of C

3 Jetzt kdnnen Sie das Volume Pedal und dessen Position in der Effect Matrix (Pre- oder Post Digital)
oder das Morphing Pedal auswahlen. Dazu drehen Sie den <3> Knopf, bis das Display etwa so

aussieht:
"" Uolume Fdl: Morephing
r— D ts0 B 3
— _/—EF_:‘-[%::%tl-ﬁ‘-@--@-—‘-———
race C of C
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4. Nun aktivieren Sie mit dem <1> Knopf die Morphing Zuordnung fiir den Preamp, oder fir das
Volume Pedal. Danach driicken Sie die <Assign> Taste; wenn dieser Parameter noch nicht

zugeordnet war, sieht das Display so aus:

5. Wahlen Sie jetzt das Expression FuBpedal an. Ist der Morphing Parameter gewihlt, so zeigt das

'—i Morrh Exp 1 Min [(L501Max
'— H0n APdL  BdSOC B ESO

5o mar)  faae) Mee ) _Gam) () M ), ) s
| %

&= STEEsr T
rce 3 o {9

Display:

6. Mit dem <1> Knopf aktivieren oder deaktivieren Sie das gewahlte Expression FuBpedal. Mit dem
<2> Knopf kann ein anderes Expression FuBpedal ausgewihlt werden. Die <3> und <4> Knopfe
bestimmen den minimalen und maximalen Morph Wert zwischen Tube (t) und Solid State (d - digital).
Nachdem Sie die gewiinschten Einstellungen gemacht haben, vergessen Sie nicht, die Anderungen
durch Driicken der <Store> Taste zu speichern.

6b. Ist der Volume Control Parameter gewahlt, so zeigt das Display:

'-, Morrh Exp 1 Mim [16881IMax
'-— Bi~ BPdL BOFF O 100

o Fo A (WS ML MO )

— g = = e
PAGE l{ OF Jg

6c  Mit dem <1> Knopf aktivieren oder deaktivieren Sie das gewihlte Expression FuBpedal. Mit dem
<2> Knopf kann ein anderes Expression FuBpedal ausgewahlt werden. Die <3> und <4> Knépfe
bestimmen den minimalen und maximalen Volume (Lautstirke) Wert. Nachdem Sie die
gewtunschten Einstellungen gemacht haben, vergessen Sie nicht, die Anderungen durch Driicken
der <Store> Taste zu speichern.
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MIDI Funktionen

Heutzutage hat ein Gitarrist viele verschiedene Aufgaben zu erfillen, und die Last dieser Verantwortung
driickt schwer. Um diesen Job zu erleichtern, muB das Equipment schnell sein und mit anderen Geraten
zuverlassig kommunizieren kénnen. Aus diesem Grund haben wir bei Digitech dem 2120 VGS alle MIDI
Features eingebaut, die Sie sich nur winschen konnen.

MIDI Channels

Diese Option bestimmt den MIDI Kanal, auf dem der 2120 VGS auf MID! Program Changes und CC

Messages reagiert, und auf dem er MID! Program Changes und CC Daten sendet. Mdgliche MiDI
Channel Einsteliungen sind: Off, 1 bis 16, und All.

Die MIDI Channel Zuordnung wird wie folgt geandert:

1. Dricken Sie die <Utilities> Taste und drehen anschlieBend den <Page> Knopf bis zu Page 3 des
Utilities Menu. Das Display zeigt:

'-' MIDI: RcuChnl TransChnl
— B ! D

Smamm. “ hasSbied Sl Dlaibbluninl et i ie i
e u_uu._x/u—
race 3 or 13

2. Mit dem <2> Knopf wihlen Sie den MIDI Kanal, auf dem der 2120 VGS Daten empfangt (receive).
3. Mit dem <4> Knopf wahlen Sie den MIDI Kanal, auf dem der 2120 VGS Daten sendet (transmit).

MIDI Merging

Bei MIDI Merging werden empfangene MID! Daten mit den vom 2120 VGS erzeugten MIDI Daten
kombiniert, bevor sie an die MIDI OUT/THRU Buchse gelangen. Die MIDI Merge Option befindet sich im
Utilities Menu auf Page 6. Wenn Sie dort angelangt sind, zeigt das Display:

"" SusEx Channel MIDIMerge

'— B { OorfF
T R (T G, (B & (L -
R aramess

race b o 13

Program Receive Map

Mit der Program Receive Map (Program Empfangs—ZuordnungstabelIe) kénnen Sie alle 200 Programme
Ihres 2120 VGS Gber MID! und dessen standardisierte 128 Program Change Kommandos aufrufen. Bei
Lieferung ist der 2120 VGS so eingestellt, daB mit den MID! Program Change Nummern 1-100 die User
Programme=1-100 aufgerufen werden. Die MID! Program Change Nummern 101-128 greifen auf die
Factory Program Bank zu.

Um MID! Zugriff auf andere, nicht erwahnte Programme und Bypass zu haben, mussen Sie
das Program Mapping Feature verwenden.

Die Neuzuordnung einer Program Nummer zu einer MIDI Program Change Nummer
geschieht wie folgt:
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1. Dricken Sie die <Utilities> Taste und drehen anschlieBend den <Page> Knopf bis zu Page 4 des
Utilities Menu. Das Display zeigt:

""’ SuzEx Chamnel MIDIMerge
—— B ! BoFF

S e e
L ustl Rvyeret

".B(B(,Ia

2. Mit dem <3> Knopf wahlen Sie die MIDI Program Change Nummer, die neu zugeordnet werden soll.
Beachten Sie, daB3 sich dabei auch die Nummer unter USER andert.

3. Mit dem <4> Knopf wahlen Sie das 2120 VGS Programm, das die zuvor eingestellte MIDI Program
Change Nummer aufrufen soll. Ist diese Nummer groBer als 100, so @ndert sich die Anzeige von
USER auf FACT und zeigt damit an, daB3 die eingestelite MIDI Program Change Nummer ein
Programm aus der Factory Bank aufruft.

Program Transmit Map

Mit der Program Transmit Map (Program Sende-Zuordnungstabelle) kénnen Sie lhren 2120 VGS zur
Steuerung von Patch Changes anderer angeschlossener Effektgerate einsetzen. Wenn Sie also zum
Beispiel die FX Loop des 2120 VGS fiir weitere Sound Effekte verwenden, so werden beim Aufrufen
eines 2120 VGS Programms die zugehdrigen Programme in den anderen Effektgeriten ebenfalls
aufgerufen, sofern diese Uber MIDI steuerbar sind.

Die Neuzuordnung einer MIDI Program Change Nummer zu einer Program Nummer geschieht wie folgt:

1. Dricken Sie die <Utilities> Taste und drehen anschlieBend den <Page> Knopf bis zu Page 3 des
Utilities Menu. Das Display zeigt:

'-‘ Prad Trns Map:

- BOFF B--- O---
[N s R R I L R N ) - —
L0 Rt

race J o 13

Mit dem <2> Knopf schalten Sie die Program Transmit Map Funktion ein oder aus.

Mit dem <3> Knopf wahlen Sie die 2120 VGS Program Nummer, die neu zugeordnet werden soll.
Beachten Sie, dal3 sich dabei auch die Nummer unter MIDI andert.

4. Mit dem <4> Knopf wahlen Sie die MIDI Program Change Nummer, die an die MIDI OUT Buchse
gesendet werden soll, wenn das entsprechende Programm aufgerufen wird.

SysEx Device Channel

Die System Exclusive (SysEx) Device Channel Option ist am leichtesten vorstellbar, wenn man System
Exclusive Daten von normalen MIDI Daten trennt. Sowohl SysEx als auch MIDI haben ihre eigene Gruppe
von 16 Kanalen, Uiber die Daten gesendet werden konnen.

Normale MID! Daten, wie Program Changes, MIDI Volume, Modulation, etc. werden auf dem mit MIDI
CHANNEL eingestellten MIDI Kanal gesendet und empfangen. SysEx Daten werden jedoch auf dem mit
SYSEX DEVICE CHANNEL eingestellten SysEx Kanal gesendet und empfangen.
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Damit werden die reguldren MIDI Channels fir andere Steueraufgaben freigehalten, und Syskx Daten
werden nur von den von lhnen gewlinschten Geraten im Setup aufgerufen, ob sie nun denselben MID!
Kanal verwenden oder nicht.

Eine SysEx Device Channel Nummer wird wie folgt gedndert:

1. Driicken Sie die <Utilities> Taste und drehen anschlieBend den <Page> Knopt bis zu Page 6 des

'- 2] I
[N uﬁ—ﬁ@@ RS L —
pace b o 13

Utilities Menu. Das Display zeigt:
2. Mit dem <2> Knopf wahlen Sie den gewiinschten SysEx Channel (1-16).

SysEx Dumps

Program Dump: Mit dieser Option kénnen Sie einzelne 2120 VGS Programme auf einen anderen 2120
VGS oder andere externe MIDI Gerite, wie etwa Patch Bibliotheken, Computer oder Sequencer
iibertragen und dort speichern oder neu organisieren. Bei Program Dump wihlen Sie das Programm aus,
das (bertragen werden soll. Ist das empfangende Gerat ein anderer 2120 VGS, so kénnen Sie den
Programm-Speicherplatz, an dem das Ubertragene Programm gespeichert werden soll, ebenfalls
bestimmen.

Ein einzelner SysEx Program Dump vom 2120 VGS wird wie folgt durchgefiihrt:

1. Driicken Sie die <Utilities> Taste und drehen anschiieBend den <Page> Knopf bis zu Page 8 des

'-" SusExDume UzerPra*Pralum
~ 4ES g
— m‘:/u—E‘IEE = B0 _——

Utilities Menu. Das Display zeigt:

2. Mit dem <3> Knopf wahlen Sie das Programm, das iibertragen werden soll. Beachten Sie, daB sich
beim Scrollen auch die MID! Nummer andert.

Mit dem <4> Knopf wahlen Sie den Programm-Platz, zu dem das Programm ibertragen werden soll.

Der Program Dump Vorgang wird mit Drehen des <1> Knopfes gestartet. In der Information Zeile
erscheint kurz:

SEHDIMG PROGEAM DUMF .« .

Danach kehrt das Display zur Program Dump Anzeige zuriick.

Default Dump: Mit dieser Option kénnen Sie einzelne 2120 Effect Modul User Defaults auf einen anderen
2120 VGS oder andere externe MID! Gerate, wie etwa Patch Bibliotheken, Computer oder Sequencer
iibertragen und dort speichern oder neu organisieren. Bei Default Dump wihlen Sie den Default aus, der
iibertragen werden soll.

Ein einzelner SysEx Default Dump vom 2120 VGS wird wie folgt durchgefihrt:

1. Driicken Sie die <Utilities> Taste und drehen anschlieBend den <Page> Knopf bis zu Page 9 des
Utilities Menu. Das Display zeigt:
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'-’ UsrDf1t:Preflme User 1

- [YES B --- oy
L AR e m) MR — - -—-—
WD g aliEss

paaed o 13

2. Mit dem <3> Knopf wahlen Sie den Effect Modul, aus dem ein Default Gbertragen werden soll.
Mit dem <4> Knopf wiahlen Sie den User Default, der Gibertragen werden soll.

4. Der Default Dump Vorgang wird mit Drehen des <1> Knopfes gestartet. in der Information Zeile

SERDIMGE DEFAULT DUMF Y« .

erscheint kurz:

Danach kehrt das Display zur User Default Anzeige zuriick.

Bulk Dump: Mit dieser Option kdnnen Sie alle im Memory residenten Programme auf ein externes
Speichergerdt, wie etwa Patch Bibliotheken, Computer oder Sequencer {ibertragen und dort speichern
oder neu organisieren. Bulk Dump Gbertragt alle Programme auf einmal, es werden jedoch keine 2120
VGS Systeminformationen (Utility Einstellungen), wie etwa SysEx Device Channels oder Program Maps
tbertragen.

Ein SysEx Bulk Dump aller 2120 VGS Programme wird wie folgt durchgefiihrt:

1. Driicken Sie die <Utilities> Taste und drehen anschlieBend den <Page> Knopf bis zu Page 7 des
Utilities Menu. Das Display zeigt:

"'" SusEx Dump: Bulk Susten

- BYES  BYES

' R D D T3 & M M

‘_ S =it ilaak B RLBE S I -~ —
Tor i3

2. Der Bulk Dump Vorgang wird mit Drehen des <3> Knopfes gestartet. In der Information Zeile

SEMDIMG BULK DUMF. ..

erscheint kurz:

Danach kehrt das Display zur Dump Anzeige zuriick. Bulk Dumps iibertragen groBe Datenmengen und
konnen daher mehrere Minuten dauern.

System Dump: Mit dieser Option kdénnen Sie Systemdaten auf ein externes MIDI- oder SysEx
Speichergerat lbertragen. Mit System Dump werden alle Einstellungen des Utilities Menu gesendet;
Programme werden nicht bertragen.

Der System Dump Vorgang ist der gleiche wie bei Bulk Dump (siehe oben), er wird jedoch mit Drehen
des <4> Knopfes gestartet.
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Weitere Hilfsfunktionen

Hier finden Sie zuséatzliche Hilfsfunktionen, die das Programmieren im 2120 VGS ein wenig erleichtern.

Ouput Mode
Mit dieser Option kénnen Sie den Ausgang des 2120 VG5 auf Stereo oder Mono schalten.

1. Driicken Sie die <Utilities> Taste und drehen anschlieBend den <Page> Knopf bis zu Page 1 des
Utilities Menu. Das Display zeigt:

"" QutrPut:Stereo EQ/Mix

[T R a0 () [ T T PO, —_—
[ ‘.‘ ) o . (R B
o

race | oe {3

2. Mit dem <2> Knopf stellen Sie den Ausgang des 2120 VGS auf Stereo oder Mono ein.

Cabinet Emulator - global oder lokal

Bei Verwendung des Cabinet Emulator (Lautsprecherbox-Nachbildung) im Global- oder Local Mode gilt
es zu iberlegen, ob mit diesem Effekt alle Sounds beeinflufit werden sollen, oder nur bestimmte Sounds.
Global Mode ist eine gute ldee, wenn Sie Sfters auf verschiedenen Biihnen spielen, da jeder Raum
anders klingt.

1. Driicken Sie die <Utilities> Taste und drehen anschlieBend den <Page> Knopf bis zu Page 2 des
Utilities Menu. Das Display zeigt:

"" Cabinet Emulator: Leocal
a— n

= EEEEEEE S
PAGE EO‘ '3

2. Mit dem <4> Knopf schalten Sie den Cabinet Emulator auf Local On, Global On oder Global Off.

‘Global EQ und Wet/Dry Mixer - global oder lokal

Bei Verwendung des Global EQ und Wet/Dry Mixer im Global- oder Local Mode gilt es zu Uberlegen, ob
mit diesem Effekt alle Sounds beeinfluBt werden sollen, oder nur bestimmte Sounds. Global Mode ist
eine gute Idee, wenn Sie Sfters auf verschiedenen Biihnen spielen, da jeder Raum anders klingt.

1 Driicken Sie die <Utilities> Taste und drehen anschlieBend den <Page> Knopf bis zu Page 1 des
Utilities Menu. Das Display zeigt:
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2. Mit dem <4> Knopf schalten Sie den Global EQ und Wet/Dry Mixer in den Local- oder Global Mode.

Werkseinstellungen zuriicksetzen

Mit Factory Reset werden alle User Program-, Default- und Utilities Einstellungen auf einmal geldscht und
das Memory auf die 2120 VGS Werkseinstellungen zuriickgesetzt (Reset).

WARNUNG!

Dieser Vorgang 16scht unwiderruflich alle User Programme im 2120 VGS Memory und setzt sie auf
die Werkseinstellungen zuriick! Uberlegen Sie genau, ob Sie diesen Yorgang wirklich fortsetzen
wollen. Im Zweifelsfall brechen Sie den Vorgang ab und beginnen von vorne.

Ein Factory Reset wird wie folgt durchgefiihrt:

1. Dricken Sie die <Utilities> Taste und drehen anschlieBend den <Page> Knopf bis zu Page 13 des
Utilities Menu. Das Display zeigt:

'-’ Factory Reset 7
£7 1 D 5 0O e
[ERTRE]

2. Der Reset Vorgang wird mit Drehen des <1> Knopfes eingeleitet.
3. Hierist lhre letzte Chance...
Wenn Sie sich nicht sicher sind, kénnen Sie den Vorgang mit Drehen des <4> Knopfes abbrechen.

Wenn Sie TATSACHLICH den Reset durchfilhren wollen, drehen Sie den <3> Knopf. In der Information
Zeile des Display erscheint kurz:

FRCTORY REZETTIHG...

Nach dem Reset Vorgang schaltet der 2120 VGS auf Program 1.

In besonderen Situationen kann der 2120 VGS auch durch eine spezielle Netz-Einschaltsequenz auf die
Werkseinstellungen zuriickgesetzt werden. Wie beim normalen Reset werden auch hier samtliche User
Einstellungen gel&scht! Der Vorgang ist wie folgt:

1. Dricken und halten Sie die <Preamp> Taste, wahrend Sie den 2120 VGS einschalten.

2. Halten Sie die <Preamp> Taste weiter gedriickt, bis ein Stern (*) in der Information Zeile des Display
erscheint. Lassen Sie die <Preamp> Taste los.

3. Drlicken Sie die <Mod> Taste. Der 2120 VGS wird neu initialistert.

67




Abschnitt 7 - Anhang

2120 VGS Werks-Programme

Bank 1 Artist 1

1. Satch 1 (JoeSatriani) .............oooo Cig9
2- Satch 2 (Joe Satriani) ... ..ot Clg-1
3- Satch 3 (Joe Satriani) .......ooooioeoies -14
4 NewLemst (Alex Lifeson) ............... Cig-1
5- Finger Pluck Theramin (ennifer Bauen) ... Ctg9
Bank 2 Artist 2

6- FSG 98 (Frank Gambale) ................ Cfg-1
7- Craniac (Frank Gambale) ................ -9
8  We're Not Gambale (Frank Gambale) ...... 9
9- Surfer’s Paradise (Frank Gambale) ......... Clg2
10-  REEVZ largest Tone (Reeves Gabrels) . ... Clg9
BNk 3 ARTIST 3

11-  RG SPACEBOY (Reeves Gabrels) .......... Cfg-13
12-  RG UNITRON 1975 (Reeves Gabrels) . ... Clg1
13 Naked Power (GizzButt) ................ (a1
14-  Whatareyouon? (GizBut) ............ -1
15-  Triple Double (Gizz Butt) ............... -
Bk 4 ARTIST 4

16-  Morse Dist+Pan Delay (Steve Morse) ... -13
13- Morse Clean (Steve Morse) .............. Clg-2
18- Korn'sBeef (Head) ............... ... Cfg-3
19-  Munk Dog Phase (Munky) ............... 2
20 KillUTone (Munky) ...t -2
BANK S ARTIST 5

21-  Head Dog Sample (Head) ............... Cfg-14
22-  Stand and Deliver (Rodney Sheppard) ... .. Cfg-2
23 Iron Mike Lead (Rodney Sheppard) ... ... .. -1
24-  Lead For Anyone (Rodney Sheppard) ... .. -1
25.  Diamonds & Bails (Rev. Mike Scott) . ... .. Clg-1
Bank 6 Artist 6

26-  Doves (Rev. Mike Scott) ... Cfg-1
27 Chicken Grease (Rev. Mike Scott) ......... Cig-1
28-  Talkin' Loud (Rev. Mike Scott) ............ Cfg-2
29-  Promethius (Larry Mitchell) ............. Clg-12
30-  Pleasure Mc Nylon (Larry Mitchell) ... Cig-2
Bank 7 Artist 7

31.  Sugar Plums (Larry Mitchell) ... Cfg-9
3).  Fat Wet Slap Bass (Dave LaRue) ........... Clg-1
33.  Ambient Bass Chorus (Dave LaRue ) ... Cg:2
34.  Splitting Basses (Doug Wimbish) .. ........ Clg-2
35.  Bells of Bish (Doug Doug Wimbish ) ....... -2
Bank 8 MorpH

36-  Country>>Rock Morph ... Clg-13
37 MetaMorph .. ... Clg-22
38 HotStack>>GreasyFuzz ... ... Cfg-8
39.  SuperwetClean>>Thrash ... Cé-lZ
40- AptoMorph ... Clg-13
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Bank 9 Blues

41-  LlateNightBlues ............. ... ... Cfg-2
& ExpPedalSlide ....................... Clg4
43  SqueezyCleanDelay ................... cé.z
44 BigBluesSolo .. ... Cig-8
45 SweetandBlueSolo ... ... ..., Cfg-11
Bank 10 Country

46-  CounmryPicken ...................... Clg-13
47- GonnaBeAShowdown ................. Clg6
48 TremOlLluck ... (‘é{)
49-  Country Rock Stereo ... Clg-13
50-  StereoCountry....... ..ol 14
Bank 11 Metal Tones

Si-  RhythmKing .........oooooooioiiiion Cig-1
520 OCAVIAR . ... .oovenerai i -1
53 Stereo Razor ........oioaoonn Clg8
54-  BadAtitude ............. R Clg3
55.  DeathSe00P «..vvvnorreiinaenns Cfg-t
Bank 12 Preamp Only

56 TubeDitt...... ...t Cfg-9
57-  BigPowerChord .................ol Clg-12
58 Singinglead ........ooeiiiinnn Clg-12
59.  TwinCombo ........cooooiiiiiiiinn, -12
60- ThickSoloTone ............coviinnns -12
Bank 13 Dual Tone

61-  Hybrid Stereo Sweep . ... Cfg-2
62- DirtyfCleanSqueeze .. ... oo Cfg-12
63  Stereoverdrive ... .....oiias B .£-13
64-  Pannable SweetSolo ......... ... -13
65 MyTone'sBigger .........c.oooiiins Cfg9
Bank 14 Studio

66 LACROTUS .. oo Cfp-14
67- TraStereo+PanDly................... Clg-13
68-  Stereo Power Chord ... ... Clg3
69-  WestCoastSolo ... Cfg3
70- GreasySolo ... Cfg-2
Bank 15 Vintage

71-  Surfininthe90s ... . ... Cfg-2
72. Phumdelic ... ... Cig-14
73 TapeDelay ... Cfg-H
74-  HerName Wasledie ............ovenve Cig-14
75-  TrueAmalogDelay ... g-12
Bank 16 Clean

76-  Clean Quad Detune/Delay ... 8%-2
77- Panning CleanWarm Tube ............... 8
78 Crisp CIEAn .. ooooeeean Clg-1
79 CleanwMod Delay ... ooooi e 8
80- Phasew/PannigDelay ... ......... - Cfg9




Digital Effect Block Konfigurationen (Factory Bank)
Cfg = Konfiguration

Bank 17 Jax/Fusion

FusionSolo ............. .. ... ... .. Clg-11
82 Jazm FXNeck Pickup ................ . ... Clg-11
83  JazzConmcertHall ..... ... . ... ... ... Cle-l
84 PopJamComp........... . . ... ... Cfg-20
85 SynthVolPedalPad ... . . .. ... Cfg-20
Bank 18 Jam-A-Long

Sound+Sound Jam ... ... ... ... . .. Cfg-23
87 Sound+Sound 1>4>5 ... ... ... Clg-23
88 DelayShifter ......... . ... ... Cfg-10
89 MegaChord ... .. ... ... ... ... Cfg-15
90 SpaceBeat ............... ... ... ... Cfg-5
Bank 19 Jazz

Hit-Me-Hard Phase ... ... ... ... ..., Cfg9
92 DuckedDelay ... . .. ... ...... ... C
93-  Soft: Reverb Hard: Chorus .. ......... ... Cig3
94 EnwelopeAmack ......... ... ... ... ..... Cfg-8
95-  PanningDynoWah ...... ... ... .. ... ... Cg-1
96 SlightofHand ........... ... .. ... Cfg-11
97-  WorthWaitingFor ... ... ... ....... Clg4
98 PeacefulPlace .......... ... ... ... ... Cg-5
99 GuitarSynthPad ..... ... ... ... ..., Cig-12
100- YouTaketheHighwp ... .. ... ... ... Clg-13

Digital Effect Block Configurations (Factory Bank)

101)  Clg 14,444

102)  Clg 2(4, 4, H)

103) Cfg. 3 (1, 4. 4)

104)  Cfg 4 (4. H. 9)

105)  Cfg. S(H, H)

106) (g 6(d.4.2)

107) Clg7(4,4.4.9)

108)  Cfg 8 (H. H)

109) Clg. 9 (F)

110)  Cfg 10 (M, H, H.H) Dual $-DISC 11
111)  Cfg 11 (E, F) Dual SDISC Il
112)  Cfg 124, 4. 4, 4. F) Dual S-DISCII
113)  Cfg 13 (FF) Dual $DISC Il
114)  Cfg. 14 (All 4ths) Dual $-DISC 11
115  Cfg 15 (4,4,2.4.4.2)

116)  Cfg 16 (All 4ths)

117) g 1734)

118)  Cfg 18(4,3)

119)  Clg 19(244)

1200 Cfg 20(4,4.2)

121)  Clg 21 (4,4.4.4)

122)  Cfg 22 (H 1L F)

123)  Cfg 23 (F H.4.4)

124)  Clg 24 (4, 4. 445
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Effect Block Konfigurationen

Config 1 - Full Config9 - 44,2 Config 17 -2,2,2,2
'rgjg-—--@--—-----? s N O @T"'@“D“”'ﬁi’“
) L D - e
. Config 18 - 2,2,2,2
Config 2 -22 Config 10 - 44,2 o1
i = e e S -
= -H- S L) S
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Config6 - 2,44 Config 14 - Full Full Config 22 - 4,4,2,4,4,2
&, ] @m. (... x=m @@ @ [ e
lpao.m @& = t B
L JUy B o) B S
<Config7-2,4.4 Config 15 - Full, Full Config 23 - All 41bs
R N s (P I =@
Ll\C e BE— (B D" (@ T T e
Config 8 - 4,2,4 Cor:ﬁg 16 - 2,2,F Cogg f{f - r1%11 é\tbsm
W _ 3 \“_r , \___r{‘.__r'\_f R ‘(]T’_
— S ‘ S s
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Dual Output Konfigurationen - Beachten Sie, daB3 einige Effect Konfigurationen (etwa 7 und 8) Dual
Outputs verwenden. Das bedeutet, daB Dual Distortion Pfade sowoh! an den linken als auch rechten
Ausgang geroutet werden konnen. Diese Eigenschaft wird durch Pannen der Distortions nach links oder

rechts erreicht.

Legende: 4 = Modul mit 1/4 GroBe
H = Modul mit 1/2 GréBe
3 = Modul mit 3/4 GroBe

F = Modul mit 1/1 GroBe
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Intervall-Tabelle

Interval Major Minor Harm.Minor | Mel.Minor Dorian Mixolydian | Lydian
10ct C C C C C C C
T7th B Bl B B B} B B
teth A Al A A A A A
T3th G G G G G G G
Td4th F F F F F F F#
T3rd E E} EL E} E} E E
T2nd D D D D D D D

af: G 3 > 5 G
2nd | B B} B B B} B B
43rd A Al Al A A A A
$4th G G G G G G
15th F F F F F F F#
+6th E El E} E} E}b E E
+7th D D D D D D
+0ct C C C C C Cc C

int. LXf,;'_" ot | PO | Beer | it | Blues | b | WROR | g [HIEWREE L [WREHI
t0ct | C |t0ct | C
10ct C tb?th| B} |t6th B
17th B t0ct | C t0ct | C |t6th | A [1t5th | A
TéLh fOct | C [T0ct | C |TbPth| By |Tb7th| A4 [15th | G |tb6th| G#
T45th| G# [t6th | A [tbPth| Bl |15th | G |t#5th| G# |t#4th| F# [tpS5th| F#
TH4th] F# |[tSth | G |T5th | G |TbSth| F# |t44th| F# [T3rd | E |14th | F
t3rd | E [t3rd | E [TMth | F [t4th F {13rd | E [t#2nd| E} |tb3rd| E;
t2nd | D |t2nd | D |tb3rd| E} |T3rd| E, |t2nd | D |t2nd | Db [t2nd | D
“SFE%_’G@%J T ECE - 33 prrrlaey . TSEART:
Wb2nd| B E3rd] A 42nd B [42nd B $2nd A¥  |42nd By |4b2nd| B
Wh3Ird| A +4th G +4th G 44th G 43rd G# |4b3rd| A Jp3rd] A
13rd | G# |db6th| E [I5th 4bSth| F# [IBSthy F¥ |¥4th | G [I3rd | G#
ibSth| F# Hb7thi D 46th EL, [+5th F b6th| E bOth| F# |4bSth| F#
béthi £ [10ct C |40ct | C [¥6th | E} [4b7th! D |ib6th| E} [45th
lb7th| D 40ct, C (d0ct | C |46th | E |46th | E}
10ct C L7th | Db |4b7th| D
+0ct C 40ct C
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2120 VGS Technische Daten

A/D Konverter: 20-bit, 64faches Oversampling, Delta Sigma Stereo
D/A Konverter: 20-bit, 64faches Oversampling

Sampling Frequenz: 44,1kHz

Frequenzbereich: 20Hz-20kHz, +0,5dB

DSP:

Static-Dynamic Instruction Set Computer (S-DISC®): 2
Breite des digitalen Signalwegs: 24 bit (144,5dB)

Breite des internen Datenwegs: 48 bit (289dB)
Dynamisches Delay Memory: 64k x 24 bit (1,4 Sekunden)
Statisches Delay Memory: 256 Register mit 24 bit (5,8ms)
Data ALU Processing: 45,1 MIPS

Address ALU Processing: 33,8 MIPS

“Multiplier GréBe: 24 bit x 24 bit

THD: < 0,03% bei 1kHz

Eingang:

AnschluB: 1x 1/4* TRS Klinkenbuchse, symmetrisch
Normpegel: -10dBV oder +4dBu (per Software einstellbar)
Maximaler Pegel: +18dBu

impedanz: 10kOhm

Ausgang:

AnschluB: 2x 1/4" TRS Klinkenbuchse, symmetrisch
Normpegel: -10dBV oder +4dBu (schaltbar)
Maximaler Pegel: +18dBu

impedanz: 470 Ohm

Empfohlener AbschluBwiderstand: 20kOhm

Allgemein:

Frequenzbereich: 20Hz-20kHz, +3dB

Stérspannungsabstand:

> 91dB bei max. Signalpegel, 22kHz MeB-Bandbreite, nicht bewertet
96dB bei max. Signalpegel, bewertet nach Kurve "A”

THD: < 0,03% bei 1kHz

MIDE: IN und OUT/THRU

Memory Kapazitat:
Factory: 100 Programme
User: 100 Programme

NetzanschluB:

Europa: 230VAC, 50Hz

UK: 240VAC, 50Hz

USA und Kanada: 120VAC, 60Hz
Japan: T00VAC, 50/60Hz
Leistungsaufnahme: 28 Watt

Abmessungen und Gewichte:

BxHxT: 19 x 3,5 x 9,25 Zoll (482 x 88 x 234 mm)
Nettogewicht: 10,6 Ibs (4,8 kg)
Versandgewicht: 13,35 Ibs (6,05 kg)
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MIDI Implementation Tabelle

Function... Transmitted Recognized Remarks
Basic Default o
| - -1 Me /

Channel Cbannel A ! I-16 116 femorized

Default X Mode 2. Mode 4 I
Mode Messages X Mode 2, Mode 4 Memorized
Note
Number True Voice X NA X X
Yelocity Note ON ' X . X

Note OFF A X ’ X
Afler Key's . X 0 X
Touch Chs ? X X
Pitch Bender X X
Control X 0 7*
Change
Preset
Cbange True & X NA 0 0-127 2*
System Exclusive 0 0 See Sysbx (soe appendix)
System Song Pas X X

Song Sel X
Common Tune X X
System Clock Y X
Real Time :Commands X XY
Aux :Local ON/OFF X X
Mes- Al Notes Off X X
sages Aclive Serse X X

Kesel X X
Bemerkungen:

1* Jeder Parameter kann mit jedem Control Change gelinkt werden. Die Zuordnungstabellen werden im
Memory gespeichert.

2* Fur Preset Map 1-128 (Preset Change kann Factory Presets, User Presets oder der Bypass Funktion
zugeordnet werden).

Mode | - OMNI ON. POLY
Mode 3 - OMNI OFF, POLY

Mode 2 : OMNT ON, HONO
Mode 4 - QMUNI OFF. MONO
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